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Prije uporabe kalkulatora

Prvo pročitajte ovaj odjeljak

O ovom priručniku
• Tvrtka CASIO Computer Co., Ltd. ni u kojem slučaju nije odgovorna

za posebnu, popratnu, slučajnu ili posljedičnu štetu koja je povezana s
kupnjom ili uporabom ovog proizvoda i predmeta koji se isporučuju s
njim ili proizlazi iz nje. Nadalje, tvrtka CASIO Computer Co., Ltd. nije
odgovorna za potraživanja bilo koje vrste i bilo koje druge strane koja
proizlaze iz uporabe ovog proizvoda i predmeta koji se isporučuju s
njim.

• Sadržaj ovog priručnika podliježe izmjenama bez prethodne najave.
• Zasloni i ilustracije (npr. oznake tipki) u ovom priručniku služe isključivo

kao primjer i mogu se donekle razlikovati od stvarnih stavki koje
predstavljaju.

• QR Code registrirani je zaštitni znak tvrtke DENSO WAVE
INCORPORATED u Japanu i drugim državama.

• Nazivi tvrtki i proizvoda koji se koriste u ovom priručniku mogu biti
registrirani zaštitni znakovi ili zaštitni znakovi svojih vlasnika.

Radnje s pomoću tipki
U primjeru u nastavku navedeno je kako su radnje s pomoću tipki
prikazane u ovom priručniku.

Primjer 1.: 
Tipke je potrebno pritisnuti u prethodno navedenom redoslijedu (slijeva na
desno).

Primjer 2.: (π)*
Navedeni simboli upućuju na to da trebate pritisnuti , a zatim , čime
ćete unijeti simbol π. Na taj su način prikazane sve radnje koje se provode
s pomoću više tipki. Prikazane su oznake na tipkama, nakon kojih slijedi
znak ili naredba u zagradi koju je potrebno unijeti.
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* Za više informacija o simbolima tipki korištenima u ovom primjeru
pogledajte odjeljak „Oznake tipki” (stranica 14).

Primjer 3.: , , , , , 

• Pojedinačne tipke pokazivača označene s (1) prikazane su kao , ,
, .

• Pojedinačne tipke za listanje stranice označene s (2) prikazane su kao
, .

Radnje u izborniku
Određene radnje u ovom priručniku prikazane su u pojednostavljenom
obliku, kako je prikazano u primjeru u nastavku.

Primjer 1.:

 – [Other] > [π]

ili

Pritisnite , a zatim odaberite [Other] > [π].

Stvarna radnja 1

1. Pritisnite .
2. S pomoću tipki  i  odaberite [Other], a zatim pritisnite .
3. S pomoću tipki  i  odaberite [π], a zatim pritisnite .
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Primjer 2.:

 - Calculate

ili

Pritisnite , odaberite ikonu aplikacije Calculate, a zatim pritisnite .

Stvarna radnja 2

1. Pritisnite .
2. S pomoću tipki pokazivača ( , , , ) odaberite ikonu aplikacije

Calculate, a zatim pritisnite .

Tipka  i tipka 
Tipka  i tipka  imaju istu funkciju. U ovom priručniku  služi za
odabir i primjenu postavke, dok  služi za izvršavanje izračuna. Međutim,
imajte na umu da nema razlike hoćete li pritisnuti  ili  za radnje u
okviru kojih su prikazani  ili .

Primjeri
Ako nije navedena uputa za uporabu određene aplikacije kalkulatora ili
konfiguraciju određenih postavki za radnju u primjeru, podrazumijeva se
uporaba aplikacije i postavki u nastavku.

Aplikacija kalkulatora: Calculate
Postavke: zadane postavke kalkulatora

Za informacije o vraćanju kalkulatora na zadane postavke pogledajte
odjeljak „Pokretanje kalkulatora” (stranica 8).

Pokretanje kalkulatora

Važno!

• Postupak u nastavku služi za pokretanje svih postavki kalkulatora, osim za aplikacije
Contrast i Auto Power Off. Također služi za brisanje svih podataka koji su pohranjeni u
memoriji kalkulatora.

1. Pritisnite  za prikaz zaslona HOME.
2. S pomoću tipki pokazivača ( , , , ) odaberite ikonu aplikacije

kalkulatora, a zatim pritisnite .
3. Pritisnite , a zatim odaberite [Reset] > [Initialize All] > [Yes].

• Prikazat će se zaslon HOME.
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Zaslon Get Started na kalkulatoru
Dok je prikazan zaslon HOME, pritiskom tipke  prikazat će se zaslon
Get Started, koji sadržava informacije navedene u nastavku.
• QR Code za pristup mrežnoj stranici „Get Started” Worldwide Education

Service (https://wes.casio.com/calc/cw/)
Putem mrežne stranice Get Started možete pristupiti priručniku
za uporabu i ostalim povezanim informacijama za jednostavno
upoznavanje s radom kalkulatora.

• Identifikacijski broj kalkulatora (niz od 24 znaka)

Pritisnite  za povratak na zaslon HOME.

Napomena

• Zaslon Get Started možete prikazati i tako da ga odaberete u izborniku SETTINGS.
Pogledajte odjeljak „Uporaba izbornika SETTINGS” (stranica 20).

Mjere opreza

Sigurnosne mjere opreza
Hvala vam na kupnji ovog proizvoda tvrtke CASIO.
Prije uporabe ovog proizvoda obavezno pročitajte sigurnosne mjere
opreza kako biste osigurali da ga pravilno upotrebljavate. Sačuvajte svu
korisničku dokumentaciju za buduće potrebe.

Opasnost
Označava nešto uslijed čega nastaje ozbiljan rizik od smrti ili
teške tjelesne ozljede.

 Mjere opreza za dugmaste baterije (samo fx-991CW)

Pripazite da se baterija slučajno ne proguta.
Posebno je važno držati baterije podalje od djece.

Ako se baterija slučajno proguta ili ako postoji mogućnost da se baterija
progutala, odmah se obratite liječniku.
Gutanje baterije može dovesti do kemijskih opeklina, prodora u tkivo
sluznice i ostalih ozbiljnih problema koji dovode do rizika od smrti.
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Upozorenje
Označava nešto uslijed čega nastaje rizik od smrti ili teške
tjelesne ozljede.

 Zaslon

Nemojte pritiskati LCD ili ga izlagati snažnim udarcima.

U suprotnom može doći do pucanja stakla LCD zaslona, što dovodi do
rizika od tjelesne ozljede.

Ako LCD zaslon pukne, nipošto nemojte dodirivati tekućinu
unutar zaslona.

Ako tekućina iz LCD zaslona dospije na kožu, nastaje rizik od
nadraženosti kože.
Ako tekućina iz LCD zaslona dospije u usta, odmah ih isperite i obratite
se liječniku.
Ako tekućina iz LCD zaslona dospije u oči ili na kožu, odmah ih isperite
čistom vodom i obratite se liječniku.

 Mjere opreza za baterije

Ako tekućina koja curi iz baterije dospije na vašu kožu ili
odjeću, odmah je isperite čistom vodom.

Tekućina iz baterije koja dospije u oči dovodi do rizika od gubitka vida i
sl. Isperite oči i odmah se obratite liječniku.

Oprez
Označava nešto uslijed čega nastaje rizik od lakše tjelesne
ozljede ili fizičke štete.
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Pridržavajte se mjera opreza u nastavku. U protivnom može doći
do puknuća baterije, što dovodi do rizika od požara, tjelesne
ozljede i prljanja obližnjih predmeta uslijed curenja tekućine.

• Nemojte pokušavati rastaviti bateriju i nemojte dopustiti da na
bateriji dođe do kratkog spoja.

• Nemojte puniti bateriju koja nije punjiva.
• Nemojte izlagati bateriju toplini ni bacati je u vatru.

• Upotrebljavajte isključivo odgovarajuću vrstu baterije.
• Postavite bateriju tako da pravilno okrenete polove (pozitivni

(+) i negativni (–)).
• Zamijenite bateriju što je prije moguće nakon što prestane

raditi.

 Mjere opreza za baterije

Pridržavajte se mjera opreza u nastavku. U protivnom može
doći do eksplozije baterije ili curenja zapaljive tekućine ili
plina.

• Upotrebljavajte samo vrstu baterije koja je predviđena za ovaj
proizvod.

• Nemojte spaljivati bateriju, odlagati je u peć za spaljivanje ni
mehanički drobiti ili rezati.

• Nemojte izlagati bateriju iznimno visokim ili niskim temperaturama
tijekom uporabe, skladištenja ili transporta.

• Nemojte izlagati bateriju iznimno niskom barometarskom tlaku tijekom
uporabe, skladištenja ili transporta.

Mjere opreza pri rukovanju
• fx-570CW: Čak i ako kalkulator normalno radi, zamijenite bateriju barem

svake dvije godine (R03).
fx-991CW: Čak i ako kalkulator normalno radi, zamijenite bateriju barem
svake dvije godine (LR44).
Prazna baterija može iscuriti, što dovodi do oštećenja i kvara
kalkulatora. Nikad nemojte ostavljati praznu bateriju u kalkulatoru.
Nemojte pokušavati upotrebljavati kalkulator ako je baterija potpuno
prazna (fx-991CW).

• Snosit ćete troškove za kvarove ili oštećenja uslijed curenja baterije, koji
nisu pokriveni jamstvom.

• Baterija koja dolazi s kalkulatorom može se nešto brže isprazniti zbog
vremena provedenog u skladištu i transportu. Iz tog razloga možda
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ćete je trebati zamijeniti ranije od normalnog očekivanog vijeka trajanja
baterije.

• Ne držite kalkulator u vlažnim, prašnjavim, pretoplim ili prehladnim
prostorima.

• Nemojte izlagati kalkulator snažnim udarcima, prekomjernom tlaku ili
savijanju.

• Nemojte pokušavati rastaviti kalkulator.
• Za čišćenje vanjskog dijela kalkulatora upotrijebite meku, suhu krpu.
• Kalkulator ili baterije odlažite u skladu s lokalnim zakonima i propisima.

Početak rada

Pričvršćivanje i uklanjanje prednjeg poklopca

Za uklanjanje prednjeg poklopca

Prije uporabe kalkulatora uklonite prednji poklopac (①) i pričvrstite ga za
stražnji dio (②).

Za pričvršćivanje prednjeg poklopca

Kada ne upotrebljavate kalkulator, uklonite prednji poklopac (①) i
pričvrstite ga za prednji dio (②).
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Važno!

• Uvijek pričvrstite prednji poklopac za kalkulator dok ga ne upotrebljavate. U protivnom
slučajni pritisak tipke  može dovesti do uključenja kalkulatora i pražnjenja baterije.

Uključivanje i isključivanje kalkulatora
Pritisnite tipku  kako biste uključili kalkulator.
Pritisnite (OFF) kako biste isključili kalkulator.

Napomena

• Kako biste uključili kalkulator, pritisnite i držite . U svrhu izbjegavanja slučajnog
pokretanja kalkulatora vrh tipke  nešto je niži od ostalih tipki.

• Ako se zaslon prikazan u nastavku pojavi odmah po uključivanju kalkulatora, razina je
baterije niska.

Ako se pojavi ovaj zaslon, zamijenite bateriju što je prije moguće. Za pojedinosti o
zamjeni baterije pogledajte odjeljak „Zamjena baterije” (stranica 143).

• Kalkulator će se također automatski isključiti nakon otprilike 10 minuta ili 60 minuta
mirovanja. Pritisnite tipku  za ponovno uključivanje kalkulatora.
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Zaslon HOME
Pritiskom tipke  prikazat će se zaslon HOME. Zaslon HOME sadržava
popis instaliranih aplikacija kalkulatora.

  Zaslon HOME   Zaslon aplikacije Calculate
                 

Za informacije o instaliranim aplikacijama kalkulatora pogledajte odjeljak
„Popis instaliranih aplikacija kalkulatora” (stranica 18).

Prilagodba kontrasta zaslona
1. Pritisnite , odaberite ikonu aplikacije kalkulatora, a zatim pritisnite .
2. Pritisnite , a zatim odaberite [System Settings] > [Contrast].

3. S pomoću tipki  i  prilagodite kontrast zaslona.
4. Nakon prilagodbe postavke na željenu razinu pritisnite .

Važno!

• Ako se prilagodbom kontrasta zaslona ne poboljša čitljivost, vjerojatno je slaba
baterija. Zamijenite bateriju.

Oznake tipki
Ako pritisnete tipku , a zatim pritisnete neku drugu tipku, provest će se
alternativna funkcija druge tipke. Alternativna funkcija označena je tekstom
iznad tipke na lijevoj strani.

(1) Glavna funkcija tipke: 
(2) Alternativna funkcija: (π)
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Oznake
Oznake

U tablici u nastavku nalazi se opis oznaka koje se mogu pojaviti na vrhu
zaslona.

Oznaka: Značenje:

Tipkovnica je pripremljena za provedbu
alternativne funkcije pritiskom tipke .
Tipkovnica će se vratiti na glavnu funkciju i
oznaka će nestati nakon što pritisnete sljedeću
tipku.

U izborniku SETTINGS za opciju Input/Output
odabrani su MathI/MathO ili MathI/DecimalO.

 /  / 
Trenutačna postavka za Angle Unit ( : Degree,

: Radian ili : Gradian) u izborniku SETTINGS.

FIX Primjenjuje se fiksni broj decimalnih mjesta.

SCI
Primjenjuje se fiksni broj značajnih decimalnih
mjesta.

E
Za Engineer Symbol u izborniku SETTINGS
odabrana je opcija On.

i / ∠ Trenutačna postavka opcije Complex Result (i :
a+bi ili ∠: r∠θ) u izborniku SETTINGS.

 / 

Za trenutačno prikazani rezultat izračuna postoji
prethodna ( ) ili sljedeća ( ) povijest izračuna.
U određenim aplikacijama kalkulatora te oznake
upućuju na to da su dostupni drugi rezultati
izračuna.
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Kalkulator izravno napajaju solarne ćelije u
potpunosti ili u zajedno s baterijom. (samo
fx-991CW)

Uporaba izbornika
Mnoge radnje na kalkulatoru provode se s pomoću zaslona izbornika.
U primjerima u nastavku prikazane su radnje koje započinju na zaslonu
izbornika koji se pojavi kada pritisnete .

Odabir stavke izbornika

Za odabir stavke izbornika označite je s pomoću tipki pokazivača ( ,
, , ), a zatim pritisnite . Imajte na umu da  i  možete

upotrebljavati samo ako se stavke izbornika nalaze u više stupaca.

Navigacija hijerarhijama u izborniku

Oznaka „ ” zdesna stavci izbornika upućuje na to da pod tom stavkom
postoje niže hijerarhijske razine. Ako odaberete stavku izbornika i
pritisnete  ili , prijeći ćete na sljedeću nižu razinu u hijerarhiji. Za
povratak na sljedeću višu razinu u hijerarhiji pritisnite .

Napomena

• Ako se nalazite na nižoj razini u hijerarhiji izbornika s jednim stupcem, umjesto tipke
 možete pritisnuti  kako biste se vratili na sljedeću višu razinu.
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Odabir stavke izbornika s pomoću kružića za označavanje ( /
)

Ako je na zaslonu prikazan popis s većim brojem opcija, slijeva svakoj
opciji nalazit će se kružić za označavanje (  ili ).  označava
trenutačno odabranu opciju.

Konfiguracija postavki stavke izbornika s kružićem za označavanje
1. Označite relevantnu stavku izbornika i potom pritisnite .

• Što će se dogoditi sljedeće ovisi o vrsti odabrane stavke izbornika.
– Ako za odabranu stavku izbornika ne postoji još postavki koje

možete konfigurirati, kružić za označavanje pored stavke promijenit
će se u .

– Ako za odabranu stavku izbornika postoji još postavki koje
možete konfigurirati, pojavit će se zaslon za odabir postavke stavke
izbornika. U tom slučaju idite na korak 2.

2. Na zaslonu s postavkom označite željenu postavku i pritisnite .
• Vratit ćete se na zaslon sa stavkom izbornika iz koraka 1., pri

čemu će se kružić za označavanje pored prethodno označene stavke
izbornika promijeniti u .

Listanje među zaslonima

Ako postoji veći broj stavki izbornika, zbog čega ne stanu na jedan zaslon,
na desnoj strani zaslon pojavit će se klizač.
• Listajte među zaslonima s pomoću tipki  i .
• Listajte po redcima s pomoću tipki  i .

Za zatvaranje izbornika i povratak na zaslon koji je bio
prikazan prije izbornika

pritisnite .

Napomena

• Možete zatvoriti prikazani izbornik tako da pritisnete , , , ,  ili 
tako da pritisnete . Ako je prikazan izbornik koji se pojavi odmah nakon pokretanja
određene aplikacije kalkulatora ili ako je riječ o izborniku specifičnom za određenu
aplikaciju, ne možete ga zatvoriti pritiskom tipke . U tom slučaju trebate pritisnuti

 kako biste zatvorili izbornik.
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Aplikacije i izbornici
kalkulatora

Aplikacije kalkulatora

Odabir aplikacije kalkulatora
Odredite aplikaciju kalkulatora koja odgovara vrsti izračuna koji želite
obaviti.
1. Pritisnite  za prikaz zaslona HOME.

• Za informacije o aplikacijama kalkulatora pogledajte „Popis
instaliranih aplikacija kalkulatora” (stranica 18).

2. S pomoću tipki pokazivača ( , , , ) odaberite ikonu željene
aplikacije kalkulatora.

3. Pritisnite  za prikaz početnog zaslona aplikacije kalkulatora čiju ste
ikonu odabrali.

Popis instaliranih aplikacija kalkulatora

Ikona Opis

(Calculate)

Opći izračuni

(Statistics)

Statistički i regresijski izračuni

(Distribution)

Distribucijski izračuni
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(Spreadsheet)

Tablični izračuni

(Table)

Generiranje tablice brojeva na
temelju jedne ili dvije funkcije

(Equation)

Istodobne jednadžbe, jednadžbe
višeg reda i Solver (funkcija za
pronalazak vrijednosti bilo koje
varijable u unesenoj jednadžbi)

(Inequality)

Izračuni nejednadžbi

(Complex)

Izračuni s kompleksnim brojevima

(Base-N)

Računanje u raznim brojevnim
sustavima (binarni, oktalni,
decimalni, heksadecimalni)

(Matrix)

Matrični račun

(Vector)

Računanje s vektorima
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(Ratio)

Računanje omjera

(Math Box)

Sljedeće funkcije za lakše učenje
matematike:
Dice Roll, Coin Toss: simulacija
vjerojatnosti

Uporaba izbornika SETTINGS
Za prikaz izbornika SETTINGS pritisnite  dok upotrebljavate aplikaciju
kalkulatora. Izbornik SETTINGS sadržava stavke izbornika u nastavku.

Calc Settings
Sadržava stavke izbornika za konfiguraciju
postavki izračuna, kao što je oblik prikaza
rezultata izračuna.

System Settings
Sadržava stavke izbornika za konfiguraciju
postavki rada kalkulatora, kao što je prilagodba
kontrasta.

Reset
Sadržava stavke izbornika za obavljanje različitih
vrsta postupaka ponovnog postavljanja.

Get Started
Služi za prikaz zaslona Get Started. Za više
informacija pogledajte odjeljak „Zaslon Get
Started na kalkulatoru” (stranica 9).

Napomena

• Ako pritisnete  dok je prikazan zaslon HOME, prikazat će se zaslon Get Started
umjesto izbornika SETTINGS.

• Ako pritisnete , možda se neće prikazati izbornik SETTINGS ovisno o zaslonu
prikazanom u aplikaciji kalkulatora.
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Promjena postavki kalkulatora
1. Pritisnite , odaberite ikonu aplikacije kalkulatora, a zatim pritisnite .
2. Pritisnite  za prikaz izbornika SETTINGS.

3. S pomoću tipki  i  odaberite Calc Settings ili System Settings, a
zatim pritisnite .
• Prikazat će se popis stavki postavki koje se nalaze u odabranom

izborniku.
Ovdje prikazani zaslon primjer je stavki prikazanih nakon odabira
izbornika [Calc Settings].

• Za stavke postavki koje se nalaze u izbornicima [Calc Settings] i
[System Settings] pogledajte odjeljak „Stavke i dostupne opcije
postavki” (stranica 21).

4. S pomoću tipki  i  označite stavku čiju postavku želite promijeniti, a
zatim pritisnite .
• Prikazat će se popis opcija postavki za odabranu stavku.

Ovdje prikazani zaslon primjer je stavki prikazanih nakon odabira
stavke [Input/Output].

5. S pomoću tipki  i  označite željenu opciju, a zatim pritisnite .
6. Nakon prilagodbe postavke na željenu razinu pritisnite .

Stavke i dostupne opcije postavki
„◆” označava zadane postavke.

Calc Settings > Input/Output

Označava oblik korišten na kalkulatoru za unos izraza i ispis rezultata
izračuna.
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MathI/MathO◆ Unos: u prirodnom obliku; ispis:
oblik koji sadržava razlomak, √  i/ili
π*1

MathI/DecimalO
Unos: u prirodnom obliku; ispis:
pretvoren u decimalnu vrijednost

LineI/LineO
Unos: linearni*2; ispis: decimalni ili
u obliku razlomaka

LineI/DecimalO
Unos: linearni*2; ispis: pretvoren u
decimalnu vrijednost

*1 Decimalni ispis primjenjuje se ako se iz nekog razloga ne mogu prikazati
navedeni oblici.

*2 Svi izračuni, uključujući razlomke i funkcije, unose se u jednom retku.
Ispis je isti kao kod modela koji nemaju prikaz kao na papiru (modeli
S-V.P.A.M. itd.)

Primjeri prikaza oblika unosa/ispisa:

MathI/MathO
(zadana postavka)

MathI/DecimalO
(Number Format: Norm 1)

(Number Format: Norm 2)

LineI/LineO

LineI/DecimalO
(Number Format: Norm 1)
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Calc Settings > Angle Unit

Degree◆; Radian; Gradian
Služi za određivanje stupnjeva, radijana ili grada kao mjerne jedinice kuta
za unos vrijednosti i prikaz rezultata izračuna.

Calc Settings > Number Format

Služi za određivanja broja znamenki za prikaz rezultata izračuna.
Fix: Vrijednost koju odaberete (od 0 do 9) utvrđuje se željeni broj značajnih
decimalnih mjesta za ispis rezultata. Rezultati izračuna zaokružuju se na
navedenu znamenku prije nego što se prikažu.

Primjer: 1 ÷ 6
(Fix 3)

1 6 ( )*

Sci: vrijednost koju odaberete (od 1 do 10) utvrđuje broj značajnih
decimalnih mjesta za ispis rezultata izračuna. Rezultati izračuna
zaokružuju se na navedenu znamenku prije nego što se prikažu.

Primjer: 1 ÷ 6
(Sci 3)

1 6 ( )*

Norm: služi za prikaz rezultata u obliku potencije broja 10 ako se rezultat
nalazi unutar raspona navedenog u nastavku.
Norm 1◆: 10-2 > |x|, |x| ≥ 1010, Norm 2: 10-9 > |x|, |x| ≥ 1010

Primjer: 1 ÷ 200
(Norm 1)

1 200 ( )*

(Norm 2)

1 200 ( )*
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* Ako pritisnete ( ) umjesto  nakon unosa izračuna, rezultat
izračuna prikazat će se u decimalnom obliku.

Calc Settings > Engineer Symbol

On; Off◆
Služi za određivanje hoće li se rezultati izračuna prikazati s pomoću
tehničkih simbola.

Napomena

• Ako je za ovu postavku odabrana opcija On, na vrhu zaslona prikazana je oznaka (E).

Calc Settings > Fraction Result

Mixed Fraction; Improp Fraction◆
Služi za određivanje hoće li se u rezultatima izračuna razlomci prikazivati u
nepravom ili miješanom obliku.

Calc Settings > Complex Result

a+bi◆; r∠θ
Služi za određivanje pravokutnih ili polarnih koordinata za rezultate
izračuna u aplikaciji Complex i rješenja polinoma u aplikaciji Equation.

Napomena

• Ako je za postavku Complex Result odabrana opcija a+bi, na vrhu zaslona prikazana
je oznaka i. Ako je odabrana opcija r∠θ, prikazana je oznaka ∠.

Calc Settings > Decimal Mark

Dot◆; Comma
Služi za određivanje hoće li se za decimalnu oznaku u rezultatu izračuna
prikazati točka ili zarez. Pri unosu uvijek se upotrebljava točka. Ako se
kao decimalna oznaka upotrebljava točka, višestruka rješenja razdvajaju
se zarezom (,). Ako je odabran zarez, razdjelnik je točka sa zarezom (;).

Calc Settings > Digit Separator

On; Off◆
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Služi za određivanje hoće li se u rezultatima izračuna upotrebljavati znak
razdjelnika.

System Settings > Contrast

Pogledajte odjeljak „Prilagodba kontrasta zaslona” (stranica 14).

System Settings > Auto Power Off

10 Min.◆; 60 Min.
Služi za određivanje vremena do aktivacije značajke Auto Power Off.

System Settings > MultiLine Font

Normal Font◆; Small Font
Služi za određivanje veličine prikazanog fonta kada je za Input/Output
odabrana opcija LineI/LineO ili LineI/DecimalO. Ako je odabrana normalna
veličina fonta (Normal Font), na zaslonu je moguće prikazati najviše četiri
retka, a ako je odabran mali font (Small Font), na zaslonu je moguć prikaz
najviše šest redaka.

System Settings > QR Code

Služi za određivanje prikazane verzije značajke QR Code kada pritisnete
(QR).

Version 3: označava 3. verziju značajke QR Code.
Version 11◆: označava 11. verziju značajke QR Code.

Reset > Settings & Data

Pogledajte odjeljak „Za aktivaciju postavki kalkulatora” (stranica 26).

Reset > Variable Memory

Pogledajte odjeljak „Brisanje sadržaja svih memorija” (stranica 39).

Reset > Initialize All

Pogledajte odjeljak „Pokretanje kalkulatora” (stranica 8).
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Get Started

Pogledajte odjeljak „Zaslon Get Started na kalkulatoru” (stranica 9).

Za aktivaciju postavki kalkulatora

Važno!

• Postupak u nastavku služi za pokretanje svih postavki kalkulatora, osim za aplikacije
Contrast i Auto Power Off. Također služi za brisanje svih podataka osim memorije
varijabli i podataka memorije Ans.

1. Pritisnite , odaberite ikonu aplikacije kalkulatora, a zatim pritisnite .
2. Pritisnite , a zatim odaberite [Reset] > [Settings & Data] > [Yes].

• Prikazat će se zaslon HOME.

Uporaba izbornika CATALOG
Pritisnite  za prikaz izbornika CATALOG. U tom su izborniku prikazane
kategorije naredba, funkcija i simbola u skladu s aplikacijom kalkulatora
koju trenutačno upotrebljavate te trenutačni status (prikazani zaslon ili
trenutačne postavke) aplikacije.

Primjer: izbornik CATALOG za aplikaciju Calculate

Napomena

• Za informacije o načinu unosa naredba, funkcija i simbola iz izbornika CATALOG
pogledajte odjeljak „Napredni izračuni” (stranica 47).

• Za informacije o naredbama, funkcijama i simbolima svojstvenima za svaku aplikaciju
kalkulatora pogledajte opise aplikacija kalkulatora u odjeljku „Uporaba aplikacija
kalkulatora” (stranica 67).

Uporaba izbornika TOOLS
Izbornik TOOLS pojavljuje se kada pritisnete  te sadržava stavke
izbornika za obavljanje funkcija svojstvenih svakoj aplikaciji kalkulatora i
za konfiguraciju postavki.
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Primjer: izbornik TOOLS za aplikaciju Calculate

Primjeri: izbornik TOOLS za aplikaciju Table

Napomena

• Stavka izbornika u nastavku zajednička je većem broju aplikacija kalkulatora.
– Undo (pogledajte odjeljak „Poništavanje radnji” (stranica 30))
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Unos izraza i vrijednosti

Osnovna pravila unosa
Kada pritisnete , automatski će se procijeniti redoslijed operacija i na
zaslonu će se prikazati rezultat.

4 × sin 30 × (30 + 10 × 3) = 120

*1 Iza sinusa i ostalih funkcija koje upotrebljavaju zagrade potrebno je
unijeti desnu zagradu.

*2 Moguće je izostaviti te simbole množenja (×).
*3 Moguće je izostaviti desnu zagradu neposredno prije operacije .

Prebacivanje pokazivača na početak ili kraj unesenog izraza

Pri unosu izraza možete pritisnuti  za prebacivanje pokazivača na
početak izraza ili  za prebacivanje pokazivača na kraj izraza.

Oznaka „More” (Više) u unesenom izrazu i rezultatu izračuna
( , )

Ako se zdesna retku unesenog izraza ili retku rezultata izračuna nalazi
simbol strelice (  ili ), prikazani redak nastavlja se udesno. S pomoću
tipki  i  pomičite redak ulijevo i udesno.
• Ako se na desnom kraju retka rezultata izračuna nalazi , možete

skočiti na kraj rezultata tako da pritisnete . Za skok na početak retka
rezultata izračuna pritisnite .

• Imajte na umu da ako želite pomicati uneseni izraz dok su prikazane
oznake  i , prvo trebate pritisnuti  ili , a potom pomaknuti izraz
s pomoću tipki  i .
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Automatsko umetanje zagrada

Ako izvršite izračun koji sadržava i operacije dijeljenja i množenja u kojima
je izostavljen znak množenja, automatski će se umetnuti zagrade kako je
prikazano u primjeru u nastavku.
– Kada izostavite znak množenja neposredno ispred otvorene zagrade ili

iza zatvorene zagrade.
Primjer: 6 ÷ 2(1 + 2) → 6 ÷ (2(1 + 2))

– Kada izostavite znak množenja neposredno prije varijable, konstante itd.
Primjer: 6 ÷ 2π → 6 ÷ (2π)

Oznaka ograničenja unosa

Oblik pokazivača promijenit će se u  kada preostane 10 bajtova ili manje
dozvoljenog unosa. Ako se to dogodi, završite unos izračuna i pritisnite

.

Unos izraza u prirodnom obliku
(samo MathI/MathO ili MathI/
DecimalO)
Izrazi koji uključuju razlomke i/ili posebne funkcije kao što je √  mogu
se unijeti na način na koji se pišu na papir s pomoću obrazaca koji se
pojave ako pritisnete određene tipke ili ako iz izbornika CATALOG unesete
određene funkcije.

Primjer: 3 1
2  + 5 3

2
1. Pritisnite ( ).

• Na taj se način unosi predložak za razlomak u miješanom obliku.

2. Unesite vrijednosti u polje cijelog broja, brojnika i nazivnika u obrascu.

3 1 2

3. Ponovite postupak za unos ostatka izraza.

( )5 3 2
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Napomena

• Dok se pokazivač za unos nalazi unutar područja za unos u obrascu (razlomci u
miješanom obliku, integriranje (∫) i suma (Σ)), pritiskom tipki  pokazivač će se
pomaknuti na položaj koji se nalazi neposredno nakon obrasca (zdesna obrascu), dok
će se pritiskom tipki  pokazivač pomaknuti na položaj neposredno prije obrasca
(slijeva obrascu).

• Uvijek možete znati na kojem se položaju pokazivač trenutačno nalazi u obrascu, jer
će prazno uokvireno područje ili znakovi na kojem se nalazi biti tamnocrno, dok će svi
ostali dijelovi izraza izračuna biti tamnosivi.

Poništavanje radnji
Za poništavanje posljednje radnje s pomoću tipke pritisnite , odaberite
opciju [Undo] i potom pritisnite .
Za vraćanje radnje koju ste upravo poništili pritisnite , odaberite opciju
[Undo], a zatim ponovno pritisnite .

Uporaba vrijednosti i izraza kao argumenata

Primjer: za unos izraza 1 + 7
6  i promjenu izraza u 1 + 

1 7 6 (INS)

Ako pritisnete (INS) u prethodno navedenom primjeru, 7
6  će postati

argument funkcije koju ćete unijeti sljedećom radnjom tipke (√ ).

Način za zamjenu teksta (samo LineI/
LineO ili LineI/DecimalO)
U načinu za zamjenu teksta tekstom koji unesete zamijenit će se tekst
na trenutačnom položaju pokazivača. Možete se prebacivati iz načina za
umetanje teksta u način za zamjenu teksta i obratno tako da provedete
radnju: (INS). U načinu za umetanje pokazivač će izgledati kao „ ”,
dok će u načinu za zamjenu teksta izgledati kao „ ”.

30

Copyrig
ht E

uro
co

m
 d.o

.o
.



Osnovni izračuni

Aritmetički izračuni
Obavite aritmetičke izračune s pomoću tipki , ,  i .

Primjer: 7 × 8 - 4 × 5 = 36

7 8 4 5

Računanje s razlomcima
Imajte na umu da metoda unosa razlomaka ovisi o trenutačnoj postavci
opcije Input/Output u izborniku SETTINGS.

Za unos 7
3  (razlomka u nepravom obliku)

(Input/Output: MathI/MathO ili MathI/DecimalO)

7 3 ili 7 3 7
3

(Input/Output: LineI/LineO ili LineI/DecimalO)

7 3

(a) brojnik, (b) nazivnik

Za unos 2 1
3  (razlomka u miješanom obliku)

(Input/Output: MathI/MathO ili MathI/DecimalO)

( )2 1 3 2 1
3

(Input/Output: LineI/LineO ili LineI/DecimalO)
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2 1 3

(a) brojnik, (b) nazivnik, (c) cijeli broj

Primjer: 2
3  + 1 1

2  = 13
6

(Input/Output: MathI/MathO)

2 3 ( )1 1 2

(Input/Output: LineI/LineO)

2 3 1 1 2

Napomena

• Razlomci u rezultatima izračuna prikazani su u pokraćenom obliku.

Za pretvorbu rezultata izračuna u razlomak u nepravom ili miješanom
obliku pritisnite . Za više informacija pogledajte odjeljak „Pretvorba
u razlomak u nepravom obliku i razlomak u miješanom obliku”
(stranica 44).

Rezultati izračuna u obliku razlomka

Nije moguć prikaz rezultata izračuna u obliku razlomka u miješanom obliku
ako je ukupni broj znamenaka (što uključuje cijeli broj, brojnik, nazivnik i
simbol razdjelnika ) veći od 10. U tom slučaju rezultat izračuna prikazan
je kao decimalna vrijednost.

Primjer 1.: 1 1 123456 = 123457 123456

(Input/Output: LineI/LineO)

1 1 123456

Budući da ukupan broj znamenaka razlomka 1 1 123456 iznosi 10,
rezultat je prikazan u obliku razlomka.

Primjer 2.: 1 1 1234567 (= 1234568 1234567) = 1,00000081
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(Input/Output: LineI/LineO)

1 1 1234567

Budući da ukupan broj znamenaka razlomka 1 1 1234567 iznosi 11,
rezultat je prikazan kao decimalna vrijednost.

Napomena

• Miješanje razlomaka i decimalnih vrijednosti u izračunu dok je odabrana neka druga
opcija pored opcije MathI/MathO dovest će do prikaza rezultata kao decimalne
vrijednosti.

Potencije, n-ti korijeni i recipročne
vrijednosti
S pomoću tipki u nastavku možete unijeti funkcije potencije, n-tih korijena i
recipročnih vrijednosti.
Funkcije potencije: (kvadratna vrijednost), (n-ta potencija)
Funkcije n-tih korijena: (drugi korijen), ( ) (n-ti korijen)
Funkcija recipročne vrijednosti: ( )

Primjer 1.: (52)3 = 15625

5 3

Primjer 2.: (1 + 1)2+2 = 16

1 1 2 2

Primjer 3.:√2 × 3 = 3√2 = 4,242640687...
(Input/Output: MathI/MathO)

2 3

(Input/Output: LineI/LineO)
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2 3

Primjer 4.: 5√32 = 2
(Input/Output: MathI/MathO)

( ) 5 32

(Input/Output: LineI/LineO)

5 ( ) 32

Primjer 5.: 10-1 = 1
10

(Input/Output: MathI/MathO)

10 ( )

Tipka  (10. potencija)

Funkcija tipke  odgovara pritisku tipki . Unos je obiju
operacija „×10 ” (MathI/MathO ili MathI/DecimalO) ili „×10^(” (LineI/LineO
ili LineI/DecimalO).

Primjer: 1,23 × 103 = 1230

1 23 3

Raspon izračuna oblika √ 

U nastavku su prikazani dopušteni rasponi prikaza rezultata izračuna
oblika √ .

± a√b, ± d ± a√b, ± a√b
c  ± d√e

f
1 ≤ a < 100, 1 < b < 1000, 1 ≤ c < 100
0 ≤ d < 100, 0 ≤ e < 1000, 1 ≤ f < 100
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Primjer:
• 10√2 + 15 × 3√3 = 45√3 + 10√2 ... Prikazano u obliku √ 
• 99√999 (= 297√111) = 3129,089165 ... Prikazano kao decimalna

vrijednost

Pi, baza prirodnog logaritma e

Pi
Unesite π tako da pritisnete (π).
π se prikazuje kao 3,141592654, ali u izračunima se upotrebljava π =
3,1415926535897932384626.

Baza prirodnog logaritma e
Unesite e tako da pritisnete (e).
Baza prirodnog logaritma e prikazuje se kao 2,718281828, ali u izračunima
se upotrebljava e = 2,7182818284590452353602.

Povijest i ponavljanje izračuna

Povijest izračuna
Oznaka  i/ili  na vrhu zaslona upućuje na to da iznad i/ili ispod
prikazanog sadržaja postoji više povijesti izračuna. Kroz sadržaj povijesti
izračuna možete se kretati s pomoću tipki  i .

Aplikacije u kojima je podržana povijest izračuna:
Calculate, Complex, Base-N

Primjer
2 + 2 = 4

2 2

3 + 3 = 6

3 3
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(Vraćanje unatrag.)

Napomena

• Ako pritisnete  ili , promijenite postavku opcije Input/Output ili obavite postupak
Reset („Settings & Data” ili „Initialize All”), izbrisat će se svi podaci povijesti izračuna.

Ponavljanje
Dok je na zaslonu prikazan rezultat izračuna, možete pritisnuti ,  ili

 kako biste uredili izraz koji ste upotrijebili za prethodni izračun.

Primjer
4 × 3 + 2 = 14

4 3 2

4 × 3 - 7 = 5

(Nastavak)  7

Napomena

• Ako je na bilo kojem kraju ili oba kraja retka rezultata izračuna prikazana oznaka 
(ulijevo) ili  (udesno), s pomoću tipki  i  možete pomaknuti redak ulijevo i
udesno. Ako je tome tako, prvo pritisnite  ili , a zatim s pomoću tipki  i 
uredite izraz.

Uporaba memorijskih funkcija

Pozitivna memorija (Ans)
Rezultat posljednjeg izračuna se pohranjuje u memoriji Ans (pozitivnoj
memoriji).

Uporaba memorije Ans za provedbu niza izračuna

Primjer: dijeljenje rezultata 3 × 4 sa 30
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3 4

(Nastavak)  30

Unos sadržaja memorije Ans u izraz

Primjer: provedba izračuna prikazanog u nastavku:

123 456

(Nastavak)  789

Varijable (A, B, C, D, E, F, x, y, z)
U varijable možete pohraniti željene vrijednosti te ih potom upotrijebiti u
izračunima.

Zaslon popisa varijabli

Ako pritisnete , na zaslonu će se prikazati vrijednosti koje su trenutačno
pohranjene u varijablama A, B, C, D, E, F, x, y i z. Na tom zaslonu
vrijednosti se uvijek prikazuju s pomoću postavke „Norm 1” za opciju
Number Format. Kako biste zatvorili zaslon, pritisnite  ili .

Primjer 1.: pohranjivanje rezultata 3 + 5 u varijablu A
1. Provedite izračun.

3 5

2. Pritisnite , a zatim odaberite [A=] > [Store].
• Na taj ćete način rezultat 3 + 5 (koji je jednako 8) pohraniti u varijablu

A.
3. Pritisnite .
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Primjer 2.: promjena sadržaja varijable A u 1
1. Pritisnite , a zatim označite [A=].

2. Pritisnite .
• Prikazat će se zaslon za uređivanje na kojem je unesen broj 1.

3. Pritisnite .

Napomena

• Umjesto postupka iz koraka 2. možete pritisnuti  i potom odabrati [Edit]. Prikazat će
se zaslon za uređivanje bez unosa. Unesite željenu vrijednost, a zatim pritisnite .

• Ako ste označili varijablu na zaslonu s popisom varijabli i pojavila se ikona lokota ( ),
ne možete uređivati označenu varijablu.

Primjer 3.: pozivanje vrijednosti varijable A
(nastavak koraka 2. u primjeru 1.)
1. Pritisnite , a zatim odaberite [A=] > [Recall].

• Unijet će se „A”.

2. Pritisnite .
• Na taj ćete način pozvati vrijednost varijable A.

Primjer 4.: množenje sadržaja varijable A s 10
(nastavak koraka 2. u primjeru 1.)
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(A)* 10

* Unesite varijablu na sljedeći način: pritisnite , a zatim pritisnite tipku
koja odgovara nazivu željene varijable. Kako biste unijeli x kao naziv
varijable, možete pritisnuti (x) ili .

Brisanje sadržaja svih memorija
Sadržaj memorije Ans i sadržaj varijabli zadržava se čak i ako pritisnete

, promijenite aplikaciju kalkulatora ili isključite kalkulator.
Kada želite obrisati sadržaj iz svih memorija, obavite sljedeći postupak.
1. Pritisnite , odaberite ikonu aplikacije kalkulatora, a zatim pritisnite .
2. Pritisnite , a zatim odaberite [Reset] > [Variable Memory] > [Yes].
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Promjena oblika rezultata
izračuna

Uporaba izbornika FORMAT
S pomoću izbornika FORMAT, koji se pojavi kada pritisnete , možete
pretvoriti prikazani rezultat izračuna u različite oblike.

Popis stavki u izborniku FORMAT

Stavka izbornika: Služi za pretvorbu u oblik:

Standard
Standard (obuhvaća oblik razlomka, π,
√ )

Decimal Decimalni

Prime Factor Faktorizacija

Rectangular Coord Pravokutne koordinate

Polar Coord Polarne koordinate

Improper Fraction Razlomak u nepravom obliku

Mixed Fraction Razlomak u miješanom obliku

ENG Notation
Tehnički oblik (oblik a×10n, n =
eksponent djeljiv s 3)

Sexagesimal
Stupnjevi, minute, sekunde
(seksagezimalni oblik)
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Napomena

• Stavke izbornika koje se pojave kada pritisnete  ovise o trenutačno prikazanom
rezultatu izračuna. Osim toga, ako prikazani rezultat izračuna nije moguće pretvoriti,
neće se pojaviti izbornik kada pritisnete .

Primjer postupka pretvorbe

Primjer: 3 ÷ 2 = 3
2  = 1,5 = 1 1

2
U ovom primjeru pretvorit ćemo rezultat izračuna prikazan kao razlomak u
nepravom obliku u decimalnu vrijednost, a zatim u razlomak u miješanom
obliku. Naposljetku ćemo otkazati pretvorbu i vratiti se na prvotni rezultat
izračuna.
(Input/Output: MathI/MathO, Fraction Result: Improp Fraction)

1. Provedite izračun 3 ÷ 2.

3 2

2. Za pretvorbu rezultata izračuna u decimalnu vrijednost pritisnite ,
odaberite [Decimal], a zatim pritisnite .

3. Za pretvorbu rezultata izračuna u razlomak u miješanom obliku pritisnite
, odaberite [Mixed Fraction], a zatim pritisnite .

4. Za otkazivanje pretvorbe pritisnite .
• Prikazat će se prvotni rezultat izračuna iz koraka 1.
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Pretvorba u oblike Standard i
Decimal
Standard je oblik prikaza rezultata izračuna koji, kad god je to moguće,
sadržava razlomak, √  ili π. Decimal je oblik prikaza rezultata izračuna kao
decimalne vrijednosti.

Napomena

• Pretvorba izraza koji sadržava √  ili π u format Standard moguća je ako je za postavku
Input/Output u izborniku SETTINGS odabrana opcija MathI/MathO ili MathI/DecimalO.

U okviru postupka u nastavku možete pretvoriti rezultat izračuna u oblik
Standard ili Decimal.

Primjer: π ÷ 6 = 1
6  π = 0,5235987756 (Input/Output: MathI/MathO)

(π) 6

(Odaberite [Decimal].)

(Pretvorba u decimalnu vrijednost.)

(Pretvorba u oblik Standard.)

Važno!

• U slučaju određenih rezultata izračuna odabirom oblika [Standard] u izborniku
FORMAT neće se pretvoriti prikazana vrijednost.
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Dobivanje rezultata izračuna decimalne vrijednosti dok je
odabrana opcija MathI/MathO ili LineI/LineO

Nakon unosa izračuna pritisnite ( ) umjesto .

Faktorizacija
U aplikaciji Calculate prirodni broj koji nije dulji od 10 znamenki može se
faktorizirati na proste faktore.

Primjer: faktorizacija broja 1014

1014

 – [Prime Factor]

Napomena

• Sljedeće vrste vrijednosti nije moguće faktorizirati, čak i ako imaju 10 ili manje
znamenki.
– ako je jedan prosti faktor veći ili jednak 1 018 081.
– ako dva ili više prostih faktora imaju više od tri znamenke.

• Dio koji se ne može faktorizirati ostavlja se u zagradi.
Primjer: 2036162 = 2 × (1018081)*

*1018081 = 10092

2036162
 – [Prime Factor]

Pretvorba u pravokutne i polarne
koordinate
Možete pretvoriti rezultat izračuna s kompleksnim brojevima u pravokutne
koordinate (  – [Rectangular Coord]) ili polarne koordinate (  – [Polar
Coord]). Postupak pretvorbe možete provesti u sljedećim slučajevima:
• dok je prikazano rješenje jednadžbe višeg reda u aplikaciji Equation

(pod uvjetom da je za postavku – [Complex Roots] u aplikaciji
[Equation] odabrana opcija On)

• dok je prikazan rezultat izračuna u aplikaciji Complex
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Za primjer stvarnih postupaka pretvorbe pogledajte odjeljke navedene u
nastavku.
„Pretvorba rješenja s kompleksnim brojevima u pravokutne ili
polarne koordinate” (stranica 106)
„Pretvorba rezultata izračuna s kompleksnim brojevima u pravokutne
ili polarne koordinate” (stranica 113)

Pretvorba u razlomak u nepravom
obliku i razlomak u miješanom
obliku
Možete pretvoriti trenutačno prikazani rezultat izračuna u obliku razlomka
ili decimalne vrijednosti (decimalne vrijednosti koja se na ovom kalkulatoru
može pretvoriti u razlomak) u razlomak u miješanom obliku ili razlomak u
nepravom obliku.

Primjer 1.: 13
4  = 3 1

4
(Input/Output: MathI/MathO, Fraction Result: Improp Fraction)

13 4

 – [Mixed Fraction]

 – [Improper Fraction]

Primjer 2.: 3,25 = 13
4  = 3 1

4  (Input/Output: LineI/LineO)

3 25

 – [Improper Fraction]

 – [Mixed Fraction]

Tehnički oblik
Možete pretvoriti dio u eksponentu prikazane vrijednosti rezultata izračuna
u treću potenciju s bazom 10 te se rezultat može prikazati u tom obliku.

Primjer: pretvorba 1234 u tehnički oblik premještanjem decimalne oznake
udesno, a zatim lijevo.
1. Unesite 1234, a zatim pritisnite .
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2. Provedite postupak u nastavku za pristup načinu rada za pretvorbu
ENG.

 – [ENG Notation]

• Ulaskom u način rada za pretvorbu ENG rezultat izračuna pretvara se
u tehnički oblik i s desne se strane pojavljuje .

• U načinu rada za pretvorbu ENG s pomoću tipki  i  možete
pomicati decimalni zarez vrijednosti logaritma.

3. Za izlazak iz načina rada za pretvorbu ENG pritisnite .
• Izići ćete iz načina rada za pretvorbu ENG i sa zaslona će nestati .

• Umjesto toga iz načina rada za pretvorbu ENG možete izići tako da
pritisnete  ili .

Napomena

• U načinu rada za pretvorbu ENG nije moguće provesti uobičajene izračune. Za
početak novog izračuna izađite iz načina rada za pretvorbu ENG.

• Tehnički oblik može se prikazati i s pomoću tehničkih simbola. Za pojedinosti
pogledajte odjeljak „Tehnički simboli” (stranica 57).
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Pretvorba u seksagezimalni oblik
(izračuni sa stupnjevima, minutama,
sekundama)
Možete pretvoriti rezultat izračuna iz decimalne vrijednosti u
seksagezimalnu vrijednost.

Pretvaranje rezultata izračuna iz decimalne
vrijednosti u seksagezimalnu vrijednost

Primjer: 1,25 = 1°15’0”

1 25

 – [Sexagesimal]

Unos i računanje sa seksagezimalnom vrijednošću
Osim pretvorbe prikazane vrijednosti u seksagezimalnu vrijednost možete
i unijeti seksagezimalne vrijednosti i upotrebljavati ih u izračunima.
Sintaksa u nastavku služi za unos seksagezimalne vrijednosti:

{stupnjevi} ( ) {minute} ( ) {sekunde} ( )
Imajte na umu da uvijek morate unijeti stupnjeve i minute, čak i ako je
vrijednost nula.

Primjer: provedba izračuna 2°20’30” + 9’30” i pretvorba rezultata izračuna
u decimalnu vrijednost.

2 ( )20 ( )30 ( )
0 ( )9 ( )30 ( )

(Pretvorba u decimalnu vrijednost.)
 – [Decimal]

(Povratak na prikaz u seksagezimalnom obliku.)
 – [Sexagesimal]
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Napredni izračuni
U ovom su odjeljku opisane naredbe, funkcije i simboli koje sadržavaju sve
aplikacije kalkulatora. Redoslijed u kojem su naredbe, funkcije i simboli
prikazani u ovom odjeljku odgovara redoslijedu njihova prikaza u izborniku
CATALOG koji se pojavi kada pritisnete .

Napomena

• Postoje i stavke izbornika CATALOG svojstvene određenim aplikacijama kalkulatora
koje nisu prikazane ovdje. Za više informacija o stavkama izbornika svojstvenima
određenim aplikacijama pogledajte poglavlja o relevantnim aplikacijama kalkulatora.

• Ovisno o korištenoj aplikaciji kalkulatora i zaslonu prikazanom u aplikaciji kalkulatora
možda nećete moći unijeti određene naredbe, funkcije ili simbole. Naredbe, funkcije i
simboli koje ne možete unijeti ne nalaze se u izborniku CATALOG.

• Naredbe, funkcije i simboli opisani u ovom odjeljku nisu dostupni u aplikaciji Base-N.

Analiza funkcija
Ovaj odjeljak sadržava objašnjenja naredbi i funkcija koje možete unijeti
tako da odete na:  – [Func Analysis].

Derivative(d/dx)
Funkcija Derivative(d/dx) služi za dobivanje derivacije na određenoj x
koordinati (a) u unesenom izrazu f(x).

Napomena

• Funkcija se može upotrebljavati sa svim sljedećim aplikacijama kalkulatora: Calculate,
Statistics, Distribution, Spreadsheet, Table, Equation, Inequality, Matrix, Vector, Ratio.

Sintaksa unosa

Sintaksa unosa ovisi o postavci Input/Output u izborniku SETTINGS, kako
je prikazano u tablici u nastavku.

Postavka Input/Output Sintaksa unosa

MathI/MathO ili MathI/DecimalO  d
dx (f(x))|x=a
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LineI/LineO ili LineI/DecimalO  d
dx (f(x), a, tol)*

* tol označava toleranciju, koja iznosi 1 × 10-16 ako se ništa ne unese za
tol.

Mjere opreza pri izračunu derivacije

• Za trigonometrijske funkcije f(x) postavite „Radian” kao Angle Unit u
izborniku SETTINGS.

• Manjom vrijednošću tol povećava se preciznost, ali i vrijeme računanja.
Kada unosite tol, unesite vrijednost koja iznosi 1 × 10-22 ili više.

• Netočne rezultate i greške može uzrokovati sljedeće:
– prekide u vrijednosti x
– iznimno velike promjene vrijednosti x
– uključivanje lokalnog maksimuma i lokalnom minimuma u vrijednosti x
– uključivanje točke infleksije u vrijednosti x
– uključivanje točki koje nije moguće diferencirati u vrijednosti x
– rezultati diferencijalnog izračuna koji se približavaju nuli.

Primjer izračuna derivacije

Utvrđivanje vrijednosti f’( π
2 ) ako f(x) = sin(x) (izostavljeno je utvrđivanje

vrijednosti tol.)
(Input/Output: MathI/MathO, Angle Unit: Radian)

 – [Func Analysis] > [Derivative(d/dx)]
(π) 2

(Input/Output: LineI/LineO, Angle Unit: Radian)

 – [Func Analysis] > [Derivative(d/dx)]
(,) (π) 2

Integration(∫)
Na ovom kalkulatoru integracija se provodi s pomoću Gauss-Kronrodove
metode numeričke integracije.

Napomena

• Funkcija se može upotrebljavati sa svim sljedećim aplikacijama kalkulatora: Calculate,
Statistics, Distribution, Spreadsheet, Table, Equation, Inequality, Matrix, Vector, Ratio.
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Sintaksa unosa

Sintaksa unosa ovisi o postavci Input/Output u izborniku SETTINGS, kako
je prikazano u tablici u nastavku.

Postavka Input/Output Sintaksa unosa

MathI/MathO ili MathI/DecimalO

LineI/LineO ili LineI/DecimalO

* tol označava toleranciju, koja iznosi 1 × 10-10 ako se ništa ne unese za
tol.

Mjere opreza pri izračunu integracije

• Za trigonometrijske funkcije f(x) postavite „Radian” kao Angle Unit u
izborniku SETTINGS.

• Manjom vrijednošću tol povećava se preciznost, ali i vrijeme računanja.
Kada unosite tol, unesite vrijednost koja iznosi 1 × 10-22 ili više.

• Ovisno o sadržaju funkcije f(x), pozitivnih i negativnih vrijednosti u
području integracije ili području integracije, pri izračunu vrijednosti
integracije može doći do velikih grešaka. (Primjeri: ako postoje dijelovi
s prekinutim točkama ili naglim promjenama; ako je interval integracije
preširok.) U takvim slučajevima dijeljenjem intervala integracije u više
dijelova i naknadnom provedbom izračuna možete povećati preciznost
izračuna.

Primjer izračuna integracije

(ln(x), 1, e) = 1 (izostavljeno je utvrđivanje vrijednosti tol)

(Input/Output: MathI/MathO)

 – [Func Analysis] > [Integration(∫)]
(ln) 1 (e)

(Input/Output: LineI/LineO)
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 – [Func Analysis] > [Integration(∫)]
(ln) (,)1 (,) (e)

Summation(Σ)
S pomoću sume (Σ) možete dobiti sumu unesenog izraza f(x) za određeni
raspon.

Napomena

• Funkcija se može upotrebljavati sa svim sljedećim aplikacijama kalkulatora: Calculate,
Statistics, Distribution, Spreadsheet, Table, Equation (osim za Solver), Inequality,
Matrix, Vector, Ratio.

Sintaksa unosa

Sintaksa unosa ovisi o postavci Input/Output u izborniku SETTINGS, kako
je prikazano u tablici u nastavku.

Postavka Input/Output Sintaksa unosa

MathI/MathO ili MathI/DecimalO

LineI/LineO ili LineI/DecimalO

* a i b cijeli su brojevi koji se mogu utvrditi u rasponu -1 × 1010 < a ≤ b < 1 ×
1010.

Primjer izračuna sume (Σ)

 (x + 1) = 20

(Input/Output: MathI/MathO)

 – [Func Analysis] > [Summation(Σ)]
1 1 5

(Input/Output: LineI/LineO)

 – [Func Analysis] > [Summation(Σ)]
1 (,)1 (,)5
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Logarithm(logab), Logarithm(log)
Ako pritisnete (log) ili idete na  – [Func Analysis] >
[Logarithm(log)], možete unijeti logab kao log (a, b). Baza 10 zadana je
postavka ako ne unesete ništa za a.

Primjer 1.: log101000 = log 1000 = 3

(log)1000

Primjer 2.: log216 = 4

(log)2 (,)16

Tipku  (ili  – [Func Analysis] > [Logarithm(logab)]) također možete
upotrijebiti za unos, ali samo ako je za Input/Output u izborniku SETTINGS
odabrana opcija MathI/MathO ili MathI/DecimalO. U tom slučaju morate
unijeti vrijednost za bazu.

Primjer 3.: log216 = 4

2 16

Natural Logarithm
Unesite „ln” tako da pritisnete (ln) ili idete na  – [Func Analysis] >
[Natural Logarithm].

Primjer: ln 90 (= loge90) = 4,49980967

(ln)90

Vjerojatnost
Ovaj odjeljak sadržava objašnjenja naredbi i funkcija koje možete unijeti
tako da odete na:  – [Probability].
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%
Ako unesete vrijednost i unesete naredbu %, vrijednost unosa postat će
postotak.

Napomena

• Ne možete unijeti % s pomoću aplikacije Complex.

Primjer 1.: 150 × 20 % = 30

150 20
 – [Probability] > [%]

Primjer 2.: Izračunavanje postotka od 880 koji predstavlja 660. (75 %)

660 880
 – [Probability] > [%]

Primjer 3.: Umanjivanje 3500 za 25 %. (2625)

3500 3500 25
 – [Probability] > [%]

Factorial(!)
Ova funkcija služi za dobivanje faktorijela vrijednosti koja odgovara nuli ili
prirodnom broju.

Primjer: (5 + 3)! = 40320

5 3
 – [Probability] > [Factorial(!)]

Permutation(P), Combination(C)
Funkcije permutacije (nPr) i kombinacije (nCr).

Primjer: određivanje broja mogućih permutacija i kombinacija kada se
odaberu četiri osobe iz skupine od 10
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Permutacije:

10
 – [Probability] > [Permutation(P)]

4

Kombinacije:

10
 – [Probability] > [Combination(C)]

4

Random Number
Funkcija služi za generiranje pseudoslučajnog broja u rasponu od
0,000 do 0,999. Rezultat se prikazuje kao razlomak ako je u izborniku
SETTINGS za Input/Output odabrana opcija MathI/MathO.

Napomena

• Ran# ne možete unijeti s pomoću značajke Solver u aplikaciji Equation.

Primjer: dobivanje slučajnih troznamenkastih cijelih brojeva

1000
 – [Probability] > [Random Number]

(Rezultat se razlikuje pri svakom izvršenju.)

Random Integer
Funkcija služi za generiranje pseudoslučajnog cijelog broja unutar zadanih
vrijednosti.

Napomena

• RanInt# ne možete unijeti s pomoću značajke Solver u aplikaciji Equation.

Primjer: generiranje slučajnih cijelih brojeva u rasponu od 1 do 6

 – [Probability] > [Random Integer]
1 (,)6

(Rezultat se razlikuje pri svakom izvršenju.)
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Numerički izračuni
Ovaj odjeljak sadržava objašnjenja naredbi i funkcija koje možete unijeti
tako da odete na:  – [Numeric Calc].

Absolute Value
Kada provodite izračune s realnim brojevima, ova funkcija služi za
jednostavno dobivanje apsolutne vrijednosti.

Primjer: |2 - 7| = Abs(2 - 7) = 5
(Input/Output: MathI/MathO)

 – [Numeric Calc] > [Absolute Value]
2 7

(Input/Output: LineI/LineO)

 – [Numeric Calc] > [Absolute Value]
2 7

Round Off
S pomoću funkcije Round Off (Rnd) vrijednost decimalnog razlomka
argumenta zaokružuje se u skladu s trenutačnom postavkom Number
Format. Na primjer, interni i prikazani rezultat za Rnd(10 ÷ 3) je 3,333
kada postavka Number Format jeste Fix 3. Ako se koristi postavka Norm 1
ili Norm 2, argument će se zaokružiti na 11. decimalu.

Primjer: da biste obavili sljedeće izračune kada je odabrana opcija Fix 3
za broj znamenki koje se prikazuju: 10 ÷ 3 × 3 i Rnd(10 ÷ 3) × 3
(Input/Output: MathI/DecimalO, Number Format: Fix 3)

10 3 3

 – [Numeric Calc] > [Round Off]
10 3 3
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Mjerna jedinica kuta,
polarne/pravokutne koordinate,
seksagezimalni oblik
Ovaj odjeljak sadržava objašnjenja naredbi, funkcija i simbola koje možete
unijeti tako da odete na:  – [Angle/Coord/Sexa].

Degrees, Radians, Gradians
Te funkcije služe za određivanje mjerne jedinice kuta.
° služi za određivanje stupnjeva, r radijana, a g grada.
Svaku funkciju možete unijeti s pomoću stavki izbornika u nastavku.

 – [Angle/Coord/Sexa] > [Degrees]
 – [Angle/Coord/Sexa] > [Radians]
 – [Angle/Coord/Sexa] > [Gradians]

Primjer: π/2 radijana = 90° (Angle Unit: Degree)

(π) 2
 – [Angle/Coord/Sexa] > [Radians]

Rect to Polar, Polar to Rect
„Pol(” služi za pretvaranje pravokutnih koordinata u polarne koordinate, a
„Rec(” služi za pretvaranje polarnih koordinata u pravokutne koordinate.

• Prije provedbe izračuna odredite Angle Unit u izborniku SETTINGS.
• Rezultati izračuna za r i θ te za x i y pohranjuju se pojedinačno u

varijable x i y.
• Rezultat izračuna θ prikazuje se u rasponu od -180° < θ ≤ 180°.

Napomena

• Pol( i Rec( možete upotrebljavati na zaslonu izračuna u sljedećim aplikacijama•
kalkulatora:
Calculate, Statistics, Matrix, Vector
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Primjer 1.: pretvaranje pravokutnih koordinata (√2, √2) u polarne
koordinate (Input/Output: MathI/MathO, Angle Unit: Degree)

 – [Angle/Coord/Sexa] > [Rect to Polar]
2 (,) 2

Primjer 2.: pretvaranje polarnih koordinata (√2, 45°) u pravokutne
koordinate (Input/Output: MathI/MathO, Angle Unit: Degree)

 – [Angle/Coord/Sexa] > [Polar to Rect]
2 (,) 45

Stupnjevi, minute, sekunde
S pomoću tipki ili stavki izbornika u nastavku možete unijeti simbol
seksagezimalnog oblika ( ).

( )
 – [Angle/Coord/Sexa] > [Degs Mins Secs]

Za pojedinosti pogledajte odjeljak „Pretvorba u seksagezimalni oblik
(izračuni sa stupnjevima, minutama, sekundama)” (stranica 46).

Hiperbolne, trigonometrijske
funkcije
U ovom su odjeljku pojašnjene hiperbolne i trigonometrijske funkcije.

Hiperbolne funkcije
Hiperbolne funkcije moguće je unijeti s pomoću stavki izbornika u
nastavku.

 – [Hyperbolic/Trig] > [sinh], [cosh], [tanh], [sinh-1], [cosh-1] ili [tanh-1]

Ova postavka kutne jedinice ne utječe na izračune.

Primjer: sinh 1 = 1,175201194

 – [Hyperbolic/Trig] > [sinh] 1
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Trigonometrijske funkcije
Trigonometrijske funkcije moguće je unijeti s pomoću tipki ili stavki
izbornika u nastavku.

Tipka Stavka izbornika

 – [Hyperbolic/Trig] > [sin]

 – [Hyperbolic/Trig] > [cos]

 – [Hyperbolic/Trig] > [tan]

(sin-1)  – [Hyperbolic/Trig] > [sin-1]

(cos-1)  – [Hyperbolic/Trig] > [cos-1]

(tan-1)  – [Hyperbolic/Trig] > [tan-1]

Prije provedbe izračuna odredite Angle Unit u izborniku SETTINGS.

Primjer: sin 30 = 1
2  (Angle Unit: Degree)

30

Tehnički simboli
Kalkulator podržava uporabu 11 tehničkih simbola (m, μ, n, p, f, k, M, G, T,
P, E) koje možete upotrebljavati za unos vrijednosti ili za prikaz rezultata
izračuna.
• Tehničke simbole možete unijeti tako da idete na:  – [Engineer

Symbol].
• Za prikaz rezultata izračuna s tehničkim simbolima idite na:  – [Calc

Settings] > [Engineer Symbol] > [On].

Primjer unosa i izračuna s pomoću tehničkih simbola

Primjer 1.: unos vrijednosti 500k
(Engineer Symbol: On)
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500  – [Engineer Symbol] > [Kilo] 

Primjer 2.: provedba izračuna 999 k (kilo) + 25 k (kilo) = 1,024 M (mega)
= 1024 k (kilo) = 1024000
(Engineer Symbol: On)

999  – [Engineer Symbol] > [Kilo] 
25  – [Engineer Symbol] > [Kilo] 

 – [ENG Notation]
(Služi za pristup načinu rada za pretvorbu

ENG.)

• Ako pritisnete ,  ili , izići ćete iz načina rada za pretvorbu ENG
i sa zaslona će nestati . Za početak novog izračuna izađite iz načina
rada za pretvorbu ENG.

• Za pojedinosti o načinu rada za pretvorbu ENG pogledajte odjeljak
„Tehnički oblik” (stranica 44).

Znanstvene konstante
Kalkulator dolazi s 47 ugrađenih znanstvenih konstanti. Vrijednosti se
temelje na preporučenim vrijednostima povjerenstva CODATA (2018.).

Primjer: za unos znanstvene konstante c (brzina svjetlosti u vakuumu) i
prikaz njene vrijednosti
1. Pritisnite , odaberite [Sci Constants], a zatim pritisnite .

• Prikazat će se izbornik s kategorijama znanstvenih konstanti*.

2. Odaberite [Universal], a zatim pritisnite .
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• Prikazat će se izbornik sa znanstvenim konstantama unutar kategorije
Universal.

3. Odaberite [c], a zatim pritisnite .

4. Pritisnite .

* U tablici u nastavku prikazane su znanstvene konstante iz svake
kategorije.

Kategorija Znanstvene konstante

Universal h, , c, ε0, μ0, Z0, G, lP, tP

Electromagnetic μN, μB, e, Φ0, G0, KJ, RK

Atomic&Nuclear
mp, mn, me, mμ, a0, α, re, λC, γp,
λCp, λCn, R∞, μp, μe, μn, μμ, mτ

Physico-Chem mu, F, NA, k, Vm, R, c1, c2, σ

Adopted Values gn, atm, RK-90, KJ-90

Other t

Pretvorba jedinica
S pomoću naredbi za pretvorbu jedinica možete izvršiti pretvorbu mjernih
jedinica iz metričkih u anglosaksonske i obratno. Podaci formule za
pretvorbu temelje se na dokumentu „NIST Special Publication 811 (2008)”.

Primjer: za pretvaranje 5 cm u inče (Input/Output: LineI/LineO)
1. Unesite vrijednost koju želite pretvoriti.

5
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2. Pritisnite , odaberite [Unit Conversions], a zatim pritisnite .
• Prikazat će se izbornik s kategorijama pretvorbe jedinica*.

3. Odaberite [Length], a zatim pritisnite .
• Prikazat će se izbornik s naredbama za pretvorbu unutar kategorije

Length.

4. Odaberite [cm in] (naredbu za pretvorbu centimetara u inče) i zatim
pritisnite .

5. Pritisnite .

* U tablici u nastavku prikazane su naredbe za pretvorbu jedinica iz svake
kategorije.

Kategorija Naredbe za pretvorbu jedinica

Length (duljina)
in cm, cm in, ft m, m ft, yd m, m

yd, mile km, km mile, n mile m,
m n mile, pc km, km pc

Area (površina) acre m2, m2 acre

Volume (obujam)
gal(US) L, L gal(US), gal(UK) L, L

gal(UK)

Mass (masa) oz g, g oz, lb kg, kg lb

Velocity (brzina) km/h m/s, m/s km/h

Pressure (tlak)
atm Pa, Pa atm, mmHg Pa, Pa

mmHg, kgf/cm2 Pa, Pa kgf/cm2,
lbf/in2 kPa, kPa lbf/in2

Energy (energija) kgf m J, J kgf m, J cal15, cal15 J
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*1

*2

*3

Power (snaga) hp kW, kW hp

Temperature (temperatura) °F °C, °C °F

Ostalo
Funkcije i simbole koje možete unijeti s pomoću tipki na kalkulatoru
možete unijeti i s pomoću izbornika [Other]. Idite na  – [Other] za
prikaz izbornika s funkcijama i simbolima. Primjerice, za unos funkcije Ans
možete pritisnuti  ili pritisnuti sljedeće:  – [Other] > [Ans].
U tablici u nastavku prikazane su stavke izbornika [Other] koje odgovaraju
funkcijama navedenih tipki.

Stavka izbornika Tipka

Ans

π (π)

e (e)

√ (

x√ ( ( )

-1 ( )

2

^(

- ((-))

, (,)

(

)

*1 Recipročna vrijednost
*2 Kvadratna vrijednost
*3 Znak minus
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Registracija i uporaba
definicijskih jednadžbi za f(x) i
g(x)

Registracija i uporaba definicijskih
jednadžbi za f(x) i g(x)
Kalkulator sadržava funkcije „f(” i „g(” koje možete upotrebljavati nakon
registracije definicijskih jednadžbi. Primjerice, nakon registracije jednadžbe
f(x) = x2 + 1 kao definicijske jednadžbe za funkciju „f(”, možete izračunati
f(0) = 1 i f(5) = 26.
Ako pritisnete , prikazat će se izbornik za registraciju definicijske
jednadžbe za f(x) ili g(x) i za unos vrijednosti „f(” ili „g(”.

Napomena

• Definicijske jednadžbe za f(x) i g(x) upotrebljavaju se za f(x) i g(x) i u aplikaciji
Table. Za informacije o aplikaciji Table pogledajte odjeljak „Izrada brojevne tablice”
(stranica 97).

Registracija definicijske jednadžbe
Primjer 1.: registracija jednadžbe f(x) = x2 + 1
1. Pritisnite , odaberite ikonu aplikacije Calculate, a zatim pritisnite .
2. Pritisnite , a zatim odaberite [Define f(x)].

• Prikazat će se zaslon za registraciju jednadžbe f(x).

3. Unesite x2 + 1.

1

4. Pritisnite .
• Registrirat će se uneseni izraz i ponovno će se pojaviti zaslon koji je

bio prikazan prije nego što ste pritisnuli  u koraku 2. u okviru ovog
postupka.
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Napomena

• Definicijsku jednadžbu moguće je registrirati u bilo kojoj aplikaciji kalkulatora osim u
aplikacijama Distribution, Equation (Simul Equation / Polynomial), Inequality, Base-N,
Ratio i Math Box. Međutim, ovisno o zaslonu prikazanom u aplikaciji kalkulatora (npr.
ako je prikazan zaslon izbornika) možda se neće prikazati izbornik kada pritisnete .

Provedba izračuna dodjelom vrijednosti
registriranoj definicijskoj jednadžbi

Primjer 2.: dodjela vrijednosti x = 3 jednadžbi f(x), koju ste registrirali u
primjeru 1.
(Nastavak primjera 1.)
1. Pritisnite , a zatim odaberite [f(x)].

• Time ćete unijeti „f(”.

2. Dodijelite vrijednost 3 i provedite izračun.

3

Registracija kompozicije funkcija
Primjer 3.: unos funkcije f(x) definirane u primjeru 1. u g(x) radi registracije
jednadžbe g(x) = f(x) × 2 - x
(Nastavak primjera 1.)
1. Pritisnite , a zatim odaberite [Define g(x)].

• Prikazat će se zaslon za registraciju jednadžbe g(x).

2. Unesite f(x) × 2 - x.

* 2

* Ako pritisnete  dok je prikazan zaslon za registraciju jednadžbe
g(x), jedina stavka izbornika koja će se pojaviti jest [f(x)]. Isto tako,
ako pritisnete  dok je prikazan zaslon za registraciju jednadžbe f(x),
jedina stavka izbornika koja će se pojaviti jest [g(x)].

3. Pritisnite .
• Registrirat će se jednadžba koju unesete i vratit ćete se na zaslon koji

je bio prikazan prije nego što ste započeli ovaj postupak korakom 1.
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Napomena

• Postupak dodjele vrijednosti varijabli x u funkciji g(x) i izračuna rezultata jednak
je postupku u odjeljku „Provedba izračuna dodjelom vrijednosti registriranoj
definicijskoj jednadžbi” (stranica 63). Međutim, imajte na umu da biste umjesto
[f(x)] u koraku 1. trebali odabrati [g(x)].

• Pri provedbi primjera 3. trebate unijeti f(x) u definicijsku jednadžbu g(x). Umjesto toga
možete unijeti g(x) u definicijsku jednadžbu f(x). Međutim, nemojte istodobno unositi
g(x) u f(x) i f(x) u g(x). Ako to učinite, doći će do kružne greške (Circular ERROR) kada
obavite izračun s pomoću f(x) ili g(x).

Zadržavanje podataka
Ako obavite bilo koju sljedeću radnju, izbrisat će se definicijske jednadžbe
registrirane za f(x) ili g(x).

• ako pritisnete
• ako u izborniku SETTINGS postavku Input/Output prebacite s MathI*1 

na LineI*2 ili obratno.
*1 MathI/MathO ili MathI/DecimalO
*2 LineI/LineO ili LineI/DecimalO

• ako odete na  – [Reset] > [Settings & Data] ili  – [Reset] >
[Initialize All].
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Uporaba funkcija značajke QR
Code

Uporaba funkcija značajke QR Code
Na kalkulatoru se mogu prikazati simboli značajke QR Code koje može
očitati pametni uređaj.

Važno!

• Za postupke u ovom odjeljku pretpostavlja se da korišteni pametni uređaj sadržava
čitač za QR Code s pomoću kojeg možete očitavati višestruke simbole značajke QR
Code i koji se može povezati s internetom.

• Skeniranjem koda značajke QR Code prikazanog na kalkulatoru s pomoću pametnog
uređaja pametni će uređaj pristupiti mrežnom mjestu tvrtke CASIO.

Napomena

• QR Code pojavljuje se na zaslonu svaki put kada pritisnete (QR) dok je
prikazan bilo koji od sljedećih zaslona:
– zaslon HOME
– zaslon izbornika SETTINGS
– zasloni grešaka
– zasloni rezultata izračuna u svim aplikacijama kalkulatora
– zasloni značajke Table u svim aplikacijama kalkulatora
– zaslon aplikacije Spreadsheet.
Za pojedinosti posjetite mrežno mjesto tvrtke CASIO (https://wes.casio.com).

Prikaz koda značajke QR Code
Primjer: prikaz koda značajke QR Code za rezultat izračuna u aplikaciji
kalkulatora Calculate i očitavanje koda pametnim uređajem
1. U aplikaciji Calculate obavite neki izračun.
2. Pritisnite (QR) za prikaz koda značajke QR Code.

• Brojevi u donjem desnom kutu zaslona predstavljaju trenutačni broj
koda značajke QR Code i ukupni broj simbola u kodu značajke QR
Code. Za prikaz sljedećeg koda značajke QR Code pritisnite  ili .

Napomena

• Za povratak na prethodni QR Code pritisnite  ili  onoliko puta koliko je
potrebno da bi se pojavio kȏd.
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3. S pomoću pametnog uređaja skenirajte QR Code na zaslonu
kalkulatora.
• Više informacija o načinu skeniranja koda značajke QR Code

potražite u korisničkoj dokumentaciji čitača za QR Code koji
upotrebljavate.

Ako imate problema sa skeniranjem koda značajke
QR Code

Dok je QR Code prikazan prilagodite kontrast zaslona za QR Code s
pomoću tipki  i . Navedena prilagodba kontrasta utječe samo na
zaslone za QR Code.

Važno!

• Ovisno o pametnom uređaju i/ili aplikaciji za čitanje koda značajke QR Code koje
upotrebljavate može doći do problema sa skeniranjem simbola značajke QR Code
generiranih na kalkulatoru.

• Ako je za postavku značajke „QR Code” u izborniku SETTINGS odabrana opcija
„Version 3”, ograničen je broj aplikacija kalkulatora koje mogu prikazati simbole
značajke QR Code. Ako pokušate prikazati QR Code u aplikaciji koja ne podržava
prikaz koda značajke QR Code, pojavit će se poruka „Not Supported (Version 3)”.
Međutim, QR Code generiran tom postavkom lakše je skenirati s pomoću pametnog
uređaja.

• Za više informacija posjetite mrežno mjesto tvrtke CASIO (https://wes.casio.com).
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Uporaba aplikacija kalkulatora

Statistički izračuni
Aplikacija Statistics služi za izračun različitih statističkih vrijednosti na
temelju podataka jedne varijable (x) ili uparenih varijabli (x, y).

Opći postupak za provođenje statističkog izračuna
1. Pritisnite , odaberite ikonu aplikacije Statistics, a zatim pritisnite .
2. U izborniku koji će se pojaviti odaberite [1-Variable] (jedna varijabla) ili

[2-Variable] (uparena varijabla), a zatim pritisnite .
• Prikazat će se statistički uređivač.

Jedna varijabla

Uparena varijabla

3. Po potrebi omogućite prikaz stupca Freq (frekvencija).
• Za pojedinosti pogledajte odjeljak „Stupac Freq (frekvencija)”

(stranica 68).
4. Unesite podatke.

• Za pojedinosti pogledajte odjeljak „Unos podataka s pomoću
statističkog uređivača” (stranica 68).

5. Nakon što završite s unosom podataka, pritisnite .
• Pojavit će se izbornik prikazan u nastavku.

Jedna varijabla
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Uparena varijabla

6. Odaberite stavku izbornika koja odgovara postupku koji želite provesti.
• Odaberite [1-Var Results], [2-Var Results] ili [Reg Results] za

prikaz popisa rezultata izračuna na temelju unesenih podataka.
Za pojedinosti pogledajte odjeljak „Prikaz rezultata statističkih
izračuna” (stranica 71).

• Za prikaz zaslona sa statističkim izračunom za provedbu izračuna na
temelju unesenih podataka odaberite [Statistics Calc]. Za pojedinosti
pogledajte odjeljak „Uporaba zaslona za statistički izračun”
(stranica 75).

Napomena

• Kako biste se vratili u statistički uređivač sa zaslona za statistički izračun, pritisnite
, a zatim pritisnite .

Unos podataka s pomoću statističkog uređivača
U statističkom uređivaču mogu se prikazati jedan, dva ili tri stupca: jedna
varijabla (x), jedna varijabla i frekvencija (x, Freq), uparenu varijablu (x,
y), uparena varijabla s frekvencijom (x, y, Freq). Broj redaka s podacima
koji se mogu unijeti ovisi o broju stupaca: 160 redaka za jedan stupac,
80 redaka za dva stupca, 53 retka za tri stupca.

Važno!

• Svi podaci trenutačno uneseni u statističkom uređivaču brišu se ako provedete bilo
koji od sljedećih postupaka:
– ako promijenite vrstu statističkog izračuna s jedne varijable na uparenu varijablu i

obrnuto
– ako promijenite postavku Frequency u izborniku TOOLS.

• Statistički izračuni mogu trajati prilično dugo ako postoji velika količina podataka.

Stupac Freq (frekvencija)

Ako u izborniku TOOLS uključite postavku Frequency, statistički uređivač
sadržavat će i stupac pod nazivom „Freq”. S pomoću stupca Freq
možete odrediti frekvenciju (koliko se puta isti uzorak pojavljuje u skupini
podataka) vrijednosti svakog uzorka.
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Jedna varijabla

Uparena varijabla

Za prikaz stupca Freq
1. Dok je prikazan statistički uređivač, pritisnite , a zatim odaberite

[Frequency] > [On].
2. Pritisnite  za povratak u statistički uređivač.

Za sakrivanje stupca Freq
1. Dok je prikazan statistički uređivač, pritisnite , a zatim odaberite

[Frequency] > [Off].
2. Pritisnite  za povratak u statistički uređivač.

Pravila za unos podataka uzorka u statistički uređivač

Podaci koje unesete umeću se u ćeliju u kojoj se nalazi pokazivač. S
pomoću tipki pokazivača pomičite pokazivač s jedne ćelije na drugu.

   Pokazivač

Nakon unosa vrijednosti pritisnite . Vrijednost će se registrirati i u ćeliji
će se prikazati najviše šest znamenki vrijednosti.

Primjer 1.: odabir uparene varijable i unos sljedećih podataka: (170, 66),
(179, 75), (173, 68)
1. Pritisnite , odaberite ikonu aplikacije Statistics, a zatim pritisnite .
2. Odaberite [2-Variable], a zatim pritisnite .
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3. Unesite podatke na način naveden u nastavku.

170 179 173
66 75 68

Napomena

• U statističkom uređivaču možete pohraniti vrijednost u ćeliji u varijablu. Primjerice, ako
provedete sljedeći postupak dok je prikazan zaslon iz koraka 3., pohranit ćete 68 u
varijablu A:  – [A=] > [Store]. Za pojedinosti o varijablama pogledajte odjeljak
„Varijable (A, B, C, D, E, F, x, y, z)” (stranica 37).

Uređivanje podataka uzorka

Zamjena podataka u ćeliji
U statističkom uređivaču pomaknite pokazivač na ćeliju koja sadržava
podatke koje želite urediti, unesite nove podatke, a zatim pritisnite .

Brisanje retka
U statističkom uređivaču pomaknite pokazivač na redak koji želite izbrisati
i potom pritisnite .

Umetanje retka
1. U statističkom uređivaču pomaknite pokazivač u redak koji će se nalaziti

ispod retka koji umećete.
2. Idite na:  – [Edit] > [Insert Row].

Brisanje cjelokupnog sadržaja u statističkom uređivaču
U statističkom uređivaču idite na:  – [Edit] > [Delete All].

Razvrstavanje podataka

U statističkom uređivaču možete razvrstati vrijednosti u stupcima x, y ili
Freq prema uzlaznom ili silaznom redoslijedu.

Važno!

• Imajte na umu da, nakon što promijenite redoslijed podataka, nećete ih moći vratiti na
prethodni redoslijed.
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Primjer 2.: razvrstavanje podataka u stupcu x unesenih u primjeru 1.
(stranica 69) prema uzlaznom redoslijedu i naknadno razvrstavanje
podataka u stupcu y prema silaznom redoslijedu
1. Unesite podatke na način naveden u primjeru 1.

2. Poredajte podatke u stupcu x prema uzlaznom redoslijedu.

 – [Sort] > [x Ascending]

3. Poredajte podatke u stupcu y prema silaznom redoslijedu.

 – [Sort] > [y Descending]

Prikaz rezultata statističkih izračuna

Prikaz rezultata statističkih izračuna na temelju jedne varijable

Na zaslonu 1-Var Results prikazan je popis različitih statističkih vrijednosti
(kao što su aritmetička sredina i standardna devijacija populacije)
izračunatih na temelju podataka jedne varijable. U ovom odjeljku opisan
je postupak koji trebate provesti za prikaz zaslona 1-Var Results.

Primjer 3.: unos podataka navedenih u nastavku i prikaz rezultata
statističkih izračuna na temelju jedne varijable

x 1 2 3 4 5 6 7 8 9 10
Freq 1 2 1 2 2 2 3 4 2 1

1. Pritisnite , odaberite ikonu aplikacije Statistics, a zatim pritisnite .
2. Odaberite [1-Variable], a zatim pritisnite .

• Prikazat će se statistički uređivač.
3. Pritisnite , a zatim odaberite [Frequency] > [On].

• Pritisnite  za povratak u statistički uređivač.
4. Unesite podatke u stupac x.

1 2 3 4 5 6 7 8 9 10

5. Unesite podatke u stupac Freq.
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2 2 2 2 3 4 2

6. Pritisnite .

7. Odaberite [1-Var Results], a zatim pritisnite .
• Prikazat će se zaslon 1-Var Results.

 (ili )

 (ili )

• Za značenja varijabli prikazanih na zaslonu 1-Var Results pogledajte
odjeljak „Popis varijabli statističkih vrijednosti i funkcija za
statistički izračun” (stranica 78).

8. Pritisnite  ili  za povratak u statistički uređivač.

Prikaz rezultata statističkih izračuna na temelju uparene
varijable

Na zaslonu 2-Var Results prikazan je popis različitih statističkih vrijednosti
(kao što su aritmetička sredina i standardna devijacija populacije)
izračunatih na temelju podataka uparene varijable. U ovom odjeljku opisan
je postupak koji trebate provesti za prikaz zaslona 2-Var Results.

Primjer 4.: unos podataka navedenih u nastavku i prikaz rezultata
statističkih izračuna na temelju uparene varijable

x 1,0 1,2 1,5 1,6 1,9 2,1 2,4 2,5 2,7 3,0
y 1,0 1,1 1,2 1,3 1,4 1,5 1,6 1,7 1,8 2,0

1. Pritisnite , odaberite ikonu aplikacije Statistics, a zatim pritisnite .
2. Odaberite [2-Variable], a zatim pritisnite .

• Prikazat će se statistički uređivač.
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3. Unesite podatke u stupac x.

1 1 2 1 5 1 6 1 9
2 1 2 4 2 5 2 7 3

4. Unesite podatke u stupac y.

1 1 1 1 2 1 3 1 4
1 5 1 6 1 7 1 8 2

5. Pritisnite .

6. Odaberite [2-Var Results], a zatim pritisnite .
• Prikazat će se zaslon 2-Var Results.

 (ili )

 (ili )

 (ili )

• Za značenja varijabli prikazanih na zaslonu 2-Var Results pogledajte
odjeljak „Popis varijabli statističkih vrijednosti i funkcija za
statistički izračun” (stranica 78).

7. Pritisnite  ili  za povratak u statistički uređivač.

Prikaz rezultata regresijskog izračuna

Na zaslonu Reg Results prikazan je popis rezultata regresijskog izračuna
(koeficijenata regresijskih jednadžbi) na temelju podataka uparene
varijable. U ovom odjeljku opisan je postupak koji trebate provesti za
prikaz zaslona Reg Results.
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Primjer 5.: uporaba podataka na temelju uparene varijable unesenih u
primjeru 4. (stranica 72) i prikaz rezultata sljedećih dvaju regresijskih
izračuna:
• koeficijenata (a, b) regresijske jednadžbe „y = a + bx” i koeficijenta

korelacije (r) dobivenih primjenom linearne regresije na podatke
• koeficijenata (a, b, c) regresijske jednadžbe „y = a + bx + cx2” dobivenih

primjenom kvadratne regresije na podatke

Napomena

• Za informacije o vrstama regresijskog izračuna podržanima u aplikaciji Statistics
pogledajte odjeljak „Popis podržanih vrsta regresije” (stranica 75).

1. Obavite sve korake od 1. do 5. u okviru postupka opisanog u
primjeru 4 (stranica 72).

2. Odaberite [Reg Results], a zatim pritisnite .
• Prikazat će se izbornik s vrstama regresije.

3. Odaberite [y=a+bx], a zatim pritisnite .
• Prikazat će se zaslon Reg Results za linearnu regresiju.

4. Pritisnite  ili  za povratak u statistički uređivač.
5. Pritisnite , a zatim odaberite [Reg Results] > [y=a+bx+cx2].

• Prikazat će zaslon Reg Results za kvadratnu regresiju.

6. Pritisnite  ili  za povratak u statistički uređivač.
• Za značenja varijabli prikazanih na zaslonu Reg Results pogledajte

odjeljak „Popis varijabli statističkih vrijednosti i funkcija za
statistički izračun” (stranica 78).
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Popis podržanih vrsta regresije

Vrsta regresije
Regresijska jednadžba

(stavka izbornika s vrstom
regresije)

Linearna regresija y = a + bx

Kvadratni regresijski model y = a + bx + cx2

Logaritamski regresijski model y = a + b･ln(x)

Eksponencijalni regresijski model
(e)

y = a･e^(bx)

Eksponencijalni regresijski model
(ab)

y = a･b^x

Eksponencijalni regresijski model
potencije

y = a･x^b

Regresijski model racionalne
funkcije

y = a + b/x

Uporaba zaslona za statistički izračun
S pomoću zaslona za statistički izračun možete prizvati pojedinačne
statističke vrijednosti i upotrijebiti ih u izračunima.

Zaslon bez unesenog izraza izračuna

Primjer izračuna

Za prizivanje statističke vrijednosti upotrijebite varijablu koja predstavlja
statističku vrijednost koju želite prizvati (npr. aritmetička sredina varijable
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x: x, standardna devijacija populacije varijable x: σx, maksimalna vrijednost
varijable x: max(x) itd.). Za više informacija o tim varijablama pogledajte
odjeljak „Popis varijabli statističkih vrijednosti i funkcija za statistički
izračun” (stranica 78).

Prikaz zaslona sa statističkim izračunom

Jedna varijabla
1. Dok je prikazan statistički uređivač, pritisnite .
2. U izborniku koji će se pojaviti odaberite [Statistics Calc] i potom pritisnite

.

Uparena varijabla
1. Dok je prikazan statistički uređivač, pritisnite .
2. U izborniku koji će se pojaviti odaberite [Statistics Calc] i potom pritisnite

.
• Prikazat će se izbornik s vrstama regresije (pogledajte odjeljak

„Popis podržanih vrsta regresije” (stranica 75)).

3. U izborniku odaberite željenu vrstu regresije, a zatim pritisnite .

• U izborniku iz prethodno navedenog primjera odaberite [y=a+bx]
(linearna regresija).

Vraćanje u statistički uređivač sa zaslona za statistički izračun
Pritisnite , a zatim .

Primjer izračuna na zaslonu za statistički izračun

Primjer 6.: utvrđivanje sume podataka uzorka (Σx) i aritmetičke sredine (x)
unesenih podataka jedne varijable iz primjera 3. (stranica 71)
1. Obavite sve korake od 1. do 6. u okviru postupka opisanog u

primjeru 3 (stranica 71).
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2. Odaberite [Statistics Calc], a zatim pritisnite .

3. Izračunajte sumu podataka uzorka (Σx).

 – [Statistics] > [Summation] > [Σx]

4. Izračunajte aritmetičku sredinu (x).

 – [Statistics] >
[Mean/Var/Dev...] > [x]

Napomena

• Za prikaz zaslona 1-Var Results s prethodno prikazanog zaslona za statistički izračun
pritisnite , a zatim odaberite [1-Var Results]. Za povratak na zaslon za statistički
izračun sa zaslona 1-Var Results pritisnite  ili .

Primjer 7.: utvrđivanje koeficijenata (a, b) i koeficijenta korelacije (r)
linearne regresijske jednadžbe „y = a + bx” na temelju unesenih podataka
uparene varijable iz primjera 4. (stranica 72)
1. Obavite sve korake od 1. do 5. u okviru postupka opisanog u

primjeru 4 (stranica 72).
2. Odaberite [Statistics Calc], a zatim pritisnite .

• Prikazat će se izbornik s vrstama regresije.

3. Odaberite [y=a+bx], a zatim pritisnite .

4. Utvrdite koeficijente (a, b) i koeficijent korelacije (r) regresijske
jednadžbe „y = a + bx”.
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 – [Statistics] > [Regression] > [a]

 – [Statistics] > [Regression] > [b]

 – [Statistics] > [Regression] > [r]

• Za odabir neke druge vrste regresije pritisnite  i odaberite [Select
Reg Type]. Prikazat će se izbornik s vrstama regresije iz koraka 2.

Prikaz zaslona 2-Var Results sa zaslona za statistički izračun
Pritisnite , a zatim odaberite [2-Var Results].

Prikaz zaslona Reg Results sa zaslona za statistički izračun
Pritisnite , a zatim odaberite [Reg Results].

Popis varijabli statističkih vrijednosti i funkcija za statistički
izračun

S pomoću izbornika CATALOG možete prizvati varijable koje predstavljaju
statističke vrijednosti i funkcije koje služe za provedbu statističkih izračuna.

Napomena

• Za statističke izračune s jednom varijablom dostupne su varijable označene
zvjezdicom (*).

• Za popis formula za izračun koje se upotrebljavaju za varijable i naredbe pogledajte
odjeljak „Formula statističkih izračuna” (stranica 81).

 – [Statistics] > [Summation]
Σx*, Σy ...... suma podataka uzorka
Σx2*, Σy2 ...... suma kvadratnih vrijednosti podataka uzorka
Σxy ...... suma umnožaka podataka varijable x i podataka varijable y
Σx3 ...... suma kubnih vrijednosti podataka varijable x
Σx2y ...... suma (kvadratne vrijednosti podataka varijable x × podataka
varijable y)
Σx4 ...... suma podataka varijable x na četvrtu potenciju

 – [Statistics] > [Mean/Var/Dev...]
x*, y ...... aritmetička sredina
σ2

x*, σ2
y ...... varijanca populacije
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σx*, σy ...... standardna devijacija populacije
s2

x*, s2
y ...... varijanca uzorka

sx*, sy ...... standardna devijacija uzorka
n* ...... broj stavki

 – [Statistics] > [Min/Max/Quartile] (samo za podatke jedne varijable)
min(x)* ...... minimalna vrijednost
Q1* ...... prvi kvartil
Med* ...... medijan
Q3* ...... treći kvartil
max(x)* ...... maksimalna vrijednost

 – [Statistics] > [Norm Dist] (samo za podatke jedne varijable)
P(*, Q(*, R(*, t* ...... Funkcije za obavljanje izračuna normalne
distribucije. Za više informacija o tim funkcijama pogledajte odjeljak
„Obavljanje izračuna normalne distribucije (samo za podatke jedne
varijable)” (stranica 80).

 – [Statistics] > [Min/Max] (samo za podatke uparene varijable)
min(x), min(y) ...... minimalna vrijednost
max(x), max(y) ...... maksimalna vrijednost

 – [Statistics] > [Regression] (samo za podatke uparene varijable)

Za kvadratnu regresiju
a, b, c ...... regresijski koeficijenti za kvadratnu regresiju
x̂1, x̂2 ...... Funkcije za utvrđivanje procijenjene vrijednosti varijabli x1 i x2

za unesenu vrijednost y. Za argument unesite vrijednost y neposredno
prije funkcije x̂1 ili x̂2.
ŷ ...... Funkcija za utvrđivanje procijenjene vrijednosti varijable y za
unesenu vrijednost x. Za argument unesite vrijednost x neposredno prije
navedene funkcije.

Za nekvadratnu regresiju
a, b ...... regresijski koeficijenti
r ...... koeficijent korelacije
x̂ ...... Funkcija za utvrđivanje procijenjene vrijednosti varijable x za
unesenu vrijednost y. Za argument unesite vrijednost y neposredno prije
navedene funkcije.
ŷ ...... Funkcija za utvrđivanje procijenjene vrijednosti varijable y za
unesenu vrijednost x. Za argument unesite vrijednost x neposredno prije
navedene funkcije.
Za primjer postupka za određivanje procijenjenih vrijednosti pogledajte
odjeljak „Izračunavanje procijenjenih vrijednosti (samo za podatke
uparene varijable)” (stranica 81).
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Obavljanje izračuna normalne distribucije (samo za podatke
jedne varijable)

Kada je odabran statistički izračun s jednom varijablom, možete obavljati
izračun normalne distribucije pomoću funkcija prikazanih u nastavku u
izborniku koji se pojavi kada pritisnete  i potom odaberete [Statistics] >
[Norm Dist].

P(, Q(, R( ... Te funkcije s argumentom t služe za određivanje vjerojatnosti
normalne distribucije na način prikazan u nastavku.

t ...... Ovoj funkciji prethodi argument x. Služi za izračun standardizirane
varijable za vrijednost podataka varijable x s pomoću aritmetičke sredine
(x) i standardne devijacije populacije (σx) podataka unesenih s pomoću
statističkog uređivača.

Primjer 8.: određivanje standardizirane vrijednosti kada je x = 2 i P(t) u toj
točki za unesene podatke jedne varijable iz primjera 3. (stranica 71)
1. Obavite sve korake od 1. do 6. u okviru postupka opisanog u

primjeru 3 (stranica 71).
2. Odaberite [Statistics Calc], a zatim pritisnite .

3. Izračunajte standardiziranu vrijednost ako je x = 2.

2
 – [Statistics] > [Norm Dist] > [ t]

4. Izračunajte P(t).

 – [Statistics] > [Norm Dist] > [P(]
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Izračunavanje procijenjenih vrijednosti (samo za podatke
uparene varijable)

Procijenjena vrijednost varijable y može se izračunati za zadanu vrijednost
x na temelju regresijske jednadžbe dobivene statističkim izračunom
uparene varijable. Također je moguće izračunati odgovarajuću vrijednost
x (dvije vrijednosti, x1 i x2, u slučaju kvadratne regresije) za vrijednost y u
regresijskoj jednadžbi.

Primjer 9.: određivanje procijenjene vrijednosti varijable y ako je x = 5,5 u
regresijskoj jednadžbi dobivenoj linearnom regresijom podataka unesenih
u primjeru 4. (stranica 72)
1. Obavite sve korake od 1. do 5. u okviru postupka opisanog u

primjeru 4 (stranica 72).
2. Odaberite [Statistics Calc], a zatim pritisnite .

• Prikazat će se izbornik s vrstama regresije.

3. Odaberite [y=a+bx], a zatim pritisnite .

4. Unesite vrijednost x (5,5), a zatim unesite „ŷ”, što predstavlja funkciju za
određivanje procijenjene vrijednosti varijable y.

5 5
 – [Statistics] > [Regression] > [ŷ]

5. Pritisnite .

Formula statističkih izračuna

Formula statističkih izračuna na temelju jedne varijable
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Formula statističkih izračuna na temelju uparene varijable

Formula regresijskog izračuna

Linearna regresija (y = a + bx)

Kvadratni regresijski model (y = a + bx + cx2)
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Logaritamski regresijski model (y = a + b･ln(x))

Eksponencijalni regresijski model (e) (y = a･e^(bx))

Eksponencijalni regresijski model (ab) (y = a･b^x)

Eksponencijalni regresijski model potencije (y = a･x^b)
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Regresijski model racionalne funkcije (y = a + b/x)

Distribucijski izračuni
U aplikaciji Distribution možete dobiti vrijednost vjerojatnosti odabirom
vrste distribucijskog izračuna i unosom različitih parametara.* Vrste
distribucijskih izračuna koje možete provesti prikazani su u tablici u
nastavku.

Vrsta distribucijskog izračuna Stavka izbornika

Binomna distribucija Binomial PD

Binomna kumulativna distribucija Binomial CD

Normalna distribucija Normal PD

Normalna kumulativna distribucija Normal CD
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Inverzna normalna kumulativna distribucija* Inverse Normal

Poissonova distribucija Poisson PD

Poissonova kumulativna distribucija Poisson CD

* „Inverse Normal” služi za provedbu inverznog izračuna radi utvrđivanja
vrijednosti podataka (xInv) iz vrijednosti vjerojatnosti (Area).

Opći postupak za provođenje distribucijskog
izračuna

Primjer: izračun binomne kumulativne distribucije za podatke varijable x
{2, 3, 4, 5} ako su N (broj pokušaja) = 5 i p (vjerojatnost uspješnosti) = 0,5

1. Pritisnite , odaberite ikonu aplikacije Distribution, a zatim pritisnite
.

• Prikazat će se izbornik s vrstama distribucijskih izračuna.

2. U izborniku odaberite vrstu distribucijskog izračuna.
• U ovom slučaju želimo izračunati binomnu kumulativnu distribuciju.

Odaberite [Binomial CD], a zatim pritisnite .
3. U izborniku koji se pojavi odaberite način unosa podataka (x).

[List] ... Odaberite istodoban unos više stavki podataka varijable x. Ako
odaberete tu stavku izbornika, nestat će zaslon s popisom.

[Variable] ... Odaberite unos jedne stavke podataka varijable x. Ako
odaberete tu stavku izbornika, pojavit će se zaslon za unos
parametara.

• U ovom slučaju želimo istodobno unijeti više stavki podataka varijable
x, stoga odaberite [List], a zatim pritisnite .

4. Na zaslonu s popisom unesite podatke varijable x {2, 3, 4, 5}.

2 3 4 5

5. Pritisnite .
• Prikazat će se zaslon za unos parametara za Binomial CD.
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6. Unesite vrijednosti za parametre (N = 5, p = 0,5).

5 0 5

• Parametri koji zahtijevaju unos podataka ovise o vrsti izračuna koji ste
odabrali u koraku 2. ovog postupka. Za pojedinosti pogledajte odjeljak
„Popis parametara” (stranica 86).

7. Nakon unosa vrijednosti svih varijabli odaberite [Execute] i potom
pritisnite .
• Prikazat će se zaslon s rezultatom izračuna.

• Ako ste u koraku 3. odabrali [List], na zaslonu s popisom prikazat
će se rezultati izračuna (stupac P). Za pojedinosti pogledajte odjeljak
„Zaslon s popisom” (stranica 87).

• Ako provedete bilo kakav postupak uređivanja (pogledajte odjeljak
„Uređivanje sadržaja zaslona s popisom” (stranica 88)) na
zaslonu s popisom dok su prikazani rezultati izračuna, izbrisat će
se svi rezultati izračuna. Popis će se vratiti na stanje iz koraka 4.
(dovršen unos podataka na zaslonu s popisom) u okviru ovog
postupka.

• Ako je unesena vrijednost izvan dozvoljenog raspona, pojavit će se
poruka greške. U stupcu P na zaslonu s rezultatom izračuna pojavit
će se „ERROR” ako je vrijednost unesena za odgovarajući podatak
izvan dozvoljenog raspona.

• Ako pritisnete  dok je prikazan zaslon s rezultatom izračuna, vratit
ćete se na zaslon za unos parametara.

Napomena

• Ako odaberete Normal PD, Normal CD ili Inverse Normal u prethodno navedenom
koraku 2., način unosa podataka (x) uvijek će biti „Variable” (unos jedne stavke
podataka varijable x). Zbog toga u tom slučaju nije prikazan izbornik iz koraka 3.

• Ako je način unosa podataka (x) „Variable”, rezultat izračuna pohranit će se u
memoriju Ans.

• Preciznost je rezultata distribucijskog izračuna do 6. decimale.

Popis parametara
Na popisu u nastavku navedena su značenja simbola koji se nalaze na
zaslonu za unos parametara.
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Binomial PD, Binomial CD
x … podaci
N … broj pokušaja
p … vjerojatnost uspješnosti (0 ≤ p ≤ 1)

Normal PD
x … podaci
μ … aritmetička sredina populacije
σ … standardna devijacija populacije (σ > 0)

Normal CD
Lower … donja granica
Upper … gornja granica
μ … aritmetička sredina populacije
σ … standardna devijacija populacije (σ > 0)

Inverse Normal
Area … vrijednost vjerojatnosti (0 ≤ Area ≤ 1)
μ … aritmetička sredina populacije
σ … standardna devijacija populacije (σ > 0)
(Krajnja je postavka uvijek lijevo.)

Poisson PD, Poisson CD
x … podaci
λ … aritmetička sredina

Napomena

• Zadržava se posljednja unesena vrijednost za svaki naziv parametra, neovisno o tome
na kojem je zaslonu za unos unesena. Primjerice, unosom vrijednosti parametra N na
zaslonu za unos parametara za Binomial PD vrijednost parametra N promijenit će se i
na zaslonu za unos parametara za Binomial CD.

• Vrijednosti koje unesete za svaki parametar zadržavaju se sve dok ne provedete neki
od sljedećih postupaka:  – [Reset] > [Settings & Data] ili  – [Reset] > [Initialize
All].

Zaslon s popisom
Na zaslonu s popisom možete unijeti najviše 45 stavki podataka varijable
x. Rezultati izračuna prikazuju se i na zaslonu s popisom.
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(1) Vrsta distribucijskog izračuna
(2) Vrijednost na trenutačnom mjestu pokazivača
(3) Podaci (x)
(4) Rezultati izračuna (P)

Napomena

• Na zaslonu s popisom možete pohraniti vrijednost u ćeliji u varijablu. Primjerice, ako
provedete sljedeći postupak dok je prikazan prethodno prikazani zaslon, pohranit ćete
1 u varijablu A:  – [A=] > [Store]. Za pojedinosti o varijablama pogledajte odjeljak
„Varijable (A, B, C, D, E, F, x, y, z)” (stranica 37).

• Ako provedete bilo koji od sljedećih postupaka, izbrisat će se svi uneseni podaci
varijable x sa zaslona s popisom:
– ako se vratite na zaslon HOME i pokrenete neku drugu aplikaciju kalkulatora
– ako odaberete [Delete All] (pogledajte odjeljak „Brisanje cjelokupnog sadržaja

zaslona s popisom” (stranica 89))
– ako odete na  – [Reset] > [Settings & Data] ili  – [Reset] > [Initialize All]

Uređivanje sadržaja zaslona s popisom

Izmjena podataka varijable x u ćeliji

Na zaslonu s popisom pomaknite pokazivač na ćeliju koja sadržava
podatke koje želite izmijeniti, unesite nove podatke, a zatim pritisnite .

Brisanje retka

Na zaslonu s popisom pomaknite pokazivač na redak koji želite izbrisati i
potom pritisnite .

Umetanje retka

1. Na zaslonu s popisom pomaknite pokazivač u redak koji će se nalaziti
ispod retka koji umećete.

2. Idite na:  – [Edit] > [Insert Row].
• Time ćete unijeti redak s unesenom zadanom vrijednošću 0.
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3. Unesite podatke.

Brisanje cjelokupnog sadržaja zaslona s popisom

Na zaslonu s popisom idite na:  – [Edit] > [Delete All].

Primjer izračuna
Računanje normalne distribucije ako je x = 36, μ = 35, σ = 2
1. Pritisnite , odaberite ikonu aplikacije Distribution, a zatim pritisnite

.
2. U izborniku s vrstama distribucijskog izračuna koji će se pojaviti

odaberite [Normal PD] i potom pritisnite .
• Prikazat će se zaslon za unos parametara za Normal PD.

3. Unesite vrijednosti za parametre (x = 36, μ = 35, σ = 2).

36 35 2

4. Pritisnite .

• Ako ponovno pritisnete  ili pritisnete  ili , vratit ćete se na
zaslon za unos parametara iz koraka 3. ovog postupka.

• Možete pohraniti trenutačno prikazani rezultat izračuna u varijablu.
Primjerice, ako provedete sljedeći postupak dok je prikazan zaslon iz
koraka 4., rezultat izračuna pohranit će se u varijablu A:  – [A=] >
[Store]. Za pojedinosti o varijablama pogledajte odjeljak „Varijable (A,
B, C, D, E, F, x, y, z)” (stranica 37).

Uporaba proračunske tablice
Aplikacija Spreadsheet omogućava vam obavljanje izračuna s pomoću
proračunske tablice veličine 45 redova x 5 stupaca (s ćelijama od A1 do
E45).
Za provedbu postupaka u ovom odjeljku prvo trebate pokrenuti aplikaciju
Spreadsheet. Pritisnite , odaberite ikonu aplikacije Spreadsheet, a
zatim pritisnite . Prikazat će se zaslon s proračunskom tablicom.
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(1) Brojevi redova (od 1 do 45)
(2) Slova stupaca (od A do E)
(3) Pokazivač: označava trenutačno odabranu ćeliju. Broj retka i slovo

stupca trenutačno odabrane ćelije prikazani su u crnoj boji, dok su
brojevi redaka i slova stupaca ostalih ćelija prikazani u tamnosivoj
boji.

(4) Okvir za uređivanje: služi za prikaz sadržaja ćelije na kojoj se
trenutačno nalazi pokazivač.

Važno!

• Svaki put kad isključite kalkulator ili pritisnete tipku , brišu se svi unosi u
proračunskoj tablici.

Unos i uređivanje sadržaja ćelija
U svaku ćeliju možete unijeti konstantu ili formulu.
Konstante: vrijednost konstante ostaje nepromijenjena nakon što dovršite
unos. Konstanta može biti numerička vrijednost ili izraz izračuna (kao što
je 7+3, sin30, A1×2 itd.) te se ispred nje ne nalazi znak jednakosti (=).
Formule: formula započinje znakom jednakosti (=), kao što je =A1×2, te
se izvršava u trenutku pisanja.

Napomena

• U ćeliju koju uređujete možete unijeti najviše 49 bajtova (broj bajtova prije unosa
potvrđujete tako da pritisnete ). Bajtovi se broje na sljedeći način:
– brojevi, varijable, simboli: 1 bajt po znaku
– naredbe, funkcije: 1 bajt za svaku naredbu ili funkciju.

Svaka cjelokupna naredba ili funkcija broji se kao jedan bajt. Primjerice, sljedeći
unosi broje se kao jedan bajt: „√ (”, „Sum(”.

• Broj bajtova potrošenih nakon potvrde unosa računa se na sljedeći način, ovisno o
sadržaju unesenom u svaku ćeliju.
– konstante: 14 bajtova, neovisno o unesenom broju znamenki*
– formule: broj unesenih bajtova (najviše 49 bajtova) + 15 bajtova.
* Ako unesete konstantu s 11 ili više značajnih decimalnih mjesta, nakon potvrde

unosa vrijednost se pretvara u 10 značajnih decimalnih mjesta.
Primjer: ako unesete 12345678915 (11 znamenki), vrijednost se pretvara u
1,234567892 x 1010 (10 znamenki).
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Prikaz preostalog kapaciteta za unos

Pritisnite , odaberite [Available Memory], a zatim pritisnite .

Unošenje konstante i formule u ćeliju
Primjer 1.: u ćelije A1, A2 i A3 unesite konstante 7×5, odnosno 7×6,
odnosno A2+7. Zatim unesite sljedeću formulu u ćeliju B1: =A1+7.
1. Pomaknite pokazivač na ćeliju A1.
2. Učinite sljedeće:

7 5 7 6 (A) 7

3. Pomaknite pokazivač na ćeliju B1 te potom učinite sljedeće:

(=) (A) 7

Napomena

• Na zaslonu s proračunskom tablicom možete pohraniti vrijednost u ćeliji u varijablu.
Primjerice, ako provedete sljedeći postupak dok je prikazan zaslon iz koraka 3.,
vrijednost 42 (rezultat izračuna dobiven unosom formule u ćeliju B1) pohranit će se
u varijablu A:  – [A=] > [Store]. Za pojedinosti o varijablama pogledajte odjeljak
„Varijable (A, B, C, D, E, F, x, y, z)” (stranica 37).

• Možete odrediti treba li formula u okviru za uređivanje biti prikazana onakva kakva
jeste ili kao njena vrijednost rezultata izračuna. Pogledajte odjeljak „Stavke postavki
aplikacije Spreadsheet” (stranica 96).

Uređivanje postojećih podataka u ćeliji

1. Pomaknite pokazivač na ćeliju čiji sadržaj želite urediti, zatim pritisnite
.

• Umjesto da pritisnete  možete provesti sljedeći postupak:
 – [Edit Cell]

• Poravnanje sadržaja ćelije u okviru za uređivanje promijenit će se
s desnog na lijevo. U okviru za uređivanje pojavit će se tekstualni
pokazivač (|) kako biste mogli urediti sadržaj ćelije.

2. S pomoću tipki  i  pomičite tekstualni pokazivač kroz sadržaj ćelije
i uredite ga po potrebi.

3. Za dovršetak i primjenu izmjena pritisnite .
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Unošenje naziva referentnih ćelija s pomoću naredbe Grab

Naredbu Grab možete upotrebljavati umjesto ručnog unošenja naziva
reference (npr. A1) s pomoću postupka za odabir i unos ćelije za koju
želite da bude referenca.

Primjer 2.: nastavno na primjer 1. unesite sljedeću formulu u ćeliju B2:
=A2+7.
1. Pomaknite pokazivač na ćeliju B2.
2. Provedite sljedeći postupak:

(=)  – [Spreadsheet] > [Grab]

7

Relativne i apsolutne reference
Postoje dvije vrste referenci: relativne i apsolutne.

Relativna referentna ćelija

Referenca u ćeliji (A1) u formuli kao što je =A1+7 predstavlja relativnu
referencu, što znači da se mijenja ovisno o ćeliji u kojoj se formula nalazi.
Primjerice, ako se formula =A1+7 prvotno nalazi u ćeliji B1 te je potom
kopirate i zalijepite u ćeliju C3, u ćeliju C3 unijet će se formula =B3+7.
Budući da postupkom kopiranja i lijepljenja formula premješta za jedan
stupac (iz B u C) i dva retka (iz 1 u 3), relativna referentna ćelija A1
u formuli premješta se za jedan stupac i dva retka u B3. Ako rezultat
postupka kopiranja i lijepljenja dovede do promjene naziva relativne
referentne ćelije u naziv koji je izvan opsega ćelija proračunske tablice,
slovo relevantnog stupca i/ili broj retka bit će zamijenjeni upitnikom (?) i
umjesto podataka ćelije prikazat će se „ERROR”.

Apsolutna referentna ćelija

Ako želite da red ili stupac, ili i red i stupac naziva referentne ćelije da
ostanu nepromijenjeni bez obzira gdje ih zalijepite, potrebno je napraviti
naziv apsolutne referentne ćelije. Kako biste izradili apsolutnu referentnu
ćeliju, umetnite znak dolara ( ) ispred naziva stupca i/ili broja retka.
Možete upotrijebiti jednu od tri apsolutne referentne ćelije: apsolutni
stupac s relativnim retkom ( A1), relativni stupac s apsolutnim retkom
(A 1) ili apsolutni redak i stupac ( A 1).
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Unos simbola apsolutne referentne ćelije ( )

Pri unosa formule u ćeliju pritisnite , a zatim odaberite [Spreadsheet] >
[ ].

Rezanje i lijepljenje podataka u proračunsku tablicu

1. Pomaknite pokazivač na ćeliju čije podatke želite izrezati.
2. Pritisnite , odaberite [Cut & Paste], a zatim pritisnite .

• Ući ćete u stanje pripravnosti za lijepljenje. Kako biste poništili stanje
pripravnosti za lijepljenje, pritisnite  ili .

3. Pomaknite pokazivač na ćeliju u koju želite zalijepiti podatke koje ste
upravo izrezali, a zatim pritisnite .
• Lijepljenjem se istodobno brišu podaci iz ćelije u kojoj ste obavili

postupak rezanja te se automatski poništava stanje pripravnosti za
lijepljenje.

Napomena

• U slučaju radnji rezanja i lijepljenja, referentne ćelije se ne mijenjaju nakon lijepljenja,
bez obzira jesu li relativne ili apsolutne.

Kako kopirati i zalijepiti podatke u proračunsku tablicu

1. Pomaknite pokazivač na ćeliju čije podatke želite kopirati.
2. Pritisnite , odaberite [Copy & Paste], a zatim pritisnite .

• Ući ćete u stanje pripravnosti za lijepljenje. Kako biste poništili stanje
pripravnosti za lijepljenje, pritisnite  ili .

3. Pomaknite pokazivač na ćeliju u koju želite zalijepiti podatke koje ste
upravo kopirali, a zatim pritisnite .
• Stanje pripravnosti za lijepljenje ostaje omogućeno dok ne pritisnete

 ili , zbog čega po želji možete zalijepiti kopirane podatke u
druge ćelije.

Napomena

• Kada kopirate sadržaj ćelije koja sadržava formulu s relativnom referencom, relativna
referenca mijenja se u skladu s lokacijom ćelije u koju je sadržaj zalijepljen.

Brisanje unesenih podataka iz određene ćelije

Pomaknite pokazivač na ćeliju čiji sadržaj želite izbrisati i potom pritisnite
.
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Brisanje sadržaja iz svih ćelija u proračunskoj tablici

Pritisnite , odaberite [Delete All], a zatim pritisnite .

Uporaba posebnih naredbi u aplikaciji
Spreadsheet

Unutar formula ili konstanti u aplikaciji Spreadsheet možete upotrebljavati
naredbe navedene u nastavku. Te se naredbe nalaze u izborniku koji se
pojavi kada pritisnete  i potom odaberete [Spreadsheet].

Min(
Služi za vraćanje minimalne vrijednosti u zadanom rasponu ćelija.
Sintaksa: Min(početna ćelija:završna ćelija)

Max(
Služi za vraćanje maksimalne vrijednosti u zadanom rasponu ćelija.
Sintaksa: Max(početna ćelija:završna ćelija)

Mean(
Služi za vraćanje aritmetičke sredine vrijednosti u zadanom rasponu ćelija.
Sintaksa: Mean(početna ćelija:završna ćelija)

Sum(
Služi za vraćanje sume vrijednosti u zadanom rasponu ćelija.
Sintaksa: Sum(početna ćelija:završna ćelija)

Primjer 3.: unos formule =Sum(A1:A3), koja služi za izračun zbroja ćelija
A1, A2 i A3, u ćeliju A4 (nastavak primjera 1.)
1. Pomaknite pokazivač na ćeliju A4.
2. Unesite formulu =Sum(A1:A3).

(=)  – [Spreadsheet] > [Sum]
(A)

 – [Spreadsheet] > [:]
(A)

3. Pritisnite .
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Istodoban unos iste formule ili konstante u više
ćelija

S pomoću postupaka u ovom odjeljku možete unijeti istu formuli ili
konstantu u zadani niz ćelija. Za istodoban unos formule u više ćelija
upotrijebite funkciju Fill Formula, a za istodobni unos konstante u više
ćelija upotrijebite Fill Value.

Napomena

• Ako unesena formula ili konstanta sadržava relativnu referencu, relativna će referenca
biti unesena u skladu s gornjom lijevom ćelijom zadanog raspona. Ako unesena
formula ili konstanta sadržava apsolutnu referencu, apsolutna će referenca biti
unesena u sve ćelije zadanog raspona.

Istodoban unos iste formule u niz ćelija

Primjer 4.: unos formule kojom se udvostručuje vrijednost lijevo od
odredišne ćelije, a potom oduzima 3 u ćelije B1, B2 i B3 (nastavak
primjera 1.)
1. Pomaknite pokazivač na ćeliju B1.
2. Pritisnite , odaberite [Fill Formula], a zatim pritisnite .

• Prikazat će se zaslon Fill Formula.
3. U redak „Form” unesite formulu =2A1-3: 2 (A) 3 .

• Nije potrebno unositi znak jednakosti (=) na početak.
4. U retku „Range” odredite B1:B3 kao raspon višestrukog unosa.

5. Kako biste primijenili unesenu formulu, pritisnite .
• Time će se =2A1-3 unijeti u ćeliju B1, =2A2-3 u ćeliju B2 i =2A3-3 u

ćeliju B3.

Unos iste formule u više ćelija

Primjer 5.: istodoban unos vrijednosti koja je tri puta veća od ćelije ulijevo
u ćelije C1, C2 i C3 (nastavak primjera 4.).
1. Pomaknite pokazivač na ćeliju C1.
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2. Pritisnite , odaberite [Fill Value], a zatim pritisnite .
• Prikazat će se zaslon Fill Value.

3. U redak „Value” unesite konstantu B1×3: (B) 3 .
4. U retku „Range” odredite C1:C3 kao raspon višestrukog unosa.

5. Kako biste primijenili unesenu formulu, pritisnite .
• Time će se u ćelije C1, C2 i C3 unijeti vrijednosti rezultata svakog

izračuna.

Stavke postavki aplikacije Spreadsheet
Stavke postavki u nastavku nalaze se u izborniku TOOLS.
„◆” označava zadane postavke.

Auto Calc
Označava trebaju li se formule automatski preračunavati.
On◆: služi za omogućavanje preračunavanja.
Off: služi za onemogućavanje preračunavanja.

Show Cell
Služi za određivanje hoće li se formula u okviru za uređivanje prikazati
kako jest ili kao vrijednost rezultata izračuna.
Formula◆: služi za prikaz formule onakve kakva jest.
Value: prikaz rezultata formule.

Auto Calc i Recalculate
„Auto Calc” stavka je postavke u izborniku TOOLS (pogledajte odjeljak
„Stavke postavki aplikacije Spreadsheet” (stranica 96)).
Ako je omogućena zadana postavka u aplikaciji Spreadsheet (Auto
Calc: On), formule u ćelijama automatski se izračunavaju nakon
svakog uređivanja sadržaja ćelija. Ovisno o sadržaju proračunske tablice
automatsko izračunavanje može dugo trajati. Ako je postavka Auto
Calc onemogućena (Off), po potrebi ćete ručno morati provoditi ponovni
izračun.
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Ručna provedba ponovnog izračuna

Pritisnite , odaberite [Recalculate], a zatim pritisnite .

Napomena

• Čak i ako je za postavku Auto Calc odabrana opcija On (uključeno), u sljedećim biste
slučajevima trebali provesti postupak s pomoću opcije [Recalculate]:
– ako u izborniku SETTINGS izmijenite postavku Angle Unit
– ako ćelija sadržava formulu koja sadržava funkciju „f(” ili „g(” te ako je ažurirana

pripadajuća definicijska jednadžba (f(x) ili g(x))
– ako ćelija sadržava formulu koja sadržava varijablu te je pripadajuća varijabla

ažurirana.

Izrada brojevne tablice
S pomoću aplikacije Table možete izraditi brojevnu tablicu koja se temelji
na definicijskim jednadžbama registriranima za funkcije f(x) i g(x).

Opći postupak izrade brojevne tablice

Primjer: izrada brojevne tablice za funkcije f(x) = x2 + 1
2  i g(x) = x2 - 1

2  za

raspon -1 ≤ x ≤ 1, u koracima od 0,5

1. Pritisnite , odaberite ikonu aplikacije Table, a zatim pritisnite .
• Prikazat će se zaslon s brojevnom tablicom.
• Ako za f(x) i/ili g(x) nije registrirana definicijska jednadžba te nema

podataka na mjestu na kojem se nalazi pokazivač, na dnu zaslona
pojavit će se poruka da definicijska jednadžba nije registrirana.

2. Konfigurirajte postavke za generiranje brojčane tablice na temelju dvije
funkcije.
(1) Pritisnite , a zatim odaberite [Table Type] > [f(x)/g(x)].
(2) Pritisnite .
• Za informacije o postavkama pogledajte odjeljak „Maksimalni broj

redaka u brojevnoj tablici prema postavci Table Type (Vrsta
tablice)” (stranica 98).

3. Registrirajte definicijsku jednadžbu za f(x).

 – [Define f(x)/g(x)] > [Define f(x)]
1 2
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(Zaslon koji je prikazan neposredno prije nego što pritisnete )

4. Registrirajte definicijsku jednadžbu za g(x).

 – [Define f(x)/g(x)] > [Define g(x)]
1 2

(Zaslon koji je prikazan neposredno prije nego što pritisnete )

• Definicijski izraz možete registrirati i s pomoću tipke . Za
više informacija pogledajte odjeljak „Registracija definicijske
jednadžbe” (stranica 99).

5. Konfigurirajte postavku raspona brojevne tablice.

 – [Table Range]
((-))1 1 0 5

6. Pritisnite .
• Na zaslonu s brojevnom tablicom prikazat će se rezultat.

• Postupak generiranja brojčane tablice uzrokuje promjenu sadržaja
varijable x.

Napomena

• Na zaslonu s brojevnom tablicom možete pohraniti vrijednost u ćeliji u varijablu.
Primjerice, ako provedete sljedeći postupak dok je prikazan zaslon iz koraka 6.,
pohranit ćete -1 u varijablu A:  – [A=] > [Store]. Za pojedinosti o varijablama
pogledajte odjeljak „Varijable (A, B, C, D, E, F, x, y, z”) (stranica 37).

Maksimalni broj redaka u brojevnoj tablici prema
postavci Table Type (Vrsta tablice)

Možete konfigurirati postavke zaslona s brojevnom tablicom tako da se
prikazuju stupci za f(x) i g(x) ili za jednu od tih funkcija. Postavku odaberite
s pomoću izbornika koji se pojavi kada pritisnete  – [Table Type] dok je
prikazan zaslon s brojevnom tablicom.
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f(x)/g(x) ... Služi za prikaz stupaca za f(x) i g(x) (zadana postavka)
f(x) ... Služi za prikaz isključivo stupca za f(x)
g(x) ... Služi za prikaz isključivo stupca za g(x)

Maksimalni broj redaka u generiranoj brojevnoj tablici ovisi o postavci
Table Type. Podržano je najviše 45 redaka za postavku „f(x)” ili „g(x)” i
najviše 30 redaka za postavku „f(x)/g(x)”.

Registracija definicijske jednadžbe
Dva su načina na koja možete registrirati definicijsku jednadžbu za f(x) i
g(x).
• Dok je prikazan zaslon s brojevnom tablicom u aplikaciji Table,

registrirajte jednadžbu tako da pritisnete 
 – [Define f(x)/g(x)] > [Define f(x)]
 – [Define f(x)/g(x)] > [Define g(x)]

• Dok je prikazan zaslon s brojevnom tablicom u aplikaciji Table ili dok
upotrebljavate bilo koju aplikaciju kalkulatora osim aplikacija Distribution,
Equation (Simul Equation / Polynomial), Inequality, Base-N, Ratio i Math
Box, registrirajte jednadžbu tako da pritisnete 

 – [Define f(x)]
 – [Define g(x)]

Pojavit će se isti zaslon za registraciju jednadžbe f(x) ili g(x), neovisno
o tome koji od dva navedenih postupka upotrijebite za registraciju
definicijskih jednadžbi.

Napomena

• Za pojedinosti o postupcima koji se provode s pomoću tipke  pogledajte odjeljak
„Registracija i uporaba definicijskih jednadžbi za f(x) i g(x)” (stranica 62).

Uređivanje podataka na zaslonu s brojevnom
tablicom

Brisanje retka

1. Na zaslonu s brojevnom tablicom pomaknite pokazivač na redak koji
želite izbrisati.

2. Pritisnite .

Umetanje retka

1. Na zaslonu s brojevnom tablicom pomaknite pokazivač na redak koji će
se nalaziti ispod retka koji umećete.

2. Idite na:  – [Edit] > [Insert Row].
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Brisanje cjelokupnog sadržaja zaslona s brojevnom tablicom

Na zaslonu s brojevnom tablicom idite na:  – [Edit] > [Delete All].

Promjena unesene vrijednosti u ćeliji u stupcu x

Možete promijeniti vrijednost u trenutačno označenoj ćeliji varijable x.
Promjenom vrijednosti x sukladno se ažuriraju i vrijednosti f(x) i g(x) u
istom retku.

Unos vrijednosti u označenu ćeliju u stupcu x s pomoću
sljedeće sintakse: {vrijednost gornje ćelije} +/- {vrijednost
koraka}

Ako se u ćeliji u stupcu x iznad trenutačno označene ćelije x nalazi
neka vrijednost, pritiskom na  ili  automatski ćete u istaknutu ćeliju
unijeti vrijednost jednaku vrijednosti ćelije iznad nje uvećanu za vrijednost
koraka. Isto tako, ako pritisnete , automatski ćete unijeti vrijednost
jednaku vrijednosti gornje ćelije umanjenu za vrijednost koraka. Sukladno
s time ažurirat će se i vrijednosti f(x) i g(x) u istom retku.

Slučajevi u kojima se ažuriraju f(x) i g(x)
Vrijednosti f(x) i g(x) prikazane na zaslonu s brojevnom tablicom ažuriraju
se ako dođe do bilo kojeg od sljedećih slučajeva:
• ako pritisnete  dok je na zaslonu Table Range odabrana stavka

[Execute]
• ako ažurirate definicijske jednadžbe za f(x) i g(x) (osim ako je definicijska

jednadžba kompozicija funkcija)
• ako u stupac x unesete broj (što uključuje pritiskanje tipki ,  i  u

stupcu x).

Međutim, imajte na umu da se vrijednosti neće ažurirati automatski nakon
sljedećih postupaka:
• ako u izborniku SETTINGS izmijenite postavku Angle Unit
• ako ažurirate varijablu definicijske jednadžbe (pohranite novu numeričku

vrijednost) pri registraciji definicijske jednadžbe koja sadržava varijablu
(npr. f(x) = 2x + A)

• ako registrirate definicijsku jednadžbu kompozicije funkcija (npr. g(x) =
f(x) × 2 - x) i ažurirate definicijsku jednadžbu referentne funkcije (npr. f(x)
od g(x) = f(x) × 2 - x) (ako registrirate novu definicijsku jednadžbu).

Kako biste ažurirali vrijednosti u tim slučajevima, idite na  –
[Recalculate] dok je prikazan zaslon s brojevnom tablicom.
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Zadržavanje podataka
Ako učinite sljedeće, određeni će se podaci odbaciti i očistit će se
određene postavke u aplikaciji Table:① ako se vratite na zaslon HOME i pokrenete neku drugu aplikaciju

kalkulatora② ako pritisnete③ ako promijenite postavku Input/Output u izborniku SETTINGS④ ako promijenite postavku Table Type u izborniku TOOLS.
U tablici u nastavku navedeno je koji će se podaci odbaciti, a koji će se
podaci zadržati.

Postupak ① ② ③ ④
Podaci u brojevnoj
tablici
(stupci x, f(x), g(x))

Odbačeno Odbačeno Odbačeno Odbačeno

Postavke Table Range Odbačeno Zadržano Zadržano Zadržano
Postavke Table Type Zadržano Zadržano Zadržano --
Definicijske jednadžbe
za f(x), g(x) Zadržano Odbačeno Odbačeno Zadržano

Izračuni jednadžbi
Aplikacija Equation sadržava tri funkcije opisane u nastavku. Nakon
pokretanja aplikacije pojavit će se izbornik Equation, s pomoću kojeg
možete odabrati željenu funkciju.

Simul Equation: sustav linearnih jednadžbi s dvjema do četirima
nepoznanicama
Polynomial: jednadžbe višeg reda od drugog do četvrtog stupnja
Solver: funkcija za pronalazak vrijednosti bilo koje varijable u unesenoj
jednadžbi

Sustav linearnih jednadžbi
U ovom se odjeljku nalazi objašnjenje općeg postupka za rješavanje
sustava jednadžbi s primjerom rješavanja sustava linearnih jednadžbi s
trima nepoznanicama.
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Primjer 1.: 

1. Pritisnite , odaberite ikonu aplikacije Equation, a zatim pritisnite .
• Prikazat će se izbornik Equation.

2. Odaberite [Simul Equation], a zatim pritisnite .
• Prikazat će se izbornik s brojem nepoznanica.

3. Odaberite [3 Unknowns], a zatim pritisnite .
• Prikazat će se uređivač koeficijenata.

4. S pomoću uređivača koeficijenata unesite vrijednosti koeficijenata.

1 ((-))1 1 2
1 1 ((-))1 0

((-))1 1 1 4

• Ako pritisnete  dok je prikazan uređivač koeficijenata, vrijednost
svih koeficijenata postat će nula.

5. Pritisnite .
• Prikazat će se rješenje.

• Dok je prikazana oznaka , svakim pritiskom tipke  (ili ) prikazat
će se drugo rješenje.

 (ili )
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 (ili )

• Ako pritisnete  ili  dok je prikazana oznaka , ponovno će se
pojaviti rješenje koje je upravo nestalo.

• Ako pritisnete  dok je prikazano konačno rješenje, vratit ćete se
u uređivač koeficijenata. Za povratak u uređivač koeficijenata dok je
prikazano bilo koje rješenje pritisnite .

• Ako pritisnete  dok je prikazan uređivač koeficijenata, vratit ćete se
u izbornik s brojem nepoznanica.

Napomena

• Dok je prikazan uređivač koeficijenata, možete pohraniti trenutačno prikazanu
vrijednost u varijablu. Isto tako, dok je prikazano rješenje, i njega možete pohraniti
u varijablu. Za pojedinosti o varijablama pogledajte odjeljak „Varijable (A, B, C, D, E,
F, x, y, z)” (stranica 37).

Jednadžbe višeg reda od drugog do četvrtog
stupnja

Kada riješite jednadžbu višeg reda s pomoću aplikacije Equation,
vrijednosti u nastavku prikazane su prema stupnju jednadžbe.

• Kvadratna jednadžba
Nakon prikaza rješenja jednadžbe ax2+bx+c=0 prikazat će se minimalne
(ili maksimalne) koordinate (x, y) za y=ax2+bx+c.

• Kubna jednadžba
Nakon prikaza rješenja jednadžbe ax3+bx2+cx+d=0 prikazat će se
koordinate (x, y) lokalnog minimuma (ili lokalnog maksimuma)
jednadžbe y=ax3+bx2+cx+d, pod uvjetom da lokalni minimum ili lokalni
maksimum postoje. Ako lokalni minimum ili lokalni maksimum ne
postoje i pritisnete  dok je prikazano posljednje rješenje, pojavit će
se poruka „No Local Max/Min”.

• Jednadžba četvrtog stupnja
Prikazano je rješenje jednadžbe ax4+bx3+cx2+dx+e=0.

U ovom je odjeljku prikazan primjer kvadratne jednadžbe radi objašnjenja
općeg postupka rješavanja jednadžbe višeg reda.

Primjer 2.: x2 + 2x − 2 = 0
(Input/Output: MathI/MathO)
1. Pritisnite , odaberite ikonu aplikacije Equation, a zatim pritisnite .
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• Prikazat će se izbornik Equation.

2. Odaberite [Polynomial], a zatim pritisnite .
• Prikazat će se izbornik s brojem stupnjeva.

3. Odaberite [ax2+bx+c], a zatim pritisnite .
• Prikazat će se uređivač koeficijenata.

4. S pomoću uređivača koeficijenata unesite vrijednosti koeficijenata.

1 2 ((-))2

• Ako pritisnete  dok je prikazan uređivač koeficijenata, vrijednost
svih koeficijenata postat će nula.

5. Pritisnite .
• Prikazat će se rješenje.

• Dok je prikazana oznaka , svakim pritiskom tipke  (ili ) prikazat
će se neki drugi rezultat izračuna (rješenje ili koordinata).

 (ili )

(Prikazana je x koordinata minimuma za y = x2 + 2x − 2.)

 (ili )
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(Prikazana je y koordinata minimuma za y = x2 + 2x − 2.)

 (ili )

• Ako pritisnete  ili  dok je prikazana oznaka , ponovno će se
pojaviti rezultat izračuna koji je bio prethodno prikazan.

• Ako pritisnete  dok je prikazan konačni rezultat izračuna, vratit ćete
se u uređivač koeficijenata. Za povratak u uređivač koeficijenata dok
je prikazan bilo koji rezultat izračuna pritisnite .

• Ako pritisnete  dok je prikazan uređivač koeficijenata, vratit ćete se
u izbornik s brojem stupnjeva.

Napomena

• Dok je prikazan uređivač koeficijenata, možete pohraniti trenutačno prikazanu
vrijednost u varijablu. Isto tako, dok je prikazan rezultat izračuna (rješenje ili
koordinata), možete ga pohraniti u varijablu. Za pojedinosti o varijablama pogledajte
odjeljak „Varijable (A, B, C, D, E, F, x, y, z)” (stranica 37).

Prikaz rješenja s kompleksnim brojevima (Complex Roots)

Rješenja jednadžbi višeg reda mogu sadržavati kompleksne brojeve. Ako
u izborniku Equation odaberete opciju Polynomial, s pomoću postupaka u
nastavku možete omogućiti ili onemogućiti prikaz rješenja s kompleksnim
brojevima.

 – [Complex Roots] > [On] 
Služi za omogućivanje prikaza rješenja s kompleksnim brojevima
(zadana postavka).

 – [Complex Roots] > [Off] 
Služi za onemogućivanje prikaza rješenja s kompleksnim brojevima.
Ako unesete i izvršite jednadžbu koja ima jedno ili više rješenja s
kompleksnim brojevima, pojavit će se poruka „No Real Roots”.

Primjer 3.: 2x2 + 3x + 4 = 0
(Input/Output: MathI/MathO, Complex Result: a+bi, Complex Roots: On)
1. Pritisnite , odaberite ikonu aplikacije Equation, a zatim pritisnite .

• Prikazat će se izbornik Equation.
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2. Odaberite [Polynomial] > [ax2+bx+c].
• Prikazat će se uređivač koeficijenata.

3. S pomoću uređivača koeficijenata unesite vrijednosti koeficijenata.

2 3 4

4. Pritisnite .
• Prikazat će se rješenje.

5. Omogućite prikaz drugog rješenja i vrijednosti koordinata.

 (ili )

 (ili )

 (ili )

• Ako pritisnete  dok je prikazan konačni rezultat izračuna, vratit ćete
se u uređivač koeficijenata. Za povratak u uređivač koeficijenata dok
je prikazan bilo koji rezultat izračuna pritisnite .

Pretvorba rješenja s kompleksnim brojevima u pravokutne ili
polarne koordinate

S pomoću izbornika FORMAT, koji se pojavi kada pritisnete , možete
pretvoriti rješenje s kompleksnim brojevima u pravokutne ili polarne
koordinate.

Primjer 4.: pretvorba rješenja s kompleksnim brojevima prikazanog u
primjeru 3. (stranica 105) u polarne koordinate, a potom u pravokutne
koordinate
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1. Obavite korake od 1. do 4. iz primjera 3. (stranica 105)

2. Pritisnite , odaberite [Polar Coord], a zatim pritisnite .
• Rješenje će se pretvoriti u polarne koordinate.

3. Pritisnite , odaberite [Rectangular Coord], a zatim pritisnite .
• Rješenje će se pretvoriti u pravokutne koordinate.

Uporaba značajke Solver
U okviru značajke Solver upotrebljava se Newtonova metoda za
aproksimaciju rješenja jednadžbi. Solver podržava unos jednadžbi u
oblicima navedenima u nastavku.
Primjeri: y = x + 5, x = sin(A), xy + C (tretira se kao xy + C = 0)

Primjer 5.: dobivanje rješenja jednadžbe x2 - B
2  = 0 za x ako je B = 4

(Input/Output: MathI/MathO)

Napomena

• Prije dobivanja rješenja jednadžbe x2 - B
2  = 0 za x u varijablu B trebate pohraniti 4. To

možete učiniti u koraku 3. u okviru postupka u nastavku.

1. Pritisnite , odaberite ikonu aplikacije Equation, a zatim pritisnite .
• Prikazat će se izbornik Equation.

2. Odaberite [Solver], a zatim pritisnite .
• Prikazat će se zaslon značajke Solver za unos jednadžbe.

3. Ovdje pohranite 4 u varijablu B.

4

• Taj postupak možete obaviti u bilo kojem trenutku prije koraka 7. u
okviru ovog postupka.
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• Za pojedinosti o varijablama pogledajte odjeljak „Varijable (A, B, C,
D, E, F, x, y, z)” (stranica 37).

• Pritisnite  za povratak na zaslon značajke Solver za unos
jednadžbe.

4. Unesite jednadžbu.

(B) 2
(=)*0

* Znak = možete unijeti i tako da odete na:  – [Equation] > [=].
5. Pritisnite  za registraciju unesene jednadžbe.
6. Na zaslonu Solve Target koji se pojavio potvrdite da ste odabrali [x] i

potom pritisnite .
• Prikazat će se zaslon s početnom vrijednošću varijable x.

7. Unesite 1 kao početnu vrijednost varijable x.

1

8. Nakon što potvrdite da ste odabrali [Execute], pritisnite  kako biste
dobili rješenje jednadžbe.

(1) Varijabla riješena za
(2) Rješenje
(3) Rezultat (lijeva strana) − (desna strana)

• Rješenja se uvijek prikazuju u decimalnom obliku.
• Što je rezultat (lijeva strana) − (desna strana) bliži nuli, to je rješenje

preciznije.
9. Nakon toga pritisnite tipku sa željenom funkcijom.

Funkcija:
Tipka koju trebate
pritisnuti:

Povratak na zaslon u koraku 6. *
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Pohrana unesenog izraza i povratak na zaslon
u koraku 4.

 ili 

* Kada pritisnete tu tipku, zadana vrijednost postaje posljednja zadana
vrijednost koju ste upotrijebili za izračun.

Važno!

• U okviru značajke Solver zadani broj puta provodi
se konvergencija. Ako se ne može utvrditi rješenje,
prikazat će se potvrdni zaslon prikazan zdesna s
upitom za nastavak. Pritisnite  dok je odabrana
opcija [Continue] kako biste nastavili ili odaberite
[Exit], a zatim  kako biste otkazali postupak u
okviru značajke Solver.

• Ovisno o tome koju ste početnu vrijednost unijeli za varijablu rješenja (x u prethodnom
primjeru) možda nećete moći dobiti rješenje s pomoću značajke Solver. Ako se to
dogodi, pokušajte promijeniti početnu vrijednost kako bi bila bliža rješenju.

• S pomoću značajke Solver možda nećete moći odrediti točno rješenje, čak i ako
postoji.

• U okviru značajke Solver upotrebljava se Newtonova metoda, tako da i ako postoji
više rješenja, dobit ćete samo jedno od njih.

• Zbog ograničenja Newtonove metode u pravilu je teško dobiti rješenja za jednadžbi
poput sljedećih: y=sinx, y=ex, y=√x.

Izračuni nejednadžbi
S pomoću aplikacije Inequality možete dobiti rješenje nejednadžbi drugog,
trećeg ili četvrtog stupnja.

Opći postupak za provođenje izračuna
nejednadžbe

Primjer 1.: dobivanje rješenja za x2 + 2x - 3 ≥ 0
1. Pritisnite , odaberite ikonu aplikacije Inequality, a zatim pritisnite .

• Prikazat će se izbornik s brojem stupnjeva.

2. Odaberite [ax2+bx+c], a zatim pritisnite .
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3. U izborniku koji se pojavio odaberite vrstu i smjer simbola nejednakosti
(>, <, ≥, ≤).
• U ovom slučaju želimo dobiti rješenje nejednadžbe x2 + 2x - 3 ≥ 0,

stoga odaberite [ax2+bx+c≥0] i potom pritisnite .
4. U uređivač koeficijenata koji se pojavio unesite vrijednosti koeficijenata.

1 2 ((-))3

5. Pritisnite .
• Prikazat će se rješenje.

• Za povratak u uređivač koeficijenata dok je prikazano rješenje
pritisnite ,  ili .

• Ako pritisnete  dok je prikazan uređivač koeficijenata, vratit ćete se
u izbornik iz koraka 2.

• Ako pritisnete  dok je prikazan izbornik iz koraka 2., vratit ćete se u
izbornik s brojem stupnjeva.

Napomena

• Rješenja se prikazuju kao na zaslonu u nastavku ako je u izborniku SETTINGS za
postavku Input/Output odabrano nešto drugo osim opcije MathI/MathO.

• Na zaslonu rješenja pojavit će se „No Solution” ako za nejednadžbu ne postoji rješenje
(npr. za x2 < 0).

• Na zaslonu rješenja pojavit će se „All Real Numbers” ako se rješenje nejednadžbe
sastoji samo od brojeva (npr. za x2 ≥ 0).
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Izračuni s kompleksnim brojevima
Za obavljanje izračuna s kompleksnim brojevima prvom pokrenite
aplikaciju Complex.
Pritisnite , odaberite ikonu aplikacije Complex, a zatim pritisnite .

Unos kompleksnih brojeva
Kompleksne brojeve možete unositi s pomoću pravokutnih koordinata
(a+bi) ili polarnih koordinata (r∠θ).

Primjer 1.: unos izraza 2+3i

2 3 (i)*

* i možete unijeti i tako da odete na:  – [Complex] > [i].

Primjer 2.: unos izraza 5∠30

5  – [Complex] > [∠] 30

Primjeri računanja u aplikaciji Complex

Prije provedbe postupaka iz primjera

• Za potrebe primjera u ovom odjeljku za postavku Input/Output
odaberite opciju MathI/MathO u izborniku SETTINGS. Ostale postavke
konfigurirajte kako je navedeno u svakom primjeru.

• Rezultati izračuna s kompleksnim brojevima prikazuju se u skladu s
postavkom Complex Result u izborniku SETTINGS.

• Ako planirate obaviti unos i prikaz rezultata izračuna u obliku
polarnih koordinata, prije nego što započnete s izračunom, u izborniku
SETTINGS odredite stavku Angle Unit.

• Vrijednost θ u rezultatu izračuna prikazuje se u rasponu -180° < θ ≤
180°.

• Ako pokušate prikazati rezultat izračuna dok je odabrano bilo što osim
opcije MathI/MathO, a i bi (ili r i θ) prikazat će se u zasebnim recima.

Primjer 3.: (1 + i)4 + (1 - i)2 = -4 - 2i
(Complex Result: a+bi)

1 (i) 4
1 (i)
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Napomena

• Pri dizanju kompleksnog broja na n-tu potenciju s pomoću sintakse (a+bi)n vrijednost
potencije može biti u sljedećem rasponu: -1 × 1010 < n < 1 × 1010.

Primjer 4.: 2∠45 = √2 + √2i
(Angle Unit: Degree, Complex Result: a+bi)

2  – [Complex] > [∠] 45

Primjer 5.: √2 + √2i = 2∠45
(Angle Unit: Degree, Complex Result: r∠θ)

2 2 (i)

Primjer 6.: dobivanje kompleksno konjugiranog broja iz 2 + 3i
(Complex Result: a+bi)

 – [Complex] > [Conjugate]
2 3 (i)

Primjer 7.: dobivanje apsolutne vrijednosti i argumenta iz 1 + i
(Angle Unit: Degree)

 – [Numeric Calc] > [Absolute Value]
1 (i)

 – [Complex] > [Argument]
1 (i)

Primjer 8.: izdvajanje realnog i imaginarnog dijela iz izraza 2 + 3i

 – [Complex] > [Real Part]
2 3 (i)
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 – [Complex] > [Imaginary Part]
2 3 (i)

Pretvorba rezultata izračuna s kompleksnim brojevima u
pravokutne ili polarne koordinate

S pomoću izbornika FORMAT, koji se pojavi kada pritisnete , možete
pretvoriti rezultat izračuna s kompleksnim brojevima u pravokutne ili
polarne koordinate.

Primjer 9.: √2 + √2i = 2∠45, 2∠45 = √2 + √2i
(Angle Unit: Degree, Complex Result: a+bi)

2 2 (i)

 – [Polar Coord]

 – [Rectangular Coord]

Izračuni s različitim brojevnim
sustavima
Kada želite obavljati izračune s pomoću decimalnih, heksadecimalnih,
binarnih i/ili oktalnih brojeva, pokrenite aplikaciju Base-N. Pritisnite ,
odaberite ikonu aplikacije Base-N, a zatim pritisnite . Kada pokrenete
aplikaciju Base-N, zadana je postavka brojevnog sustava decimalni
sustav.

Nakon pokretanja aplikacije Base-N promijenite brojevni sustav s pomoću
tipke .
Svakim pritiskom tipke  prebacit ćete brojevni sustav kako je prikazano
u nastavku.
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(1) [Decimal]  (2) [Hexadecimal]  (3) [Binary]  (4) [Octal]

Napomena

• Indeks uz vrijednosti navedene u primjerima upućuju na bazu (brojevni sustav) svake
vrijednosti.
Primjer: 12 ... Binarni 1; 116 ... Heksadecimalni 1

Primjer 1.: izračun izraza 112 + 12

1. S pomoću tipke  promijenite brojevni sustav u [Binary].
2. Obavite izračun izraza 112 + 12.

11 1

Primjer 2.: izračun izraza 1F16 + 116 u heksadecimalnom sustavu
1. S pomoću tipke  promijenite brojevni sustav u [Hexadecimal].
2. Obavite izračun izraza 1F16 + 116.

1 (F) 1

Napomena

• Sljedeće tipke služe za unos slova od A do F za heksadecimalne vrijednosti: 
(A), (B), (C), (D), (E), (F). Heksadecimalne

vrijednosti možete unijeti i s pomoću stavki izbornika CATALOG navedenih u
nastavku.

 – [Hex Value] > [A], [B], [C], [D], [E] ili [F]
• Imajte na umu da ako unesete bilo koji znak od A do F s pomoću postupka u

nastavku, znak će se smatrati nazivom varijable, a ne heksadecimalnom vrijednošću.
(1) Pritisnite  za prikaz zaslona s popisom varijabli.
(2) Odaberite [A=], [B=], [C=], [D=], [E=] ili [F=], a zatim pritisnite .
(3) U izborniku koji se pojavio odaberite [Recall].

• U aplikaciji Base-N nije podržan unos razlomaka i decimalnih brojeva te eksponenata.
Decimalni se dijelovi u rezultatima izračuna izostavljaju.

• U nastavku su prikazane pojedinosti o ulaznim i izlaznim rasponima (32 bita).•
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Baza Raspon

Binarno

Pozitivno: 00000000000000000000000000000000 ≤ x ≤
01111111111111111111111111111111
Negativno: 10000000000000000000000000000000 ≤ x ≤
11111111111111111111111111111111

Oktalno
Pozitivno: 00000000000 ≤ x ≤ 17777777777
Negativno: 20000000000 ≤ x ≤ 37777777777

Decimalno -2147483648 ≤ x ≤ 2147483647

Heksadecimalno
Pozitivno: 00000000 ≤ x ≤ 7FFFFFFF
Negativno: 80000000 ≤ x ≤ FFFFFFFF

• Ako je rezultat izračuna izvan primjenjivog raspona za korišteni brojevni sustav, pojavit
će se greška Math ERROR.

Utvrđivanje brojevnog sustava unesene vrijednosti
Za utvrđivanje brojevnog sustava neke vrijednosti možete unijeti posebnu
naredbu neposredno prije te vrijednosti. Posebne su naredbe: d
(decimalni), h (heksadecimalni), b (binarni) i o (oktalni).

Primjer 3.: izračun izraza 1010 + 1016 + 102 + 108 i prikaz rezultata kao
decimalne vrijednosti
1. S pomoću tipke  promijenite brojevni sustav u [Decimal].
2. Obavite izračun izraza 1010 + 1016 + 102 + 108.

 – [Base Prefix] > [Decimal(d)] 10
 – [Base Prefix] > [Hexadecimal(h)] 10

 – [Base Prefix] > [Binary(b)] 10
 – [Base Prefix] > [Octal(o)] 10

Pretvaranje rezultata izračuna u vrijednost različite
vrste

S pomoću tipke  možete pretvoriti trenutačno prikazani rezultat izračuna
u vrijednost neke druge vrste.

Primjer 4.: izračun izraza 1510 × 3710 u decimalnom obliku i naknadna
pretvorba rezultata u heksadecimalni sustav
1. S pomoću tipke  promijenite brojevni sustav u [Decimal].
2. Obavite izračun izraza 1510 × 3710.

15 37
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3. S pomoću tipke  promijenite brojevni sustav u [Hexadecimal].

Logičke i negacijske operacije
Logičke i negacijske operacije provode se pritiskom tipke  i odabirom
stavke [Logic Operation] te odabirom željene naredbe (Neg, Not, and, or,
xor, xnor) u izborniku koji se pojavi. Svi primjeri u nastavku provedeni su u
binarnom načinu rada.

Primjer 5.: Određivanje logičke vrijednosti AND za 10102 i 11002 (10102

and 11002)

1010
 – [Logic Operation] > [and]

1100

Primjer 6.: Odrediti komplement broju 10102 (Not(10102))

 – [Logic Operation] > [Not]
1010

Napomena

• U slučaju negativne binarne, oktalne ili heksadecimalne vrijednosti kalkulator će
pretvoriti vrijednost u binarnu, dodaje dvojni komplement te potom vraća vrijednost
u prvotni sustav. Kod decimalnih vrijednosti kalkulator samo dodaje znak minus.

Matrični račun
S pomoću aplikacije Matrix možete provoditi račune matrica maksimalne
veličine 4 redaka i 4 stupaca.

Opći postupak za provođenje matričnog računa
Kako biste obavili matrični izračun, upotrebljavajte posebne matrične
varijable (MatA, MatB, MatC, MatD) kako je prikazano u primjeru u
nastavku.

Primjer 1.: izračun izraza 
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• Kako biste obavili umnožak (matrica 1 x matrica 2), broj stupaca u
matrici 1 treba odgovarati broju redaka u matrici 2. U protivnom će doći
do greške.

1. Pritisnite , odaberite ikonu aplikacije Matrix, a zatim pritisnite .
• Prikazat će se zaslon s matričnim računom.

2. Pritisnite .
• Prikazat će se zaslon s popisom matričnih varijabli.

• Za pojedinosti o sadržaju zaslona s popisom matričnih varijabli i
informacije o tomu kako provesti postupke pohranjivanja i uređivanja
matričnih varijabli te druge postupke pogledajte odjeljak „Zaslon s
popisom matričnih varijabli” (stranica 118).

3. Obavite korake u nastavku kako biste pohranili u MatA.

(1) Odaberite [MatA:], a zatim pritisnite .
• Prikazat će se zaslon s postavkama veličine matrice (zadana je

postavka: 2 retka, 2 stupca).

(2) U ovom slučaju želimo pohraniti matricu veličine 2x2, stoga
odaberite [Confirm] i potom pritisnite .
• Prikazat će se matrični uređivač za unos elemenata matrice veličine

2x2 za MatA.

(3) Unesite elemente za MatA.

2 1 1 1

(4) Pritisnite ,  ili  za povratak na zaslon za matrični račun.
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4. Obavite korake u nastavku kako biste pohranili u MatB.

(1) Pritisnite , odaberite [MatB:], a zatim pritisnite .
(2) Odaberite [Confirm], a zatim pritisnite .
(3) Unesite elemente za MatB.

2 ((-))1 ((-))1 2

(4) Pritisnite ,  ili  za povratak na zaslon za matrični račun.
5. Unesite MatA×MatB

 – [Matrix] > [MatA]
 – [Matrix] > [MatB]

6. Pritisnite .
• Prikazat će se zaslon MatAns (matrična pozitivna memorija) s

rezultatom izračuna.

• Za pojedinosti o matričnoj pozitivnoj memoriji (MatAns) pogledajte
odjeljak „Matrična pozitivna memorija (MatAns)” (stranica 121).

• Ako pritisnete  dok je prikazan zaslon MatAns, vratit ćete se
na zaslon za matrični račun i očistit će se izraz izračuna. Ako
pritisnete  ili , vratit ćete stanje potpunog unosa izraza izračuna
iz koraka 5. u okviru ovog postupka.

Napomena

• Dok su prikazani matrični uređivač ili zaslon MatAns, možete pohraniti trenutačno
prikazanu vrijednost u varijablu. Dok je prikazan zaslon za matrični račun i na zaslonu
se nalazi vrijednost rezultata izračuna, možete pohraniti prikazani rezultat izračuna u
varijablu. Za pojedinosti o varijablama pogledajte odjeljak „Varijable (A, B, C, D, E, F,
x, y, z)” (stranica 37).

Zaslon s popisom matričnih varijabli
Zaslon s popisom matričnih varijabli značajka je koju biste trebali
upotrebljavati ako želite pohraniti matricu u matričnu varijablu MatA, MatB,
MatC ili MatD ili ako želite urediti prethodno pohranjenu matricu. Status
svake matrične varijable označava se kako je prikazano u primjerima u
nastavku.
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(1) 2×2
Označava da je u matričnu varijablu pohranjena matrica veličine 2x2.

(2) None
Označava da u matričnu varijablu nije pohranjeno ništa.

Prikaz zaslona s popisom matričnih varijabli

Ovisno o trenutačno prikazanom zaslonu obavite jedan od postupaka u
nastavku.
• Ako je prikazan zaslon za matrični račun:

Pritisnite .
• Ako su prikazani zaslon matričnog uređivača ili zaslon MatAns:

Pritisnite , odaberite [Define Matrix], a zatim pritisnite .

Pohrana novih podataka u matričnu varijablu

Primjer 2.: pohrana matrice veličine 2x3 

1. Dok je prikazan zaslon za matrični račun, pritisnite  za prikaz zaslona
s popisom matričnih varijabli.

2. Odaberite matričnu varijablu (MatA, MatB, MatC ili MatD) u koju želite
pohraniti nove podatke, a zatim pritisnite .
• Ako ste odabrali matričnu varijablu čiji je status „None”, idite na

korak 4. ovog postupka.
• Ako ste odabrali matričnu varijablu u koju je već pohranjena matrica,

prikazat će se zaslon s izbornikom. Idite na korak 3.

3. Odaberite [Define New], a zatim pritisnite .
4. Na zaslonu „Matrix Size?” koji se pojavio odredite broj redaka i stupaca

u matrici.

• Kako biste odredili matricu veličine 2x3, obavite korake u nastavku.
(1) Odaberite [Rows] a zatim pritisnite . U izborniku koji će se pojaviti

odaberite [2 Rows] i potom pritisnite .
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(2) Odaberite [Columns], a zatim pritisnite . U izborniku koji će se
pojaviti odaberite [3 Columns] i potom pritisnite .

5. Nakon što postavite željeni broj redaka i stupaca, odaberite [Confirm] i
potom pritisnite .
• Prikazat će se matrični uređivač.

6. Unesite elemente matrične varijable.

1 0 ((-))1
0 ((-))1 1

7. Pritisnite ,  ili  za povratak na zaslon za matrični račun.

Napomena

• Sadržaj matričnih varijabli zadržava se čak i ako pritisnete , promijenite aplikaciju
kalkulatora ili isključite kalkulator. Ako provedete bilo koji od sljedećih postupaka,
očistit će se cjelokupan sadržaj svih matričnih varijabli:
-  – [Reset] > [Settings & Data]
-  – [Reset] > [Initialize All].

Uređivanje podataka matričnih varijabli

1. Dok je prikazan zaslon za matrični račun, pritisnite  za prikaz zaslona
s popisom matričnih varijabli.

2. Odaberite matričnu varijablu (MatA, MatB, MatC ili MatD) koju želite
urediti, a zatim pritisnite .

3. U izborniku koji će se pojaviti odaberite [Edit] i potom pritisnite .
• Prikazat će se matrični uređivač.

4. S pomoću matričnog uređivača uredite elemente matrice.
• Pomaknite pokazivač na ćeliju koja sadržava element koji želite

izmijeniti, unesite novu vrijednost, a zatim pritisnite .
5. Pritisnite ,  ili  za povratak na zaslon za matrični račun.

Kopiranje sadržaja matrične varijable (ili memorije MatAns)

1. Idite na zaslon matričnog uređivača ili zaslon memorije MatAns s
matričnom varijablom koju želite kopirati.
• Za prikaz matričnog uređivača obavite korak 1., 2. i 3. iz odjeljka

„Uređivanje podataka matričnih varijabli” (stranica 120).
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• Za prikaz zaslona memorije MatAns obavite korake u nastavku dok je
prikazan zaslon za matrični račun.

 – [Matrix] > [MatAns] 
2. Odaberite odredište za kopiranje matrične varijable.

• Primjerice, kako biste je kopirali u MatD, idite na:  – [Store] >
[MatD].

• Prikazat će se matrični uređivač sa sadržajem odredišne varijable.
3. Pritisnite ,  ili  za povratak na zaslon za matrični račun.

Matrična pozitivna memorija (MatAns)
U slučaju da je rezultat izračuna obavljenog u aplikaciji Matrix matrica,
pojavit će se zaslon memorije MatAns s rezultatom. Rezultat će također
biti pohranjen u varijablu pod nazivom „MatAns”.

Varijabla MatAns može se upotrebljavati u izračunima kako je opisano u
nastavku.
• Kako biste unijeli varijablu MatAns u izračun, idite na:  – [Matrix] >

[MatAns].
• Ako pritisnete bilo koju od sljedećih tipki dok je prikazan zaslon

memorije MatAns, automatski će se pojaviti zaslon za matrični račun
s oznakom „MatAns”, nakon koje slijedi računska operacija ili funkcija
tipke koju ste pritisnuli: , , , , , , , ( ), 
( ).

Napomena

• Sadržaj memorije MatAns zadržava se čak i ako pritisnete  ili isključite kalkulator.
Ako učinite bilo što od sljedećeg, očistit će se sadržaj memorije MatAns:
- ako se vratite na zaslon HOME i pokrenete neku drugu aplikaciju kalkulatora
- ako odete na  – [Reset] > [Settings & Data]
- ako odete na  – [Reset] > [Initialize All].

Primjeri matričnog računa

U primjerima u nastavku MatA = , MatB = , MatC =

, MatD = .

Primjer 3.: zbrajanje dviju matrica (MatA + MatB)

 – [Matrix] > [MatA]
  – [Matrix] > [MatB] 
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Napomena

• Kako biste zbrojili ili oduzeli dvije matrice, trebaju biti istih dimenzija. Ako pokušate
zbrojiti ili oduzeti matrice različitih dimenzija, doći će do greške.

Primjer 4.: kvadriranje i kubiranje matrice MatA (MatA2, MatA3)

 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Matrix Squared]

 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Matrix Cubed]

Primjer 5.: inverzija matrice MatA (MatA-1)

 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Inverse Matrix]

Napomena

• Moguće je provesti inverziju isključivo matrica u obliku kvadrata (s istim brojem redaka
i stupaca). Ako pokušate provesti inverziju matrice koja nije u obliku kvadrata, doći će
do greške.

• Nije moguće provesti inverziju matrice čija je determinanta nula. Ako pokušate
provesti inverziju matrice čija je determinanta nula, doći će do greške.

• Na preciznost izračuna utječe ako je vrijednost determinante matrice blizu nuli.

Primjer 6.: dobivanje determinante matrice MatA (Det(MatA))
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 – [Matrix] > [Matrix Calc] >
[Determinant]  – [Matrix] > [MatA]

Napomena

• Determinante je moguće dobiti samo za matrice u obliku kvadrata (matrice s istim
brojem redaka i stupaca). Ako pokušate dobiti determinantu matrice koja nije u obliku
kvadrata, doći će do greške.

Primjer 7.: provedba transponiranja matrice MatC (Trn(MatC))

 – [Matrix] > [Matrix Calc] >
[Transposition]  – [Matrix] > [MatC]

Primjer 8.: izrada jedinične matrice (matrice identiteta) veličine 2 x 2 i
njezino pribrajanje matrici MatA (Identity(2) + MatA)

 – [Matrix] > [Matrix Calc] > [Identity]
2   – [Matrix] > [MatA]

Napomena

• Broj dimenzija možete odrediti vrijednošću od 1 do 4 kao argument naredbe Identity.

Primjer 9.: dobivanje apsolutne vrijednosti svih elemenata matrice MatC
(Abs(MatC))

 – [Numeric Calc] > [Absolute Value]
 – [Matrix] > [MatC]
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Računanje s vektorima
S pomoću aplikacije Vector možete provesti dvodimenzionalne i
trodimenzionalne vektorske izračune.

Opći postupak za računanje s vektorima
Kako biste obavili vektorski izračun, upotrebljavajte posebne vektorske
varijable (VctA, VctB, VctC, VctD) kako je prikazano u primjeru u nastavku.

Primjer 1.: izračun izraza (1, 2 )+ (3, 4)
• Pri zbrajanju ili oduzimanju dvaju vektora oba vektora moraju biti istih

dimenzija.
1. Pritisnite , odaberite ikonu aplikacije Vector, a zatim pritisnite .

• Prikazat će se zaslon za računanje s vektorima.

2. Pritisnite .
• Prikazat će se zaslon s popisom vektorskih varijabli.

• Za pojedinosti o sadržaju zaslona s popisom vektorskih varijabli i
informacije o tomu kako provesti postupke pohranjivanja i uređivanja
vektorskih varijabli te druge postupke pogledajte odjeljak „Zaslon s
popisom vektorskih varijabli” (stranica 126).

3. Obavite korake u nastavku kako biste pohranili (1, 2) u VctA.
(1) Odaberite [VctA:], a zatim pritisnite .

• Prikazat će se zaslon s postavkama dimenzije vektora (zadana je
postavka: dvije dimenzije).

(2) U ovom slučaju želimo pohraniti dvodimenzionalni vektor, stoga
odaberite [Confirm] i potom pritisnite .

• Prikazat će se vektorski uređivač za unos dvodimenzionalnog
vektora za VctA.
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(3) Unesite elemente za VctA.

1 2

(4) Pritisnite ,  ili  za povratak na zaslon za računanje s
vektorima.

4. Obavite korake u nastavku kako biste pohranili (3, 4) u VctB.
(1) Pritisnite , odaberite [VctB:], a zatim pritisnite .
(2) Odaberite [Confirm], a zatim pritisnite .
(3) Unesite elemente za VctB.

3 4

(4) Pritisnite ,  ili  za povratak na zaslon za računanje s
vektorima.

5. Unesite VctA+VctB.

 – [Vector] > [VctA]
 – [Vector] > [VctB]

6. Pritisnite .
• Prikazat će se zaslon memorije VctAns (vektorske pozitivne

memorije) s rezultatom izračuna.

• Za pojedinosti o vektorskoj pozitivnoj memoriji (VctAns) pogledajte
odjeljak „Vektorska pozitivna memorija (VctAns)” (stranica 128).

• Ako pritisnete  dok je prikazan zaslon VctAns, vratit ćete se na
zaslon za računanje s vektorima i očistit će se izraz izračuna. Ako
pritisnete  ili , vratit ćete stanje potpunog unosa izraza izračuna
iz koraka 5. u okviru ovog postupka.
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Napomena

• Dok su prikazani vektorski uređivač ili zaslon VctAns, možete pohraniti trenutačno
prikazanu vrijednost u varijablu. Dok je prikazan zaslon za računanje s vektorima i
na zaslonu se nalazi vrijednost rezultata izračuna, možete pohraniti prikazani rezultat
izračuna u varijablu. Za pojedinosti o varijablama pogledajte odjeljak „Varijable (A, B,
C, D, E, F, x, y, z)” (stranica 37).

Zaslon s popisom vektorskih varijabli
Zaslon s popisom vektorskih varijabli značajka je koju biste trebali
upotrebljavati ako želite pohraniti vektor u vektorsku varijablu VctA, VctB,
VctC ili VctD ili ako želite urediti prethodno pohranjeni vektor. Status
svake vektorske varijable označava se kako je prikazano u primjerima u
nastavku.

(1) 2
Označava da je u vektorsku varijablu pohranjen dvodimenzionalni
vektor.

(2) None
Označava da vektorsku varijablu nije pohranjeno ništa.

Prikaz zaslona s popisom vektorskih varijabli

Ovisno o trenutačno prikazanom zaslonu obavite jedan od postupaka u
nastavku.
• Dok je prikazan zaslon za računanje s vektorima:

Pritisnite .
• Dok su prikazani vektorski uređivač ili zaslon VctAns:

Pritisnite , odaberite [Define Vector], a zatim pritisnite .

Pohrana novih podataka u vektorsku varijablu

Primjer 2.: pohrana trodimenzionalnog vektora (1, 2, 3)
1. Dok je prikazan zaslon za računanje s vektorima, pritisnite  za prikaz

zaslona s popisom vektorskih varijabli.
2. Odaberite vektorsku varijablu (VctA, VctB, VctC ili VctD) u koju želite

pohraniti nove podatke, a zatim pritisnite .
• Ako ste odabrali vektorsku varijablu čiji je status „None”, idite na

korak 4. ovog postupka.
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• Ako ste odabrali vektorsku varijablu u koju je već pohranjen vektor,
prikazat će se zaslon s izbornikom. Idite na korak 3.

3. Odaberite [Define New], a zatim pritisnite .
4. Na zaslonu „Vector Dimension?” koji se pojavio odredite dimenziju

vektora.

• Kako biste odredili tri dimenzije, obavite korake u nastavku.
(1) Odaberite [Dimensions] a zatim pritisnite .
(2) U izborniku koji će se pojaviti odaberite [3 Dimensions] i potom

pritisnite .
5. Nakon što postavite željene specifikacije dimenzija, odaberite [Confirm] i

potom pritisnite .
• Prikazat će se vektorski uređivač.

6. Unesite elemente vektorske varijable.

1 2 3

7. Pritisnite ,  ili  za povratak na zaslon za računanje s vektorima.

Napomena

• Sadržaj vektorskih varijabli zadržava se čak i ako pritisnete , promijenite aplikaciju
kalkulatora ili isključite kalkulator. Ako provedete bilo koji od sljedećih postupaka,
očistit će se cjelokupan sadržaj vektorskih varijabli:
-  – [Reset] > [Settings & Data]
-  – [Reset] > [Initialize All].

Uređivanje podataka vektorskih varijabli

1. Dok je prikazan zaslon za računanje s vektorima, pritisnite  za prikaz
zaslona s popisom vektorskih varijabli.
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2. Odaberite vektorsku varijablu (VctA, VctB, VctC ili VctD) koju želite
urediti, a zatim pritisnite .

3. U izborniku koji će se pojaviti odaberite [Edit] i potom pritisnite .
• Prikazat će se vektorski uređivač.

4. S pomoću vektorskog uređivača uredite elemente vektora.
• Pomaknite pokazivač na ćeliju koja sadržava element koji želite

izmijeniti, unesite novu vrijednost, a zatim pritisnite .
5. Pritisnite ,  ili  za povratak na zaslon za računanje s vektorima.

Kopiranje sadržaja vektorske varijable (ili memorije VctAns)

1. Idite na zaslon vektorskog uređivača ili zaslon VctAns s vektorskom
varijablom koju želite kopirati.
• Za prikaz vektorskog uređivača obavite korak 1., 2. i 3. iz odjeljka

„Uređivanje podataka vektorskih varijabli” (stranica 127).
• Za prikaz zaslona memorije VctAns obavite korake u nastavku dok je

prikazan zaslon za računanje s vektorima.
 – [Vector] > [VctAns] 

2. Odaberite odredište za kopiranje vektorske varijable.
• Primjerice, kako biste je kopirali u VctD, idite na:  – [Store] > [VctD].
• Prikazat će se vektorski uređivač sa sadržajem odredišne varijable.

3. Pritisnite ,  ili  za povratak na zaslon za računanje s vektorima.

Vektorska pozitivna memorija (VctAns)
U slučaju da je rezultat izračuna obavljenog u aplikaciji Vector vektor,
pojavit će se zaslon memorije VctAns s rezultatom. Rezultat će također biti
pohranjen u varijablu pod nazivom „VctAns”.

Varijabla VctAns može se upotrebljavati u izračunima kako je opisano u
nastavku.
• Kako biste unijeli varijablu VctAns u izračun, idite na:  – [Vector] >

[VctAns].
• Ako pritisnete bilo koju od sljedećih tipki dok je prikazan zaslon

memorije VctAns, automatski će se pojaviti zaslon za računanje s
vektorima s oznakom „VctAns”, nakon koje slijedi računska operacija ili
funkcija tipke koju ste pritisnuli: , , , , , , , ( ),

( ).

Napomena

• Sadržaj memorije VctAns zadržava se čak i ako pritisnete  ili isključite kalkulator.
Ako učinite bilo što od sljedećeg, očistit će se sadržaj memorije VctAns:
- ako se vratite na zaslon HOME i pokrenete neku drugu aplikaciju kalkulatora
- ako odete na  – [Reset] > [Settings & Data]
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- ako odete na  – [Reset] > [Initialize All].

Primjeri vektorskih računa
U primjerima u nastavku VctA = (1, 2), VctB = (3, 4) i VctC = (2, -1, 2).

Primjer 3.: VctA • VctB (skalarni umnožak vektora)

 – [Vector] > [VctA]
 – [Vector] > [Vector Calc] > [Dot Product]

 – [Vector] > [VctB]

Napomena

• Pri računanju skalarnog umnoška dvaju vektora vektori trebaju biti istih dimenzija.

Primjer 4.: VctA × VctB (vektorski umnožak vektora)

 – [Vector] > [VctA]
 – [Vector] > [Vector Calc] > [Cross Product]

 – [Vector] > [VctB]

Napomena

• Pri računanju vektorskog umnoška dvaju vektora vektori trebaju biti istih dimenzija.

Primjer 5.: određivanje kuta koji tvore VctA i VctB do tri decimalnih
mjesta. (Number Format: Fix 3, Angle Unit: Degree)

 – [Vector] > [Vector Calc] > [Angle]
 – [Vector] > [VctA]

(,)  – [Vector] > [VctB]

Napomena

• Pri računanju kuta koji tvore dva vektora vektori trebaju biti istih dimenzija.

Primjer 6.: normalizacija vektora VctB

129

Copyrig
ht E

uro
co

m
 d.o

.o
.



 – [Vector] > [Vector Calc] > [Unit Vector]
 – [Vector] > [VctB]

Primjer 7.: dobivanje apsolutne vrijednosti vektora VctC

 – [Numeric Calc] > [Absolute Value]
 – [Vector] > [VctC]

Računanje omjera
Aplikacija Ratio omogućuje vam određivanje vrijednosti X u izrazu omjera
A : B = X : D (ili A : B = C : X) ako su vrijednosti A, B, C i D poznate.

Opći postupak za računanje omjera
Primjer 1.: rješavanje izraza 3 : 8 = X : 12 za X
1. Pritisnite , odaberite ikonu aplikacije Ratio, a zatim pritisnite .
2. U izborniku koji se pojavio odaberite [A:B=X:D] ili [A:B=C:X].

• U ovom slučaju želimo pronaći rješenje izraza 3 : 8 = X : 12 za X,
stoga odaberite [A:B=X:D], a zatim pritisnite .

3. U uređivač koeficijenata koji se pojavio unesite vrijednosti koeficijenata.
• U ovom primjeru unesite sljedeće koeficijente: A = 3, B = 8, D = 12.

3 8 12

4. Nakon što postavite sve željene vrijednosti, pritisnite .
• Time će se prikazati rješenje (vrijednost X).

• Pritisnite ,  ili  za povratak u uređivač koeficijenata.

Napomena

• U slučaju da provodite izračun u okviru kojeg je vrijednost nekog koeficijenta 0, doći će
do greške (Math ERROR).
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• Obavljanjem koraka u nastavku svi će se koeficijenti u uređivaču koeficijenata
ponovno postaviti na 1:
– Dok je prikazan uređivač koeficijenata, pritisnite , ,  ili .
– Dok je prikazano rješenje, pritisnite  ili .

• Možete pohraniti trenutačno prikazani rezultat izračuna u varijablu. Primjerice, ako
provedete sljedeći postupak dok je prikazan zaslon iz koraka 4., rezultat izračuna
pohranit će se u varijablu A:  – [A=] > [Store]. Za pojedinosti o varijablama
pogledajte odjeljak „Varijable (A, B, C, D, E, F, x, y, z)” (stranica 37).

Promjena vrste izraza omjera

1. Dok je prikazan uređivač koeficijenata, pritisnite .
2. U izborniku koji se pojavio odaberite željenu vrstu izraza omjera.

Primjer izračuna
Primjer 2.: izračun varijable X u omjeru 1 : 2 = X : 10

 – [Ratio] > [A:B=X:D]
1 2 10

Uporaba aplikacije Math Box
Aplikacija Math Box sadržava sljedeće funkcije za podršku učenju:
Dice Roll: Dice Roll funkcija je koja služi za simulaciju vjerojatnosti pri
bacanju kocke.
Coin Toss: Coin Toss funkcija je koja služi za simulaciju vjerojatnosti pri
bacanju novčića.

Dice Roll
Dice Roll služi za provedbu simulacije bacanja jedne, dviju ili triju virtualnih
kocki određeni broj puta. Za prikaz rezultata možete odabrati bilo koji od
zaslona prikazanih u nastavku.

131

Copyrig
ht E

uro
co

m
 d.o

.o
.



Zaslon List

Zaslon Relative Freq

Opći postupak za uporabu aplikacije Dice Roll

Primjer: simulacija 100 bacanja dviju kocki. U ovom primjeru za prikaz
rezultata simulacije upotrijebljen je zaslon Relative Freq, na kojem je
prikazan broj pojavljivanja (frekvencija) i relativna frekvencija brojčane
razlike (0, 1, 2, 3, 4, 5) između dviju kocki pri svakom bacanju.

1. Pritisnite , odaberite ikonu aplikacije Math Box, a zatim pritisnite .
• Prikazat će se izbornik Math Box.

2. Odaberite [Dice Roll], a zatim pritisnite .
• Prikazat će se zaslon za unos parametara.

Dice: odaberite jednu, dvije ili tri kocke.
Attempts: unesite broj bacanja kocke (broj pokušaja) kao vrijednost od 1
do 250.
Same Result: ova je postavka u pravilu isključena (Off) (zadana
postavka). Za pojedinosti pogledajte odjeljak „Postavka Same Result”
(stranica 135).

3. Odaberite svaku stavku izbornika i konfigurirajte je na željeni način.
(1) Odaberite [Dice], a zatim pritisnite . U izborniku koji će se pojaviti

odaberite [2 Dice] i potom pritisnite .
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(2) Odaberite [Attempts], a zatim pritisnite . Na zaslonu za unos koji
će se pojaviti unesite 100 i potom pritisnite . Odaberite [Confirm],
a zatim pritisnite .

(3) Ostavite postavku [Same Result] isključenom (Off) (zadana
postavka).

4. Nakon što konfigurirate sve postavke na željeni način, odaberite
[Execute] i potom pritisnite .
• Pojavit će se zaslon na kojem je prikazana provedena simulacija i

nakon toga pojavit će se izbornik Result Type.

List: služi za prikaz popisa ishoda svakog bacanja (pokušaja).*1

Relative Freq: služi za prikaz broja pojavljivanja na temelju rezultata
bacanja*2 i njihovu relativnu frekvenciju.
*1 Ako postoje dvije kocke, ishod svakog bacanja prikazuje se zajedno

sa zbrojem i razlikom svakog bacanja. Ako postoje tri kocke, ishod
svakog bacanja prikazuje se zajedno sa zbrojem bacanja.

*2 Ishod (od 1 do 6) u slučaju jedne kocke, zbroj (od 2 do 12) ili razlika
(od 0 do 5) ishoda u slučaju dviju kocki i zbroj (od 3 do 18) ishoda u
slučaju triju kocki.

5. S pomoću izbornika Result Type odaberite oblik prikaza rezultata.
(1) U ovom slučaju želimo prikazati broj pojavljivanja i relativnu

frekvenciju, stoga odaberite [Relative Freq] i potom pritisnite .
• Prikazat će se izbornik za odabir opcije [Sum] ili [Difference].

(2) U ovom slučaju želimo prikazati razliku ishoda svakog bacanja,
stoga odaberite [Difference] i potom pritisnite .

• Na zaslonu Relative Freq prikazat će se rezultat simulacije.

(Rezultat se razlikuje pri svakom izvršenju.)

• Za pojedinosti o zaslonu s rezultatom simulacije pogledajte
odjeljak „Zaslon s rezultatima značajke Dice Roll” (stranica
134).

6. Za prikaz rezultata u nekom drugom obliku omogućite prikaz rezultata, a
zatim pritisnite .
• Vratit ćete se u izbornik Result Type, stoga možete ponoviti korak 5.

ovog postupka i promijeniti oblik prikaza rezultata.
7. Ako želite provesti simulaciju s nekim drugim postavkama, pritisnite 

dok je prikazan izbornik Result Type.
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• Očistit će se rezultat simulacije i vratit ćete se na zaslon za unos
parametara. Ponovno obavite postupak iz koraka 3.

8. Za izlaz iz značajke Dice Roll pritisnite  dok je prikazan zaslon za
unos parametara.
• Vratit ćete se u izbornik Math Box.

Napomena

• Na zaslonu Relative Freq možete pohraniti vrijednost u ćeliji u stupcu Rel Fr u
neku varijablu. Primjerice, ako provedete sljedeći postupak u prethodno navedenom
koraku 5., vrijednost u prvom retku stupca „Rel Fr” pohranit će se u varijablu A:  –
[A=] > [Store]. Za pojedinosti o varijablama pogledajte odjeljak „Varijable (A, B, C, D,
E, F, x, y, z)” (stranica 37).

Zaslon s rezultatima značajke Dice Roll

• Zaslon List

(1) Svaki redak predstavlja bacanja po redu. Primjerice, 1 predstavlja
prvo bacanje, 2 predstavlja drugo bacanje itd.

(2) A, B i C označavaju korištenu kocku. „Sum” predstavlja ukupni ishod,
a „Diff” predstavlja razliku ishoda dviju kocki. Stupci koji će se pojaviti
na zaslonu ovise o broju korištenih kocki.
1 kocka: samo stupac A.
2 kocke: stupci A, B, Sum i Diff.
3 kocke: stupci A, B, C i Sum.

• Zaslon Relative Freq
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(1) Sum ili Diff: služi za prikaz ishoda jedne kocke (Sum: od 1 do 6),
zbroja ishoda dviju kocki (Sum: od 2 do 12) ili razlike dviju kocki (Diff:
od 0 do 5) ili zbroja ishoda triju kocki (Sum: od 3 do 18).

(2) Freq: služi za prikaz broja pojavljivanja (frekvenciju) svakog ishoda
bacanja.

(3) Rel Fr: služi za prikaz relativne frekvencije (frekvencije podijeljene s
brojem bacanja) rezultata bacanja.

(4) Broj pokušaja
(5) Označena vrijednost ćelije u stupcu Rel Fr

Postavka Same Result

Ako provedete simulaciju s pomoću značajki Dice Roll ili Coin Toss dok je
postavka Same Result isključena (Off) (zadana postavka), nakon svakog
izvršenja prikazat će se različit (nasumičan) rezultat. Ako je postavka
Same Result izmijenjena i nije isključena (Off), prikazani se rezultati
određuju kalkulatorom. Postavke #1, #2 ili #3 korisne su ako želite da
se na svim kalkulatorima koje upotrebljavaju učenici u razredu prikaže isti
rezultat.

Napomena

• Kako bi se na većem broju kalkulatora prikazao isti rezultat, pobrinite se da su
sljedeće postavke iste na svim kalkulatorima:
– broj kocki ili novčića
– broj pokušaja (bacanja kocki ili novčića)
– postavka Same Result (#1, #2 ili #3).

Coin Toss
Coin Toss služi za provedbu simulacije bacanja jednog, dvaju ili triju
virtualnih novčića određeni broj puta. Za prikaz rezultata možete odabrati
bilo koji od zaslona prikazanih u nastavku.

Zaslon List
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Zaslon Relative Freq

Na zaslonu je glava prikazana kao , a pismo kao .

Opći postupak za uporabu aplikacije Coin Toss

Primjer: simulacija 100 bacanja triju novčića. U ovom primjeru zaslon
Relative Freq služi za prikaz rezultata simulacije te se na njemu nalazi broj
glava (0, 1, 2, 3) i relativna frekvencija glava pri svakom bacanju.

1. Pritisnite , odaberite ikonu aplikacije Math Box, a zatim pritisnite .
• Prikazat će se izbornik Math Box.

2. Odaberite [Coin Toss], a zatim pritisnite .
• Prikazat će se zaslon za unos parametara.

Coins: odaberite jedan, dva ili tri novčića.
Attempts: unesite broj bacanja novčića (broj pokušaja) kao vrijednost od
1 do 250.
Same Result: ova je postavka u pravilu isključena (Off) (zadana
postavka). Za pojedinosti pogledajte odjeljak „Postavka Same Result”
(stranica 135).

3. Odaberite svaku stavku izbornika i konfigurirajte je na željeni način.
(1) Odaberite [Coins], a zatim pritisnite . U izborniku koji će se pojaviti

odaberite [3 Coins] i potom pritisnite .
(2) Odaberite [Attempts], a zatim pritisnite . Na zaslonu za unos koji

će se pojaviti unesite 100 i potom pritisnite . Odaberite [Confirm],
a zatim pritisnite .

(3) Ostavite postavku [Same Result] isključenom (Off) (zadana
postavka).

4. Nakon što konfigurirate sve postavke na željeni način, odaberite
[Execute] i potom pritisnite .
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• Pojavit će se zaslon na kojem je prikazana provedena simulacija i
nakon toga pojavit će se izbornik Result Type.

List: služi za prikaz popisa glava ili pisma*1 za svako bacanje (pokušaj).
Relative Freq: služi za prikaz broja pojavljivanja za svako bacanje
novčića čiji je rezultat glava*2 i njihovu relativnu frekvenciju.
*1 U slučaju dvaju ili triju novčića, zaslon služi za prikaz broja novčića pri

svakom bacanju čiji je rezultat glava.
*2 Za dva ili tri novčića. U slučaju jednog novčića zaslon služi za prikaz

frekvencije glava i pisma te njihove relativne frekvencije.
5. S pomoću izbornika Result Type odaberite oblik prikaza rezultata.

U ovom slučaju želimo prikazati broj pojavljivanja i relativnu frekvenciju,
stoga odaberite [Relative Freq] i potom pritisnite .
• Rezultat simulacije prikazan je na zaslonu Relative Freq.

(Rezultat se razlikuje pri svakom izvršenju.)

• Za pojedinosti o zaslonu s rezultatom simulacije pogledajte odjeljak
„Zaslon s rezultatima značajke Coin Toss” (stranica 138).

6. Za prikaz rezultata u nekom drugom obliku omogućite prikaz rezultata, a
zatim pritisnite .
• Vratit ćete se u izbornik Result Type, stoga možete ponoviti korak 5.

ovog postupka i promijeniti oblik prikaza rezultata.
7. Ako želite provesti simulaciju s nekim drugim postavkama, pritisnite 

dok je prikazan izbornik Result Type.
• Očistit će se rezultat simulacije i vratit ćete se na zaslon za unos

parametara. Ponovno obavite postupak iz koraka 3.
8. Za izlaz iz značajke Coin Toss pritisnite  dok je prikazan zaslon za

unos parametara.
• Vratit ćete se u izbornik Math Box.

Napomena

• Na zaslonu Relative Freq možete pohraniti vrijednost u ćeliji u stupcu Rel Fr u
neku varijablu. Primjerice, ako provedete sljedeći postupak u prethodno navedenom
koraku 5., vrijednost u prvom retku stupca „Rel Fr” pohranit će se u varijablu A:  –
[A=] > [Store].
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Zaslon s rezultatima značajke Coin Toss

• Zaslon List

(1) Svaki redak predstavlja bacanja po redu. Primjerice, 1 predstavlja
prvo bacanje, 2 predstavlja drugo bacanje itd.

(2) A, B i C označavaju korišteni novčić. Ako upotrebljavate dva ili tri
novčića, u stupcu  zdesna prikazuje se broj bacanja novčića čiji je
rezultat glava.

• Zaslon Relative Freq

(1) Side: ako upotrebljavate samo jedan novčić, „ ” označava glavu,
dok „ ” označava pismo. Ako upotrebljavate dva ili tri novčića, u
tom je stupcu prikazan broj glava (od 0 do 3).

(2) Freq: služi za prikaz broja pojavljivanja (frekvencije) svakog ishoda
bacanja.

(3) Rel Fr: služi za prikaz relativne frekvencije (frekvencije podijeljene s
brojem bacanja) rezultata bacanja.

(4) Broj pokušaja
(5) Označena vrijednost ćelije u stupcu Rel Fr
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Tehničke informacije

Greške
Na kalkulatoru će se prikazati poruku greške svaki put kada tijekom
izračuna dođe do greške iz bilo kojeg razloga.

Prikaz lokacije greške
Ako pritisnete ,  ili  dok je prikazana poruka greške, vratit ćete
se na zaslon koji je bio prikazan neposredno prije nego što se pojavila
poruka greške. Pokazivač će se nalaziti na mjestu gdje je došlo do greške
i biti spreman za unos. Provedite potrebne izmjene izračuna i ponovno ga
izvršite.

Primjer: umjesto 14 ÷ 10 × 2 slučajno ste unijeli 14 ÷ 0 × 2.

14 0 2

(ili ili )

1

Poruke greške

Syntax ERROR

Uzrok:
• Postoji problem s oblikom izračuna koji obavljate.

Korektivna mjera:
• Provedite potrebne izmjene.

Math ERROR

Uzrok:
• Srednji ili konačni rezultat izračuna koji obavljate premašuje

dozvoljeni raspon izračuna.
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• Unos premašuje dozvoljeni raspon unosa (posebice pri uporabi
funkcija).

• Izračun koji obavljate sadržava nedopuštenu matematičku operaciju
(npr. dijeljenje nulom).

• Pri uporabi aplikacije koja ne podržava kompleksne brojeve ili dok
je prikazan zaslon koji ne podržava unos kompleksnih brojeva
pokušali ste izvršiti izračun koji sadržava varijablu u koju je pohranjen
kompleksni broj.

Korektivna mjera:
• Provjerite vrijednosti unosa, smanjite broj znamenki i pokušajte

ponovo.
• Ako upotrebljavate varijablu kao argument funkcije, provjerite je li

vrijednost varijable unutar dopuštenog raspona za funkciju.
• Kako biste izvršili izračun koji sadržava varijablu u koju je pohranjen

kompleksni broj dok upotrebljavate aplikaciju koja ne podržava
kompleksne brojeve ili dok je prikazan zaslon koji ne podržava unos
kompleksnih brojeva, promijenite vrijednost pohranjenu u varijabli u
realan broj.

Stack ERROR

Uzrok:
• Izračun koji obavljate je doveo do premašivanja kapaciteta brojčanog

stoga ili stoga naredbe.
• Izračun koji obavljate je doveo do premašivanja kapaciteta stoga

matrice ili vektora.
Korektivna mjera:
• Pojednostavite izraz izračuna tako da ne premašuje kapacitet stoga.
• Pokušajte podijeliti izračun na dva ili više dijelova.

Argument ERROR

Uzrok:
• Postoji problem s argumentom izračuna koji obavljate.

Korektivna mjera:
• Provedite potrebne izmjene.

Dimension ERROR (samo u aplikacijama Matrix i Vector)

Uzrok:
• Pokušavate obaviti izračun s matricama ili vektorima čije dimenzije ne

dozvoljavaju tu vrstu izračuna.
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Korektivna mjera:
• Provjerite jesu li dimenzije matrica i vektora kompatibilne za tu vrstu

računa.

Variable ERROR (samo u okviru značajke Solver u aplikaciji
Equation)

Uzrok:
• Pokušali ste izvršiti značajku Solver za unos izraza bez uključene

varijable.
Korektivna mjera:
• Unesite izraz koji sadržava varijablu.

Cannot Solve (samo u okviru značajke Solver u aplikaciji
Equation)

Uzrok:
• Kalkulator nije mogao pronaći rješenje.

Korektivna mjera:
• Provjerite ima li grešaka u jednadžbi koju ste unijeli.
• Unesite vrijednost za varijablu rješenja koja je blizu očekivanom

rješenju i pokušajte ponovo.

Range ERROR

Uzrok (aplikacija Table):
• Pokušali ste generirati brojevnu tablicu u aplikaciji Table čiji uvjeti

dovode do premašivanja maksimalnog broja dozvoljenih redaka.
Korektivna mjera:
• Smanjite dimenziju tablice promjenom početne i konačne veličine te

veličine koraka (Start, End i Step) te pokušajte ponovno.
Uzrok (aplikacija Spreadsheet):
• Tijekom višestrukog unosa u aplikaciji Spreadsheet unos za raspon

(Range) nalazi se izvan dozvoljenog raspona ili odgovara nazivu ćelije
koja ne postoji.

Korektivna mjera:
• Za raspon (Range) unesite naziv ćelije koja je unutar raspona od A1

do E45 s pomoću sljedeće sintakse: „A1:A1”.
Uzrok (aplikacija Math Box):
• Unos vrijednosti za Attempts (broj pokušaja) za značajku Dice Roll ili

Coin Toss nalazi se izvan dopuštenog raspona ili je vrijednost koja
nije prirodni broj.
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Korektivna mjera:
• Za Attempts unesite prirodni broj unutar dopuštenog raspona.

Time Out

Uzrok (izračun diferencijacije ili integracije):
• Trenutačni izračun integracije ili diferencijacije završava bez

ispunjavanja završnog uvjeta.
Korektivna mjera:
• Pokušajte povećati vrijednost tol. Imajte na umu da se time također

smanjuje preciznost rješenja.
Uzrok (aplikacija Distribution):
• Trenutačni izračun distribucije završava bez ispunjavanja završnog

uvjeta.
Korektivna mjera:
• Promijenite vrijednost svakog parametra.

Circular ERROR

Uzrok (značajka f(x) i g(x)):
• U registriranoj kompoziciji funkcija dolazi do kružne reference

(„Registracija kompozicije funkcija” (stranica 63)).
Korektivna mjera:
• Nemojte istodobno unositi g(x) u f(x) i f(x) u g(x).

Uzrok (aplikacija Spreadsheet):
• U proračunskoj tablici postoji kružna referenca (npr. „=A1” u ćeliji A1).

Korektivna mjera:
• Izmijenite sadržaj ćelije kako biste uklonili kružne reference.

Memory ERROR (samo u aplikaciji Spreadsheet)　

Uzrok:
• Pokušavate unijeti podatke koji premašuju dopušteni kapacitet unosa

(1700 bajta).
• Pokušavate unijeti podatke koji dovode do lanca konsekutivnih

referentnih ćelija (npr. u ćeliji A1 postoji referenca na ćeliju A2, u ćeliji
A2 postoji referenca na ćeliju A3... itd.). Ova vrsta unosa uvijek dovodi
do pojave ove pogreške, čak i ako kapacitet memorije (1700 bajta)
nije premašen.

Korektivna mjera:
• Izbrišite nepotrebne podatke i ponovo unesite podatke.
• Smanjite unos koji dovodi do lanca konsekutivnih referentnih ćelija.
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Not Defined

Uzrok (značajka f(x) i g(x)):
• Pokušali ste izračunati f(x) ili g(x) s nedefiniranom funkcijom f(x)/g(x).

Korektivna mjera:
• Definirajte f(x) ili g(x) prije računanja funkcije f(x)/g(x).

Uzrok (u aplikacijama Matrix i Vector):
• Matrica ili vektor koji pokušavate upotrijebiti u izračunu je unesen bez

navođenja dimenzije.
Korektivna mjera:
• Odredite dimenziju matrice ili vektora, a zatim ponovite izračun.

Prije nego što pretpostavite da je
došlo do kvara kalkulatora...
Napominjemo da biste trebali izraditi odvojene kopije važnih podataka
prije obavljanja ovih koraka.
1. Provjerite izraz izračuna kako biste potvrdili da ne sadržava greške.
2. Pobrinite se da upotrebljavate odgovarajuću aplikaciju kalkulatora za

vrstu izračuna koju pokušavate obaviti.
• Kako biste provjerili koju aplikaciju kalkulatora trenutačno

upotrebljavate, pritisnite . Tipka služi za označavanje ikone
trenutačno korištene aplikacije kalkulatora.

3. Ako s pomoću prethodnih koraka ne riješite problem, pritisnite tipku .
• Na kalkulatoru će se obaviti postupak kojim se provjerava rade li

funkcije izračuna pravilno. Ako se na kalkulatoru utvrdi bilo kakva
nepravilnost, aplikacija kalkulatora automatski će se pokrenuti i
izbrisat će se sadržaj memorije.

4. Vratite postavke kalkulatora (osim za Contrast i Auto Power Off) na
zadane postavke na sljedeći način.
(1) Pritisnite , odaberite ikonu aplikacije kalkulatora, a zatim pritisnite

.
(2) Pritisnite , a zatim odaberite [Reset] > [Settings & Data] > [Yes].

Zamjena baterije
Ako se zaslon prikazan u nastavku pojavi odmah po uključivanju
kalkulatora, razina je baterije niska.
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Prazna baterija dovodi i do zatamnjenog zaslona, čak i ako prilagodite
kontrast, ili nemogućnosti pojave brojeva na zaslonu neposredno nakon
što upalite kalkulator.
Ako dođe do toga ili se pojavi prethodno prikazani zaslon, zamijenite
bateriju novom.

Važno!

• Ako izvadite bateriju, izbrisat će se cjelokupni sadržaj memorije kalkulatora.

1. Pritisnite (OFF) kako biste isključili kalkulator.
• Kako ne biste slučajno uključili kalkulator pri zamjeni baterije,

pričvrstite prednji poklopac za prednju stranu kalkulatora.
2. Kako je prikazano na slici, uklonite poklopac baterije i uklonite bateriju,

a zatim postavite novu bateriju tako da znak plus (+) i znak minus (−)
budu pravilno okrenuti.

3. Zamijenite poklopac baterije.
4. Pritisnite tipku  kako biste uključili kalkulator.
5. Pokrenite kalkulator.

(1) Pritisnite , odaberite ikonu aplikacije kalkulatora, a zatim pritisnite
.

(2) Pritisnite , a zatim odaberite [Reset] > [Initialize All] > [Yes].
• Nemojte preskakati prethodno navedene korake!
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Redoslijed operacija
Izračuni na kalkulatoru obavljaju se prema redoslijedu operacija.

• Izračuni se u pravilu obavljaju slijeva nadesno.
• Izrazi sa zagradama imaju najviši prioritet.
• U nastavku je prikazan redoslijed operacija za svaku naredbu.

1 Izrazi u zagradama

2
Funkcije koje sadržavaju zagrade (sin(, log(, f(, g( itd.,
funkcije čiji je argument na desnoj strani te funkcije koje
zahtijevaju desnu zagradu nakon unosa argumenta)

3
Funkcije koje dolaze nakon unesene vrijednosti (x2, x3, x-1, x!,
°’ ”, °, r, g, %, t), tehnički simboli (m, μ, n, p, f, k, M, G, T, P,
E), potencije ( ), korijeni ( )

4 Razlomci

5
Negativni predznak ((-)), Base Prefix (simboli brojevnih
sustava) (d, h, b, o)

6
Naredbe za pretvorbu jedinica (cm in itd.), procjene
vrijednosti u aplikaciji Statistics (x̂, ŷ, x̂1, x̂2)

7 Množenje kada je znak množenja izostavljen

8
Permutacija (nPr), kombinacija (nCr), simbol polarne
koordinate kompleksnog broja (∠)

9 Skalarno množenje (•)

10 Množenje (×), dijeljenje (÷)

11 Zbrajanje (+), oduzimanje (−)

12 and (logički operator)

13 or, xor, xnor (logički operatori)

Ako izračun sadržava negativnu vrijednost, možda ćete trebati uvrstiti
negativnu vrijednost u zagradu. Primjerice, ako želite kvadrirati vrijednost
-2, trebat ćete unijeti: (-2)2. Razlog tomu je što je x2 funkcija kojoj prethodi
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vrijednost (3. prioritet, kako je prethodno navedeno) višeg prioriteta od
negativnog predznaka (5. prioritet).

Primjer:
((-))2     -22 = -4

((-))2  (-2)2 = 4

Raspon izračuna, broj znamenki i
preciznost
Raspon izračuna, broj znamenki korištenih za interni izračun i preciznost
izračuna ovise o vrsti izračuna koji obavljate.

Raspon i preciznost izračuna

Raspon izračuna ±1 × 10-99 do ±9,999999999 × 1099 ili 0

Broj znamenki za interne
izračune

23 znamenki

Preciznost

U pravilu, ±1 na 10-u znamenku za jedan
izračun. Preciznost za eksponencijalni
prikaz je ±1 na najmanje značajnoj
znamenki. Greške su kumulativne u
slučaju kumulativnih izračuna.

Raspon unosa funkcijskih argumenata i preciznost

Funkcije Raspon unosa

sinx
cosx

Stupnjevi
(Degree)

0 ≤ |x| < 9 × 109

Radijani (Radian) 0 ≤ |x| < 157079632,7

Gradi (Gradian) 0 ≤ |x| < 1 × 1010
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tanx

Stupnjevi
(Degree)

Isto kao sinx, osim ako je |x|
= (2n - 1) × 90.

Radijani (Radian)
Isto kao sinx, osim ako je |x|
= (2n - 1) × π/2.

Gradi (Gradian)
Isto kao sinx, osim ako je |x|
= (2n - 1) × 100.

sin-1x, cos-1x 0 ≤ |x| ≤ 1

tan-1x 0 ≤ |x| ≤ 9,999999999 × 1099

sinhx, coshx 0 ≤ |x| ≤ 230,2585092

sinh-1x 0 ≤ |x| ≤ 4,999999999 × 1099

cosh-1x 1 ≤ x ≤ 4,999999999 × 1099

tanhx 0 ≤ |x| ≤ 9,999999999 × 1099

tanh-1x 0 ≤ |x| ≤ 9,999999999 × 10-1

logx, lnx 0 < x ≤ 9,999999999 × 1099

10x -9,999999999 × 1099 ≤ x ≤ 99,99999999

√x 0 ≤ x < 1 × 10100

x2 |x| < 1 × 1050

x-1 |x| < 1 × 10100; x ≠ 0

x! 0 ≤ x ≤ 69 (x je cijeli broj)

nPr
0 ≤ n < 1 × 1010, 0 ≤ r ≤ n (n i r cijeli su brojevi)
1 ≤ {n!/(n - r)!} < 1 × 10100

nCr
0 ≤ n < 1 × 1010, 0 ≤ r ≤ n (n i r cijeli su brojevi)
1 ≤ n!/r! < 1 × 10100 ili 1 ≤ n!/(n - r)! < 1 × 10100

Pol(x, y)
|x|, |y| ≤ 9,999999999 × 1099

√x2 + y2 ≤ 9,999999999 × 1099

Rec(r, θ)
0 ≤ r ≤ 9,999999999 × 1099

θ: Isto kao sinx
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a°b’c”
|a|, b, c < 1 × 10100; 0 ≤ b, c
Vrijednost prikazanih sekundi podložna je greški
od ±1 na drugom decimalnom mjestu.

a°b’c” = x

0°0’0” ≤ |x| ≤ 9999999°59’59”
Seksagezimalna vrijednost izvan prethodno
navedenog raspona automatski se smatra
decimalnom vrijednošću.

xy

x > 0: -1 × 10100 < ylogx < 100
x = 0: y > 0

x < 0: y = n, m
2n + 1 (m i n cijeli su brojevi)

Međutim: -1 × 10100 < ylog |x| < 100

x
√y

y > 0: x ≠ 0, -1 × 10100 < 1/x logy < 100
y = 0: x > 0

y < 0: x = 2n + 1, 2n + 1
　 m　

 (m ≠ 0; m i n cijeli su

brojevi)
Međutim: -1 × 10100 < 1/x log |y| < 100

a b/c
Cijeli broj, brojnik i nazivnik zajedno moraju
imati 10 ili manje znamenki (uključujući simbol
razdjelnika).

RanInt#(a, b) a < b; |a|, |b| < 1 × 1010; b - a < 1 × 1010

• Preciznost je u osnovi ista kao preciznost opisana u odjeljku „Raspon i
preciznost izračuna”.

• Funkcije tipa xy, 
x
√y, x!, nPr, nCr zahtijevaju ulančano računanje koje

može dovesti do gomilanja grešaka pri svakom izračunu.
• Greška je kumulativna i obično je velika u blizini singularne točke i točke

infleksije funkcije.
• Raspon za rezultate izračuna koji se mogu prikazati u obliku π ako je

za Input/Output u izborniku SETTINGS odabrana opcija MathI/MathO
jest |x| < 106. Međutim, imajte na umu da greška pri obavljanju internog
izračuna može onemogućiti prikaz nekih rezultata izračuna u obliku π.
Također može dovesti do toga da se rezultati izračuna koji trebaju biti u
decimalnom obliku prikažu u obliku π.
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Specifikacije

fx-570CW
Zahtjevi napajanja:
Baterija veličine AAA R03 × 1

Približni vijek trajanja baterije:
2 godine (na temelju jednosatnog rada dnevno)

Potrošnja energije:
0,0008 W

Radna temperatura:
0 °C do 40 °C

Dimenzije:
13,8 (V) × 77 (Š) × 162 (D) mm

Približna težina:
100 g, uključujući bateriju

fx-991CW
Zahtjevi napajanja:
ugrađena solarna ćelija; dugmasta baterija LR44 × 1

Približni vijek trajanja baterije:
2 godine (na temelju jednosatnog rada dnevno)

Radna temperatura:
0 °C do 40 °C

Dimenzije:
10,7 (V) × 77 (Š) × 162 (D) mm

Približna težina:
95 g, uključujući bateriju
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Česta pitanja

Česta pitanja
■ Kako mogu promijeniti rezultat iz razlomka koji je rezultat dijeljenja

u decimalni oblik?
→ Dok je prikazan rezultat izračuna razlomka, pritisnite , a zatim

odaberite [Decimal] ili pritisnite ( ). Kako bi se rezultati izračuna
početno prikazali u decimalnim vrijednostima, promijenite postavku
Input/Output u izborniku SETTINGS na MathI/DecimalO.

■ Koja je razlika između memorije Ans memorije i memorije varijabli?
→ Obje vrste memorija djeluju kao „spremnici” za privremenu pohranu

jedne vrijednosti.
Pozitivna memorija: pohranjuje rezultat posljednjeg obavljenog
izračuna. Tu memoriju upotrijebite za prijenos rezultata jednog izračuna
u sljedeći.
Varijable: ta je memorija korisna kada trebate upotrijebiti istu vrijednost
više puta u jednom ili više izračuna.

■ Kako na ovom kalkulatoru mogu pronaći funkciju koju sam
upotrebljavao/upotrebljavala na starijem modelu kalkulatora
CASIO?

→ Funkcijama kalkulatora možete pristupiti iz izbornika CATALOG koji se
pojavi kada pritisnete . Za pojedinosti pogledajte sljedeće odjeljke:
„Uporaba izbornika CATALOG” (stranica 26)
„Napredni izračuni” (stranica 47).

■ Na starijem modelu kalkulatora CASIO pritisnuo/pritisnula bih 
za promjenu oblika prikaza rezultata izračuna. Kako to mogu učiniti
na ovom kalkulatoru?

→ Dok je prikazan rezultat izračuna, pritisnite . S pomoću izbornika
koji se pojavio odaberite željeni oblik prikaza. Za pojedinosti pogledajte
odjeljak „Promjena oblika rezultata izračuna” (stranica 40).

■ Kako mogu utvrditi koju aplikaciju kalkulatora trenutačno
upotrebljavam?

→ Pritisnite . Ikona aplikacije kalkulatora koju trenutačno upotrebljavate
postat će označena.

■ Kako mogu izračunati sin2 x

→ Primjerice, za izračun izraza sin2 30 =  1
4  unesite izračun u nastavku.
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30

■ Zašto ne mogu unijeti (i) ili računati s kompleksnim brojem?
→ U aplikaciji Calculate ne možete unijeti i ili obavljati izračune s

kompleksnim brojevima. Za takve izračune upotrebljavajte aplikaciju
Complex.

■ Zašto se pojavljuje ikona baterije ( ) neposredno nakon što
uključim kalkulator?

→ Ikona baterije upućuje na to da je razina baterije niska. Ako vidite tu
ikonu, zamijenite bateriju što je prije moguće. Za pojedinosti o zamjeni
baterije pogledajte odjeljak „Zamjena baterije” (stranica 143).

■ Kako mogu vratiti kalkulator na zadane postavke?
→ Obavite postupak u nastavku kako biste vratili postavke kalkulatora na

zadane vrijednosti (osim za aplikacije Contrast i Auto Power Off).
(1) Pritisnite , odaberite ikonu aplikacije kalkulatora, a zatim pritisnite

.
(2) Pritisnite , a zatim odaberite [Reset] > [Settings & Data] > [Yes].
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